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前言

本使用者指南說明如何安裝與使用 Sun StorEdge™ Configuration Service 來配置、監
視與管理 Sun StorEdge 3510 FC 和 3310 SCSI 陣列。

除非另有指定，否則文中所指的 Sun StorEdge 3510 FC 陣列和 3310 SCSI 陣列一律稱
為陣列。本指南也參考 Sun StorEdge 3000 Family Diagnostic Reporter，這是 Sun
StorEdge Configuration Service 所附的公用程式，用來傳送和接收來自主機和陣列的訊
息。如果需要安裝和使用 Sun StorEdge Diagnostic Reporter 的詳細資訊，請參閱《Sun
StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

本指南是為已經熟悉 Sun™ 硬體和軟體產品之有經驗的系統管理員編寫的。

本書的組織結構
本書包含下列主題：

第 1 章介紹 Sun StorEdge Configuration Service 的功能。

第 2 章列出要遵循的步驟，以在安裝和使用 Sun StorEdge Configuration Service 之前，
確保陣列已配置妥當。

第 3 章提供在執行 Solaris™ 作業環境的系統上，安裝 Sun StorEdge Configuration
Service Console 和 Sun StorEdge Configuration Service Agent 的系統需求和過程。

第 4 章說明在 Windows NT/2000 作業系統上，安裝 Sun StorEdge Configuration
Service Console 和 Sun StorEdge Configuration Service Agent 的系統需求和安裝程
序。
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第 5 章說明在執行 Linux 作業環境的系統上，安裝 Sun StorEdge Configuration Service
Console 和 Sun StorEdge Configuration Service Agent 的系統需求和安裝程序。

第 6 章說明設定 Sun StorEdge Configuration Service 的程序。

第 7 章提供配置陣列的指示。

第 8 章說明如何建立 LUN 篩檢程式以維護共用公用儲存裝置的大型光纖通道網路 ( 僅
適用光纖通道 )。

第 9 章說明如何監視陣列。

第 10 章 說明如何維護陣列的完整性。

第 11 章說明如何變更或新增目前的陣列配置。

附錄 A 提供基本的 RAID 資訊。

附錄 B 說明如何監視韌體以及將其下載到獨立的 JBOD ( 僅限 SCSI)。

附錄 C 提供有關設定叢集配置的資訊 ( 僅限 SCSI)。

附錄 D 說明如何決定執行 Solaris 作業環境與 Windows NT 之系統上的主機世界通用
名稱 (World Wide Name，WWN) ( 僅適用於光纖通道 )。

附錄 E 說明如何設定完整的事件監視與電子郵件通知能力。

附錄 F 為一系列徵兆提供疑難排解建議。

附錄 G 包含 Sun StorEdge Configuration Service 錯誤代碼和訊息清單。

辭彙表提供產品說明文件中使用的 RAID 名詞術語和定義。
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使用 UNIX 指令
本文件並未包含有關基本 UNIX® 指令和程序的資訊，例如：關閉系統、系統開機以及
配置裝置等。

相關資訊請參見下列的一或多個項目：

■ Sun Peripherals 的 Solaris Handbook
■ Solaris 作業環境的 AnswerBook2™ 線上文件
■ 系統隨附的其他軟體文件

排版慣例

字體*

* 您所用瀏覽器的設定可能與這裏的這些設定不同。

含義 範例

AaBbCc123 指令、檔案和目錄的名稱，
電腦-畫面輸出

編輯 .login 檔案。

使用 ls -a 列出所有檔案。

% You have mail。

AaBbCc123 您所鍵入的內容與電腦畫面輸出
形成對比。

% su

Password:

AaBbCc123 書籍標題、新的名詞或術語、要
強調的名詞。請用實際名稱或值
取代指令列變數。

請閱讀 《使用者指南》的第 6 章。

這些稱為類別選項。

您必須是超級使用者，才能執行這項作
業。

若要刪除檔案，請輸入 rm filename。
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Shell 提示字元

相關文件

Shell 提示字元

C Shell 機器名稱 %

C Shell 超級使用者 機器名稱 #

Bourne shell 與 Korn shell $

Bourne shell 與 Korn shell 超級使用者 #

產品 標題 文件編號

僅限於 Sun StorEdge 3310 
SCSI Array

Sun StorEdge 3310 SCSI Array Release Notes 816-7292

Sun StorEdge 3000 Family 佳實作手冊 816-7989

Sun StorEdge 3000 Family RAID Firmware 3.25 User's Guide 816-7296

Sun StorEdge 3000 Family 安裝、操作和維修手冊 817-2990

僅限於 Sun StorEdge 3510 FC 
Array

Sun StorEdge 3510 FC Array Release Notes 816-7301

Sun StorEdge 3000 Family 佳實作手冊 817-2991

 Sun StorEdge 3000 Family RAID Firmware 3.27 User's Guide 816-7934

Sun StorEdge 3000 Family 安裝、操作和維修手冊 816-0226

同時用於 Sun StorEdge 3310 
SCSI 和 Sun StorEdge 3510 FC 
Array

Sun StorEdge 3000 Family Diagnostic Reporter 1.3 使用者指南 817-2995

Sun StorEdge 3000 Family 機架安裝指南 817-2993

Sun StorEdge 3000 Family FRU 安裝指南 817-2992

Sun StorEdge 3000 Family Safety, Regulatory, and Compliance 
Manual

816-7930
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請與 Sun 技術支援聯絡
有關 新消息和故障檢修提示，請參閱適當目錄中陣列的版本資訊： 

www.sun.com/products-n-solutions/

hardware/docs/Network_Storage_Solutions/Workgroup/

如果您對本產品的技術問題未在文件中解答，請至：

http://www.sun.com/service/contacting

如果要啟用或檢查限於美國的服務請求，請與 Sun 支援中心聯絡：

800-USA4SUN

如果要獲得國際的技術支援，請與各國的經銷辦事處聯絡：

www.sun.com/service/contacting/sales.html

存取 Sun 文件
所有的 Sun StorEdge 3000 系列文件都可以在下列位置同時以 PDF 與 HTML 格式取
得：

http://www.sun.com/products-n-solutions/ 

hardware/docs/Network_Storage_Solutions/Workgroup/

您可以到下列網址檢視、列印或購買各種 Sun 文件：

http://www.sun.com/documentation

您也可以在下列的網址訂購 Sun StorEdge 3000 系列手冊的書面副本：

http://corppub.iuniverse.com/marketplace/sun
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508 號傷殘資源存取特性
Sun StorEdge 文件有 508 號傷殘資源 HTML 格式版本，這些版本採用輔助科技方案，
便於視覺不便之人士使用。您可以在產品的文件 CD 中找到這些檔案，也可以在前面
「存取 Sun 文件」一節中所指定的網站上取得。此外，軟體與韌體應用程式也提供鍵盤
瀏覽與捷徑的功能，這些功能在使用者指南中都有詳細的說明。

Sun 歡迎您的批評指教
Sun 非常願意提升文件的品質，並誠心歡迎您的意見和指正。請傳送您的意見至：

http://www.sun.com/hwdocs/feedback

請在意見回應中附上文件的標題和文件編號：Sun StorEdge 3000 Family Configuration
Service 1.3 使用者指南，文件編號 817-2994-10。
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第  章1

介紹

本節中的內容對 Sun StorEdge Configuration Service 特性進行了簡要概述。

注意 — 為了簡潔之故，在本指南中有時會將 Sun StorEdge Configuration Service 
稱為程式。

Sun StorEdge Configuration Service 是一個以 Javaô 程式語言為基礎的複雜程式，它將
儲存配置、資源分配、維護和監視工具整合到一個應用程式中，以便對陣列進行的集中
式的管理。

透過網路上的單一主控台，系統管理員可以透過直覺式圖形使用者介面 (GUI) 初始化網
路儲存設備、更改配置、監控狀態並排程常式維護。

管理員還可以根據隨著整個網路儲存需求變化而改變的儲存要求動態地分配、重新分配
或擴充容量。 

如果狀態發生更改，程式會透過主控台顯示、電子郵件或文字數字呼叫器發送警示。也
可以將警示傳送到任何簡單網路管理通訊協定 (SNMP) 企業管理員，例如 HP OpenView。 
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Sun StorEdge Configuration Service 由兩個元件組成：

■ Sun StorEdge Configuration Service Agent – Solaris 8 和 Solaris 9 作業環境、Windows NT
與 Windows 2000，以及 Sunô Linux 5.0 和 Red Hat Linux 7.2 及 7.3 作業環境。

此代理監視連接的磁片儲存設備，並向主控台報告這些裝置的狀態。需要在作為 Sun
StorEdge Configuration Service 網路一部分的每台獨立伺服器上安裝代理軟體。可
以從網路中的單一工作站透過遠端方式完成安裝。 

■ Sun StorEdge Configuration Service Console – Solaris 8 和 Solaris 9 作業環境、
Windows NT 與 Windows 2000，以及 Sun Linux 5.0 和 Red Hat Linux 7.2 及 7.3 
作業環境。

主控台是由 Sun StorEdge Configuration Service 的 GUI 部分構成的，用來顯示代理
程式報告的資訊。主控台還提供了從單一工作站對裝置進行遠端配置和管理的功能。
需要將主控台安裝在網路上管理伺服器的電腦上。
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第  章2

開始之前

本章包含一些在安裝和使用 Sun StorEdge Configuration Service 之前必須瞭解的重要
資訊。本章涵蓋下列主題：

■ 第 3 頁 「範例畫面」
■ 第 3 頁 「Solaris 作業環境」
■ 第 4 頁 「Windows NT/2000 作業系統」
■ 第 4 頁 「超級使用者 / 管理員權限」

範例畫面
本指南提供了許多示範程式的範例畫面。這些畫面可能是 Sun StorEdge 3310 陣列或
Sun StorEdge 3510 陣列的輸出畫面。除非明確指明某項功能 ( 及其範例畫面 ) 僅適用於
Sun StorEdge 3510 FC 陣列，否則兩種陣列都可適用。

Solaris 作業環境
將 Sun StorEdge Configuration Service 安裝在執行 Solaris 作業環境的系統之前：

■ 確定安裝有 Sun StorEdge Configuration Service 代理程式的主機伺服器已連線到一
個分配有主通道 ID 的通道上。請參閱適合您的陣列的《Sun StorEdge 3000 Family 安
裝、操作和服務手冊》，瞭解控制器預設值和初始配置資訊。
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■ 對於 Sun StorEdge 3310 SCSI 陣列，請確定作業環境能識別相同 ID 下的多個 LUN。
如果需要額外的主機 LUN 分配，您可能必須修改 /kernel/drv/sd.conf。如果
需要有關修改這個檔案的詳細資訊，請參閱 SCSI 陣列的《Sun StorEdge 3000 Family
安裝、操作和維修手冊》。如果對 sd.conf 檔進行修改，則需要重新開啟工作站，
這樣所作的修改才能生效。

Windows NT/2000 作業系統
在 Microsoft Windows 作業系統上安裝 Sun StorEdge Configuration Service 之前：

■ 確定安裝有 Sun StorEdge Configuration Service 代理程式的主機伺服器已連線到一
個分配有主通道 ID 的通道上。請參閱適合您的陣列的《Sun StorEdge 3000 Family 安
裝、操作和服務手冊》，瞭解控制器預設值和初始配置資訊。

■ 確定伺服器已連接到作業系統，而且伺服器能夠辨識出儲存記憶體。

超級使用者 / 管理員權限
必須擁有超級使用者或管理員權限，才能夠安裝 Sun StorEdge Configuration Service
並執行主控台。
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第  章3

將 Sun StorEdge Configuration 
Service 安裝在執行 Solaris 作業環境
的系統上

本章提供在執行 Solaris 作業環境的系統上，安裝 Sun StorEdge Configuration Service
Console 和 Configuration Service Console Agent 的過程。本章涵蓋下列主題：

■ 第 5 頁 「系統需求」
■ 第 6 頁 「安裝 Sun StorEdge Configuration Service 之前」
■ 第 7 頁 「安裝軟體」
■ 第 14 頁 「使用者和密碼」
■ 第 16 頁 「解除安裝 Sun StorEdge Configuration Service」
■ 第 17 頁 「恢復配置」

系統需求
■ Netscape™ 4.0 ( 含 ) 以後版本 - 檢視線上說明。

■ 符合 TCP/IP 的主控台網路介面 - 每個主控台都必須擁有符合 TCP/IP 的網路介面 
( 例如乙太網路或 Token Ring 網路卡，或附有數據機的序列線 )。 

■ 主控台在設定為 256 色的 1024 x 768 像素顯示器解析度時，可獲得 佳觀看效果。如
果需要有關其他主控台需求的資訊，請參閱下表。
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■ 符合 TCP/IP 的代理網路介面 - 每個代理程式必須擁有具備 TCP/IP 能力的網路卡介
面和驅動程式集 ( 包含在作業環境中 )。有關其他代理程式需求的資訊，請參閱下表。

安裝 Sun StorEdge 
Configuration Service 之前
安裝程式及其它相關軟體元件前，應注意以下必需的過程和其他的選項。

■ 請務必閱讀陣列的版本資訊。

■ 安裝作業環境更新。如果要在執行 Solaris 作業環境的系統上使用 Sun StorEdge
Configuration Service，需要安裝 Sun 建議的 新作業環境修補程式，以及用於
Solaris 8 和 Solaris 9 的 Java 修補程式 如果需要 Sun 所建議的修補程式清單，請參
閱陣列的版本資訊。 

表 3-1 主控台系統需求 

Solaris 作業環境版本 記憶體 磁碟空間

安裝了 Sun 所建議的修正程
式的 Solaris 8 和 9。
( 如果需要 Sun 所建議的修
補程式清單，請參閱陣列的 
版本資訊 )

建議使用 64 MB 小 16 MB 的可用磁碟空間  

表 3-2 代理程式系統需求 

Solaris 作業環境版本 記憶體 磁碟空間

Solaris 8 和 Solaris 9 少為 128 MB 1 MB 的可用磁碟空間空間
6 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



■ 如果操作環境包含企業管理主控台，則可以選擇將代理程式配置成使用 SNMP 服務
將陷阱事件傳送到主控台。SNMP 服務內含在作業環境之內，而且是在安裝 TCP/IP
通訊協定堆疊之後才安裝。

■ 如果要讓網路上的伺服器將 SNMP 陷阱傳送到 企業管理主控台，請參閱第 229 頁
「電子郵件和 SNMP」。

■ 選擇性項目。如果要安裝和使用 Sun StorEdge Diagnostic Reporter (Sun StorEdge
Configuration Service 所附的公用程式，可以將儲存系統的事件報告給指定的電子郵
件位址 )，請參閱 《Sun StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

■ 選擇性項目。若要使用多重路徑設定，需要用於 Solaris 作業環境的 Sun StorEdge
Traffic Manager 軟體 ( 包括在 Sun StorEdge SAN Foundation 軟體中 )。如果需要
更詳細的資訊，請參閱陣列版本資訊中＜ Other Supported Software ＞ ( 其他支援的
軟體 ) 一節。

注意 – 必須是超級使用者才能夠安裝 Sun StorEdge Configuration Service 並執行主控
台。

安裝軟體
Sun StorEdge Configuration Service 包含下列元件：

■ Sun StorEdge Configuration Service Agent

■ Sun StorEdge Configuration Service Console

■ Diagnostic Reporter ( 選擇性公用程式 ) - 如果需要安裝和操作的資訊，請參閱
《Sun StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

■ 指令列介面 (CLI) - 如果需要安裝資訊，請參閱陣列的 《Sun StorEdge 3000 Family 
安裝、操作和維修手冊》。
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安裝套裝軟體

Sun StorEdge Configuration Service Agent 和 Configuration Service Console 安裝套
裝軟體包含在 Sun StorEdge 3000 Family Professional Storage Manager CD 上。程式
支援四種語言。下表指明每個語言需要的檔案。

注意 – 每種語言都需要用於主控台和代理程式的英文安裝套裝軟體。

▼ 安裝代理程式和主控台

在作為 Sun StorEdge Configuration Service 一部分的每台伺服器上安裝代理程式。在
計畫用於管理和維護儲存系統的電腦或工作站上安裝主控台。

主控台可以安裝在伺服器或任何用戶端系統上。代理程式必須安裝在連接儲存裝置的伺
服器上。

完成下列步驟以安裝代理程式、主控台，或兩者都安裝。至少必須安裝一個代理程式和
一個主控台使程式能夠執行。

注意 – 確定在要安裝 Sun StorEdge Configuration Service 的電腦或工作站上，已安裝
Java runtime environment 1.2 ( 含 ) 以後版本。 

注意 – 升級主控台或代理程式時，必須解除安裝 Sun StorEdge Configuration Service。
如果需要解除安裝詳細資訊，請參閱第 16 頁 「解除安裝 Sun StorEdge Configuration
Service」。

表 3-3 Solaris 作業環境所需的 Sun StorEdge Configuration Service 安裝套裝軟體

英文 法文 日文 簡體中文

Agent SUNWscsd SUNWscsd
SUNWfscsd

SUNWscsd
SUNWjscsd

SUNWscsd
SUNWcscsd

主控台 SUNWscsu SUNWscsu
SUNWfscsu

SUNWscsu

SUNWjscsu

SUNWscsu
SUNWcscsu
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注意 – 如果您要新增法文、日文或簡體中文語言支援，您必須先安裝程式的英文版本。

1. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 並鍵入

2. 使用下列的其中一個方式安裝套裝軟體：

a. 若只要安裝代理程式 ( 英文版 )，請鍵入

b. 若要新增法文、日文或簡體中文語言支援，請鍵入

根據您安裝的語言種類，這裡的 x 可能是 c、j 或 f。如果需要套裝軟體名稱，請參閱
第 8 頁 「Solaris 作業環境所需的 Sun StorEdge Configuration Service 安裝套裝軟
體」。

c. 若只安裝主控台 ( 英文版 )，請鍵入

d. 若要新增法文、日文或簡體中文語言支援，請鍵入

根據您安裝的語言種類，這裡的 x 可能是 c、j 或 f。如果需要安裝套裝軟體名稱，請
參閱 第 8 頁「Solaris 作業環境所需的 Sun StorEdge Configuration Service 安裝套
裝軟體」。

e. 如果要安裝所有套裝軟體，請鍵入

# cd /cdrom/cdrom0/product/solaris

# pkgadd -d SUNWscsd

# pkgadd -d SUNWxscsd

# pkgadd -d SUNWscsu

# pkgadd -d SUNWxscsu

# pkgadd -d . all
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f. 如果要從功能表中選擇要安裝的套裝軟體，請鍵入

g. 如果只要安裝兩種代理程式 (Sun StorEdge Configuration Service 和 Sun StorEdge
Diagnostic Reporter) ( 英文版 )，請鍵入

h. 如果只要新增有法文、日文或簡體中文語言支援的兩種代理程式 (Sun StorEdge 
Configuration Service 和 Sun StorEdge Diagnostic Reporter)，請鍵入

根據您安裝的語言種類，這裡的 x 可能是 c、j 或 f。如果需要安裝套裝軟體名稱，請
參閱 第 8 頁「Solaris 作業環境所需的 Sun StorEdge Configuration Service 安裝套
裝軟體」。如果需要 Sun StorEdge Diagnostic Reporter 套裝軟體名稱，請參閱《Sun
StorEdge 3000 Family Diagnostic Reporter 使用者指南》

3. 對每個標準安裝提示做出適當回應。

安裝提示都是標準的 pkgadd -d  提示，這些提示可以控制要安裝的套裝軟體以及處
理指令碼的方式 ( 使用超級使用者權限 )。

a. 在 Select 套裝軟體提示時，請根據安裝方法鍵入適當的回應。 

例如，如果選擇 2a 或 2b，請鍵入 1 並按 Return。

b. 如果您先前已經安裝過代理程式，系統會詢問您是否要恢復它的配置。

鍵入 y 即可恢復配置。如果鍵入 n，您必須重新啟用管理伺服器。

# pkgadd -d .

# pkgadd -d .SUNWscsd SUNWscsa

# pkgadd -d .SUNWxscsd SUNWxscs

Select package(s) you wish to process (or ëallí to process all 
packages).(default:all) [?,??,q]: 1
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注意 – 解除 Sun StorEdge Configuration Service 安裝時，使用者密碼會被刪除。如果您
有先前的配置，您必須依照第 14 頁 「使用者和密碼」中的說明重新鍵入 ssmon、
ssadmin 和 ssconfig 密碼。

c. 如果您先前已經安裝過主控台，系統會詢問您是否要恢復它的配置。

按 y 即可恢復配置。如果鍵入 n，您必須重新加入伺服器資訊。

d. 如要繼續安裝，請鍵入 y 並按 Return。

安裝代理程式之後，將會顯示下列訊息，表示代理程式已順利安裝並且已經啟動。 

The previous configuration was saved.User passwords must be 
reentered.Do you want to restore the configuration [y,n,?,q]:y

The previous configuration was saved.Do you want to restore the 
configuration [y,n,?,q]:y

Do you want to continue with the installation [y,n,?] y

Configuring and starting Sun StorEdge(tm) Configuration Service 
agent daemons:
       The configuration is complete.
       Sun StorEdge(tm) Configuration Service agent server daemon 
has started.
       Sun StorEdge(tm) Configuration Service agent monitor daemon 
has started.
Sun StorEdge(tm) Configuration Service agent startup is complete.

Installation of <SUNWscsd> was successful.
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安裝程式會檢查是否安裝了 Java runtime environment 1.2 ( 含 ) 以後版本，如果找不
到，安裝程式會要求您指定路徑。如果您確知已經安裝了 Java 執行時期環境版本 1.2.2、
1.3 或 1.4，但是安裝程式找不到，請檢查 /usr 目錄，確認是否有從 Java 指向 新版
本 ( 而非 Java 1.1 版 ) 的連結。如果需要有關建立連結的指示，請參閱第 243 頁「疑難
排解」。

代理程式和主控台安裝在下面的目錄中：/opt/SUNWsscs/sscsconsole.

4. 如果要存取線上說明，您必須指定 Web 瀏覽器 (Netscape 4.0 ( 含 ) 以後版本 ) 的路徑。

a. 變更目錄到 /opt/SUNWsscs/sscsconsole 並且鍵入 

b. 鍵入 Web 瀏覽器的絕對路徑。

注意 – 您隨時都可以配置瀏覽器路徑名稱；不過，如果您不在某些時間點指定瀏覽器路
徑名稱，您將無法存取線上說明。

5. 對於 Sun StorEdge 3310 SCSI Array，如果有下列情況，請編輯 /kernel/drv/sd.conf：

■ 使用帶有多個磁碟機和多個 LUN 的協力廠商 HBA
■ 使用光纖裝置
■ 所有的 LUN 都擁有相同的 ID

加入適合您的配置的邏輯裝置號碼 (LUN) 行。LUN 可以編號為 0-31。一般來說，新增
的 LUN 定義不應多於計畫的數目，因為這樣會增加掃描每個 SCSI 匯流排花費的時間，
而無論儲存設備是否連接。如果需要有關修改 sd.conf 檔案的詳細資訊，請參閱 SCSI
陣列的 《Sun StorEdge 3000 Family 安裝、操作和維修手冊》。

6. 如果已經編輯過 sd.conf 檔案，才需要執行重新配置後的重新啟動。

./config_sscon
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▼ 啟動或停止代理程式

使用 /etc/init.d/ssagent 中的執行指令指令碼，可以用手動方式停止和啟動代理
程式。

1. 如果要啟動代理程式，請鍵入

注意 – 如果要啟動代理程式，您必須擁有超級使用者權限。

如果沒有先使用 stop 就使用 start，則指令碼將重新啟動任何已經停止的代理程式。
如果所有的代理程式都已經停止 ( 例如使用 stop 選項 )，則指令碼將在重新啟動代理程
式之前重新配置執行時期環境。

2. 如果要停止代理程式，請鍵入

3. 如果要判斷代理程式是否在執行，請鍵入

ssmon 和 ssserver 兩者都會顯示在輸出中。如果已經啟用了 SNMP 陷阱產生，則您
還會看到名稱 sstrapd。

4. 如果在初始開機後沒有顯示儲存系統，則應停止代理程式，並在指令提示時執行

5. 標示所需要的磁碟，然後重新啟動代理程式。

# /etc/init.d/ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss

# format
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使用者和密碼
下列各節解釋如何建立使用者和密碼。

管理 ( 使用者 ) 安全等級和準則

如果在使用 Solaris 作業環境的系統上執行程式，在安裝過程中會自動建立管理員安全等
級。您只需要根據需要的許可權等級設定密碼並指定使用者。 

管理功能會要求使用登入和密碼，以防止某個管理員未經授權重新分配或刪除屬於其他
用戶端或主機的儲存資源。 

為程式的三個安全等級指定獨立的密碼。這是透過擁有由程式管理的儲存裝置代理程式
上建立三個使用者而執行。在安裝代理程式的過程中自動新增這三個使用者。

安全等級必須擁有這三個完全相同的名稱： 

■ ssmon

代表軟體的監視等級。

■ ssadmin

代表軟體的管理等級，並提供對 Rebuild、Parity Check、Schedule Parity Check 
以及監視功能的存取。 

■ ssconfig

代表軟體的配置等級，並為安裝程式提供對配置功能和程式的其他所有相關方面的
直接存取。 

三個安全等級都需要這些登入名稱。安裝後，必須為每個安全名稱分配密碼。

ssmon、ssadmin 和 ssconfig 只對應到程式內安全等級的登入。對於 UNIX 作業環
境 (Solaris 或 Linux 作業環境 )，這些帳戶的預設殼層是指定為 /bin/false，以防止
這些使用者 ID 使用於互動式登入。

可以設定 Sun StorEdge Configuration Service，讓在不需要使用者鍵入 ssmon 密碼的
情況下也可以監視。這可以透過在主控台上將伺服器產加入到 Managed Servers 清單
時，選擇 Auto Discovery 選項來完成。您可以在每個伺服器上，以本機方式設定這三
個登入名稱和密碼。( 如果需要，這些帳戶可以在每台伺服器上擁有不同的密碼。) 
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只要在這些被管理的代理程式上設定這三個登入，系統管理員通常就能夠透過向員工分
配以完成工作所需的安全等級為基礎的適當密碼，提供對程式的使用者存取。例如，為
特定伺服器上擁有管理權限的每個使用者，分配為使用者 ssadmin 建立的相同密碼。

注意 – 如果要將伺服器加入 Managed Servers 清單，請參閱第 43 頁「新增伺服器」。

▼ 建立密碼和許可權

如果要為每個新的使用者建立密碼，請鍵入

管理員也可能想要變更群組許可權，群組許可權位於安裝期間建立的 
/opt/SUNWsscs/sscsconsole 目錄中的 svrlist.dat  檔案中。 

主控台是以 Java 程式為基礎的公用程式，因此不能提供用於控制 Sun StorEdge
Configuration Service 建立的檔案許可權與所有權的機制。svrlist.dat 檔容易為不
同形式的 ASCII 文字處理器讀取。其中包括使用者 ssmon 的已加密密碼，而且也可以
解密。 

注意 – 加入所監視的所有代理程式之後，不要更改 svrlist.dat 的許可權以及群組所
有權。

# passwd user-name
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解除安裝 Sun StorEdge 
Configuration Service 
升級主控台或代理程式時，必須解除安裝 Sun StorEdge Configuration Service。請注意
有些檔案不會被刪除，因為他們是在安裝後才建立，而且仍然對升級環境有效。

▼ 解除安裝 Sun StorEdge Configuration Service
使用 pkgrm 指令，後面接續您要解除安裝的套裝軟體。 

注意 – 如果您新增了法文、日文或簡體中文語言支援，您需要先解除安裝英文套裝軟體，
然後再解除安裝那些套裝軟體。

其中 xxxxx 是您要解除安裝的套裝軟體。如果需要套裝軟體名稱，請參閱第 8 頁
「Solaris 作業環境所需的 Sun StorEdge Configuration Service 安裝套裝軟體」。

# pkgrm SUNWxxxxx
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恢復配置
如果您重新安裝代理程式或主控台，在安裝程序中系統會詢問您是否要恢復配置。如果
您選擇要恢復配置，將會從下列檔案中恢復相關資訊：

■ /var/opt/SUNWsscs/sscsagt.cfg.tar – Sun StorEdge Configuration Service Agent

■ /var/opt/SUNWsscs/sscscon.cfg.tar – Sun StorEdge Configuration Service Console

注意 – 如果您要永久移除 Sun StorEdge Configuration Service，可以用手動方式移除這
些檔案；但是，如果您重新安裝程式，則無法恢復代理程式和主控台的配置。
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第  章4

將 Sun StorEdg eConfiguration 
Service 安裝在 Microsoft Windows 
NT 或 2000 作業系統上

本章提供在執行 Windows NT/2000 作業系統上安裝 Sun StorEdge Configuration
Service Console 和 Configuration Service Console Agent 的過程。本章涵蓋下列主題：

■ 第 19 頁 「系統需求」
■ 第 20 頁 「安裝 Sun StorEdge Configuration Service 之前」
■ 第 21 頁 「安裝軟體」
■ 第 23 頁 「使用者和密碼」
■ 第 25 頁 「解除安裝 Sun StorEdge Configuration Service」

系統需求
■ Netscape 4.0 (含 ) 以後版本，或者 Microsoft Internet Explorer 4.0 (含 ) 以後版本 - 檢

視線上說明。

■ 符合 TCP/IP 的主控台網路介面 – 每個主控台都必須擁有符合 TCP/IP 的網路介面 
( 例如乙太網路或 Token Ring 網路卡，或附有數據機的序列線 )。

■ 主控台在設定為 256 色的 1024 x 768 像素顯示器解析度時，可獲得 佳觀看效果。如
果需要有關其他主控台需求的資訊，請參閱下表。
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■ 符合 TCP/IP 的代理網路介面 ñ 每個代理程式必須擁有具備 TCP/IP 能力的網路卡
介面和驅動程式集 ( 包含在作業系統中 )。有關其他代理程式需求的資訊，請參閱下
表。

安裝 Sun StorEdge 
Configuration Service 之前
安裝程式及其它相關軟體元件前，應注意以下必需的過程和其他的選項。

■ 請務必閱讀 陣列 的版本資訊。

■ 如果作業環境包含企業管理主控台，則可以選擇將代理程式配置成使用 SNMP 服務
將陷阱事件傳送到主控台。SNMP 服務內含在作業環境之內，而且是在安裝 TCP/IP
通訊協定堆疊之後才安裝。

■ 如果要讓網路上的伺服器將 SNMP 陷阱傳送到 企業管理主控台，請參閱第 229 頁
「電子郵件和 SNMP」。

■ 選擇性項目。如果要安裝和使用 Sun StorEdge Diagnostic Reporter (Sun StorEdge
Configuration Service 所附的公用程式，可以將儲存系統的事件報告給指定的電子郵
件位址 )，請參閱 《Sun StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

表 4-1 主控台系統需求

作業系統版本 記憶體 磁碟空間

Windows NT 4.0
(SP 3 或更新的版本 )
Windows 2000

少為 32 MB
建議使用 64 MB

小 20 MB 的可用磁碟空間  
建議使用 40 MB

表 4-2 代理程式系統需求

作業系統版本 記憶體 磁碟空間

Windows NT 4.0 (Service 
Pack 3、4、5 或 6)
Windows 2000

小為 32 MB，或建議使用 64 MB 或以上
的記憶體。由其他如資料庫等大型應用程式
決定需求。

2 MB 的可用磁
碟空間
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■ 選擇性項目。若要使用多重路徑設定，需要 Sun StorEdge Traffic Manager 軟體 ( 包
括在 Sun StorEdge SAN Foundation 軟體中 )。如果需要更詳細的資訊，請參閱陣列
版本資訊中＜ Other Supported Software ＞ ( 其他支援的軟體 ) 一節。

注意 – 必須是管理員才能夠安裝 Sun StorEdge Configuration Service 並執行主控台。

安裝軟體
Sun StorEdge Configuration Service 包含下列元件：

■ Sun StorEdge Configuration Service Agent

■ Sun StorEdge Configuration Service Console

■ Diagnostic Reporter ( 選擇性公用程式 ) - 如果需要安裝和操作的詳細資訊，請參閱
《Sun StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

■ 指令列介面 (CLI)  – 如果需要安裝資訊，請參閱陣列的 《Sun StorEdge 3000 Family
安裝、操作和維修手冊》。

在儲存作業是由 Sun StorEdge Configuration Service 管理的每一個伺服器上安裝代理
程式。在計畫用於管理和維護系統儲存的電腦或工作站上安裝主控台。

安裝套裝軟體

安裝套裝軟體 (setup.exe) 包含在 Sun StorEdge 3000 Family Professional Storage
Manager CD 上，其中包括下列元件：

■ Sun StorEdge Configuration Service Agent
■ Sun StorEdge Configuration Service Console
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▼ 安裝代理程式和主控台 
您必須在想要由 Sun StorEdge Configuration Service 管理儲存的每台 Windows NT
或 2000 伺服器上，安裝代理程式。 

注意 – 確定在要安裝主控台的電腦或工作站上，已安裝 Java runtime environment 1.2 (
含 ) 以後版本。 

1. 如果要確使軟體安裝公用程式的功能 佳化，必須關閉所有開啟的 Windows 應用程式。

2. 插入  Sun StorEdge 3000 Family Professional Storage Manager CD ，並且變更到 
\product\windows 目錄。

3. 按兩下 setup.exe 並且選取要安裝的軟體元件：SUNWsscs Agent 或 SUNWsscs 
Console。

4. 在 Choose Destination Location 視窗中，安裝預設檔案夾然後按一下 Next。
代理程式會安裝在 C:\Program Files\Sun\ssagent 中；主控台會安裝在 
C:\Program Files\Sun\sscs 中。

如果要安裝到另一個檔案夾，請按一下 Browse，選取另一個檔案夾，然後按一下 Next。 

安裝完成後，代理程式將會自動啟動。

▼ 在 Windows NT Server 啟動或停止代理程式

如果要在伺服器上啟動代理程式，必須將伺服器重新開機，或啟動三個 Sun StorEdge
Configuration Service 服務：在 [ 設定 ] → [ 控制台 ] → [ 服務 ] 之下的 SUNWscsd
Startup、SUNWscsd Server 和 SUNWscsd Monitor。  

若要停止代理程式，進入 [ 設定 ] → [ 控制台 ] → [ 服務 ]，選取要停止的代理程式，然
後按一下 Stop。
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▼ 在 Windows 2000 Server 啟動和停止代理程式

1. 選擇 [ 開始 ] → [ 系統管理服務 ] → [ 電腦管理 ]。 

2. 按一下 [ 服務及應用程式 ]。

3. 在您想要啟動或停止的服務 (SUNWscsd Monitor、SUNWscsd Server、SUNWscsd
Startup) 上按一下滑鼠右鍵。 

另外也可以使用 [ 開始 ] → [ 設定 ] → [ 控制台 ] → [ 系統管理工具 ] → [ 電腦管理 ]。 

使用者和密碼
下列各節解釋如何建立使用者和密碼。

管理員 ( 使用者 ) 安全等級和準則

管理功能會要求使用登入和密碼，以防止某個管理員未經授權重新分配或刪除屬於其他
用戶端或主機的儲存資源。 

為三個安全等級指定獨立的密碼。這是透過擁有由程式管理的儲存裝置代理程式上建立
三個使用者而執行。 

安全等級必須擁有這三個完全相同的名稱： 

■ ssmon

代表軟體的監視等級。

■ ssadmin

代表軟體的管理等級，並提供對 Rebuild、Parity Check、Schedule Parity Check 
以及監視功能的存取。 

■ ssconfig

代表軟體的配置等級，並為安裝程式提供對配置功能和程式的其他所有相關方面的直
接存取。 
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三個安全等級都需要這些名稱。安裝後，必須為每個安全名稱分配密碼。

ssmon、ssadmin 和 ssconfig 只對應到程式內安全等級的登入。

可以設定 Sun StorEdge Configuration Service，讓在不需要使用者輸入 ssmon 密碼的
情況下也可以監視。這可以透過在主控台上將伺服器加入到 Managed Servers 清單時，
選擇 Auto Discovery 選項來完成。您可以在每個伺服器上，以本機方式設定這三個登
入名稱和密碼。( 這些帳戶可以在每台伺服器上擁有不同的密碼。) 

只要在這些被管理的代理程式上設定這三個登入，系統管理員通常就能夠透過向員工分
配以完成工作所需的安全等級為基礎的適當密碼，提供對程式的使用者存取。例如，為
特定伺服器上擁有有管理權限的每個使用者，分配為使用者 ssadmin 建立的相同密碼。

注意 – 如果要將伺服器加入 Managed Servers 清單， 請參閱第 43 頁「新增伺服器」。

多台伺服器上的全域密碼

如果已經擁有一個龐大的網路，而且不想要單獨設定登入，並且可以接受在多台伺服器
上使用相同的密碼，則可以在 Microsoft Windows 下的網域伺服器上建立三個登入。使
Microsoft Windows 網域中的其他所有伺服器，都能夠存取這三個登入及其各自的密碼。

▼ 建立 Windows NT 使用者

1. 使用 NT User Manager 程式新增使用者。 

2. 選擇 Policies 然後選擇 User Rights。 

3. 選擇 Show Advanced User Rights。

4. 提供 NT User Administrator (NT 使用者管理員 ) 作為作業系統的一部分之 
Rights to Act。

5. 在 User Properties 下，取消選擇 User Must Change Password at Next Login。

6. 在 User Properties 下，選擇 User Cannot Change Password 和 Password Never 
Expires。
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7. 如果計畫在網域伺服器上建立使用者名稱，並因此而不需要多個伺服器設定，請確定要
管理的伺服器屬於在其中建立 Sun StorEdge Configuration Service 使用者帳戶的網
域。

如果需要更詳細的資訊，請參閱 Windows NT 文件說明。

▼ 建立 Windows 2000 使用者

1. 在 [ 設定 ] → [ 控制台 ] → [ 系統管理工具 ] → [ 電腦管理 ] → [ 系統工具 ] → [ 本機使
用者和群組 ] 之下，選擇 [ 使用者 ]。

2. 在 Users 檔案夾上按一下滑鼠右鍵，並且選擇 New User 來新增這三個使用者 (ssmon、
ssconfig 和 ssadmin)。

3. 在 User name 下新增其中一個使用者。如果需要，可以在 Description 下輸入說明。

4. 如果需要可以輸入密碼，請選擇 User Cannot Change Password 和 Password Never
Expires。

解除安裝 Sun StorEdge Configuration 
Service
使用 Windows 新增 / 移除程式公用程式從 Microsoft Windows Console 上移除 
Sun StorEdge Configuration Service。 

▼ 解除安裝 Sun StorEdge Configuration Service
1. 移至 [ 開始 ] → [ 設定 ] → [ 控制台 ] → [ 新增 / 移除程式 ]。

2. 選擇 Sun StorEdge Configuration Service Agent，然後選擇 [ 新增 / 移除 ]。對提示做
出適當的回應。

3. 選擇 Sun StorEdge Configuration Service Console，然後選擇 [ 新增 / 移除 ]。對提示
做出適當的回應。
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第  章5

將 Sun StorEdge Configuration 
Service 安裝在執行 Linux 作業環境
的系統上

本章提供在執行 Sun Linux 或 Red Hat Linux 作業環境的系統上，安裝 Sun StorEdge
Configuration Service Console 和 Configuration Service Agent 的程序。本章涵蓋下列
主題：

■ 第 27 頁 「系統需求」
■ 第 28 頁 「安裝 Sun StorEdge Configuration Service 之前」
■ 第 29 頁 「安裝軟體」
■ 第 32 頁 「使用者和密碼」
■ 第 35 頁 「解除安裝 Sun StorEdge Configuration Service」

系統需求
■ Netscape™ 4.0 ( 含 ) 以後版本 - 檢視線上說明。

■ 符合 TCP/IP 的主控台網路介面 - 每個主控台都必須擁有符合 TCP/IP 的網路介面 
( 例如乙太網路或 Token Ring 網路卡，或附有數據機的序列線 )。 

■ 主控台在設定為 256 色的 1024 x 768 像素顯示器解析度時，可獲得 佳觀看效果。如
果需要有關其他主控台需求的資訊，請參閱下表。
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■ 符合 TCP/IP 的代理網路介面 – 每個代理程式必須擁有具備 TCP/IP 能力的網路卡
介面和驅動程式集 ( 包含在作業環境中 )。有關其他代理程式需求的資訊，請參閱下表。

安裝 Sun StorEdge 
Configuration Service 之前
安裝程式及其它相關軟體元件前，應注意以下必需的過程和其他的選項。

■ 請務必閱讀陣列的版本資訊。

■ 如果作業環境包含企業管理主控台，則可以選擇將代理程式配置成使用 SNMP 服務
將陷阱事件傳送到主控台。 

■ 如果要讓網路上的伺服器將 SNMP 陷阱傳送到 企業管理主控台，請參閱第 229 頁
「電子郵件和 SNMP」。

■ 選擇性項目。如果要安裝和使用 Sun StorEdge Diagnostic Reporter (Sun StorEdge
Configuration Service 所附的公用程式，可以將儲存系統的事件報告給指定的電子郵
件位址 )，請參閱 《Sun StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

■ 選擇性項目。若要使用多重路徑設定，需要 Sun StorEdge Traffic Manager 軟體 ( 包
括在 Sun StorEdge SAN Foundation 軟體中 )。如果需要更詳細的資訊，請參閱陣列
版本資訊中＜ Other Supported Software ＞ ( 其他支援的軟體 ) 一節。

表 5-1 主控台系統需求 

 Linux 版本 記憶體 磁碟空間

Sun Linux 5.0
Red Hat Linux 7.2 和 7.3

少為 256 MB 10 MB

表 5-2 代理程式系統需求 

Linux 版本 記憶體 磁碟空間

 Sun Linux 5.0
Red Hat Linux 7.2 和 7.3

少為 128 MB 1 MB
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注意 – 必須是超級使用者才能夠安裝 Sun StorEdge Configuration Service 並執行主控
台。

安裝軟體
Sun StorEdge Configuration Service 軟體包含下列元件：

■ Sun StorEdge Configuration Service Agent

■ Sun StorEdge Configuration Service Console

■ Diagnostic Reporter ( 選擇性公用程式 ) - 如果需要安裝和操作的詳細資訊，請參閱
《Sun StorEdge 3000 Family Diagnostic Reporter 使用者指南》。

■ 指令列介面 (CLI) – 如果需要安裝資訊，請參閱陣列的 《Sun StorEdge 3000 Family 
安裝、操作和維修手冊》。

安裝套裝軟體

安裝套裝軟體包含在 Sun StorEdge 3000 Family Professional Storage Manager CD 
上，其中包括下列檔案：

■ SUNWscsu.rpm – Sun StorEdge Configuration Service Console
■ SUNWscsd.rpm – Sun StorEdge Configuration Service Agent

▼ 安裝代理程式和主控台

在作為 Sun StorEdge Configuration Service 一部分的每台伺服器上安裝代理程式。在
計畫用於管理和維護儲存系統的電腦或工作站上安裝主控台。

Sun StorEdge Configuration Service Console 套裝軟體 (SUNWscsu.rpm) 可以安裝在
伺服器或任何用戶端系統上。Sun StorEdge Configuration Service Agent 套裝軟體
(SUNWscsd.rpm) 必須安裝在連接儲存設備的伺服器上。

完成下列步驟以安裝代理程式、主控台，或兩者都安裝。至少必須安裝一個代理程式和
一個主控台使程式能夠執行。
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注意 – 確定在要安裝 Sun StorEdge Configuration Service 的電腦或工作站上，已安裝
Java runtime environment 1.2 ( 含 ) 以後版本。 

1. 如果您要安裝 Sun StorEdge Configuration Service 的電腦或工作站上沒有安裝 Java 
runtime envuironment 1.2 ( 含 ) 以後版本，請立即安裝它。

2. 將 CD ROM 裝載到您的檔案系統上 ( 如果還沒有裝載 )。

3. 插入 Sun StorEdge 3000 Family Professional Storage Manager CD 並鍵入

4. 使用下列的其中一個方式安裝套裝軟體：

a. 如果只要安裝代理程式，請鍵入

b. 如果只安裝主控台，請鍵入

5. 如果要存取線上說明，則安裝主控台的系統上必須安裝 Web 瀏覽器。如果偵測不到 Web
瀏覽器，系統會要求您指定 Web 瀏覽器 (Netscape 4.0 ( 含 ) 以後版本 ) 的路徑。

a. 變更目錄到 /opt/SUNWsscs/sscsconsole 並且鍵入 

b. 鍵入 Web 瀏覽器的絕對路徑。

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm

./config_sscon
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注意 – 您隨時都可以配置瀏覽器路徑名稱；不過，如果您不在某些時間點指定瀏覽器路
徑名稱，您將無法存取線上說明。

安裝代理程式之後，將會顯示下列訊息，表示這些元件已經順利安裝並且已經啟動。 

安裝主控台之後，將會顯示下列訊息，表示這些元件已經順利安裝並且已經啟動。

代理程式和主控台安裝在下面的目錄中：/opt/SUNWsscs/sscsconsole.

▼ 啟動或停止代理程式

使用 /etc/init.d/ssagent 中的執行指令指令碼，可以用手動方式停止和啟動代理
程式。

1. 如果要啟動代理程式，請鍵入

或者

# rpm -ivh SUNWscsd.rpm Preparing...
########################################### [100%] 1:SUNWscsd
########################################### [100%] add user ssmon 
add user ssadmin add user ssconfig Configuring and starting Sun 
StorEdge(tm) Configuration Service daemons[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent daemon[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent monitor 
daemon[ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%] 
Installation completed successfully!

# /etc/init.d/ssagent start

# service ssagent start
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注意 – 如果要啟動代理程式，您必須擁有超級使用者權限。

如果沒有先使用 stop 就使用 start，則指令碼將重新啟動任何已經停止的代理程式。
如果所有的代理程式都已經停止 ( 例如使用 stop 選項 )，則指令碼將在重新啟動代理程
式之前重新配置執行時期環境。

2. 如果要停止代理程式，請鍵入

3. 如果要判斷代理程式是否在執行，請鍵入

或者

ssmon 和 ssserver 兩者都會顯示在輸出中。如果已經啟用了 SNMP 陷阱產生，則您
還會看到名稱 sstrapd。

使用者和密碼
下列各節解釋如何建立使用者和密碼。

管理 ( 使用者 ) 安全等級和準則

如果在使用 Solaris 作業環境的系統上執行程式，在安裝過程中會自動建立管理員安全等
級。您只需要根據需要的許可權等級設定密碼並指定使用者。 

# /etc/init.d/ssagent stop

# ps -e | grep ss

# service ssagent status
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管理功能會要求使用登入和密碼，以防止某個管理員未經授權重新分配或刪除屬於其他
用戶端或主機的儲存資源。 

為程式的三個安全等級指定獨立的密碼。這是透過擁有由程式管理的儲存裝置代理程式
上建立三個使用者而執行。在安裝代理程式的過程中自動新增這三個使用者。

安全等級必須擁有這三個完全相同的名稱： 

■ ssmon

代表軟體的監視等級。

■ ssadmin

代表軟體的管理等級，並提供對 Rebuild、Parity Check、Schedule Parity Check 
以及監視功能的存取。 

■ ssconfig

代表軟體的配置等級，並為安裝程式提供對配置功能和程式的其他所有相關方面的直
接存取。 

三個安全等級都需要這些名稱。安裝後，必須為每個安全名稱分配密碼。

ssmon、ssadmin 和 ssconfig 只對應到程式內安全等級的登入。對於 UNIX 作業環
境 (Solaris 或 Linux 作業環境 )，這些帳戶的預設殼層是指定為 /bin/false，以防止
這些使用者 ID 使用於互動式登入。

可以設定 Sun StorEdge Configuration Service，讓在不需要使用者鍵入 ssmon 密碼的
情況下也可以監視。這可以透過在主控台上將伺服器產加入到 Managed Servers 清單
時，選擇 Auto Discovery 選項來完成。您可以在每個伺服器上，以本機方式設定這三
個登入名稱和密碼。( 如果需要，這些帳戶可以在每台伺服器上擁有不同的密碼。) 

只要在這些被管理的代理程式上設定這三個登入，系統管理員通常就能夠透過向員工分
配以完成工作所需的安全等級為基礎的適當密碼，提供對程式的使用者存取。例如，為
特定伺服器上擁有管理權限的每個使用者，分配為使用者 ssadmin 建立的相同密碼。

注意 – 如果要將伺服器加入 Managed Servers 清單，請參閱第 43 頁「新增伺服器」。
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▼ 建立密碼和許可權

如果要為每個新的使用者建立密碼，請鍵入

管理員也可能想要變更群組許可權，群組許可權位於安裝期間建立的 
/opt/SUNWsscs/sscsconsole 目錄中的 svrlist.dat 檔案中。 

主控台是以 Java 為基礎的公用程式，因此不能提供用於控制 Sun StorEdge Configuration
Service 建立的檔案許可權與所有權的機制。svrlist.dat 檔容易為不同形式的 ASCII
文字處理器讀取。其中包括使用者 ssmon 的已加密密碼，而且也可以解密。 

注意 – 加入所監視的所有代理程式之後，不要更改 svrlist.dat 的許可權以及群組所
有權。

# passwd user-name
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解除安裝 Sun StorEdge 
Configuration Service 
升級主控台或代理程式時，必須解除安裝 Sun StorEdge Configuration Service。請注意
有些檔案不會被刪除，因為他們是在安裝後才建立，而且仍然對升級環境有效。

▼ 解除安裝 Sun StorEdge Configuration Service
使用 rpm -e 指令，後面接著您想要解除安裝的套裝軟體，SUNWscsu.rpm ( 主控台 )
或 SUNWscsd.rpm ( 代理程式 )。 

# rpm -e SUNWscsu.rpm

# rpm -e SUNWscsd.rpm
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第  章6

設定 Sun StorEdge 
Configuration Service

本章說明設定 Sun StorEdge Configuration Service 的一般步驟。本章包含下列步驟：

■ 第 38 頁 「啟動 Sun StorEdge Configuration Service」
■ 第 38 頁「將 Sun StorEdge Configuration Service 安裝在 Solaris/Linux 作業環

境上」
■ 第 39 頁 「初次使用前後的主視窗」

■ 第 43 頁 「新增伺服器」 
■ 第 49 頁 「登入和登出」
■ 第 50 頁 「選擇管理控制器的伺服器」 
■ 第 54 頁 「配置代理程式參數 ( 選擇性項目 )」 
■ 第 57 頁 「驗證儲存配置」 
■ 第 59 頁 「儲存邏輯磁碟機配置」 
■ 第 60 頁 「在執行 Solaris 作業環境系統上的伺服器上建立分割」 
■ 第 63 頁 「在 Windows 2000 作業系統上的伺服器上建立分割」
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啟動 Sun StorEdge Configuration Service

注意 – 必須是超級使用者 / 管理員才能執行主控台。

注意 – 因為主控台只有在執行時才能夠接收到事件警示，所以在配置陣列之後，一定要
讓 Sun StorEdge Configuration Service 在主控台工作站上以 小化模式執行。或者，
如果不想讓主控台一直執行，您可以使用 Sun StorEdge Diagnostic Reporter ( 一種以背
景服務方式執行的 Configuration Service 附屬公用程式 ) 將訊息從主機和陣列傳送到指
定的電子郵件位址。如需詳細資訊，請參閱 《Sun StorEdge 3000 Family Diagnostic
Reporter 使用者指南》。如果需要其他接收事件警示的方法，請參閱第 241 頁 「不使用
Sun StorEdge Configuration Service 而傳送 SNMP 陷阱」。

注意 – 為了讓 Sun StorEdge Configuration Service 能夠檢視和管理陣列，每塊 HBA 卡
都必須連接到主控制器。

▼ 將 Sun StorEdge Configuration Service 安裝在 
Solaris/Linux 作業環境上

在指令提示處，請鍵入

▼ 在 Microsoft Windows NT/2000 作業系統上啟動 
Sun StorEdge Configuration Service
選擇 [ 開始 ] → [ 程式集 ] → [Sun StorEdge 3000 Family] → [Configuration Service]。 

# ssconsole
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初次使用前後的主視窗
首次初始化程式時，主視窗為空白。Add Server 視窗會顯示，讓您能夠將伺服器加入到
使用中主控台的 Managed Servers 清單。如果要獲得有關新增伺服器的詳細資訊，請參
閱第 43 頁 「新增伺服器」。

首次啟動程式之後，以及選擇 Managed Servers 之後再次啟動時，主視窗會為 Managed
Servers 清單中的伺服器顯示伺服器圖示。按一下 OK 或 Cancel 以繼續。

配置新陣列並開啟工作站之後，只有在為邏輯磁碟機加入標籤後，程式才能夠發現陣列，
因為 Sun StorEdge Configuration Service 使用本機 Sun 驅動程式。

如果主控台在使用中鎖住

在執行 Solaris 或 Linux 作業環境的系統上，如果主控台在使用中鎖住，您可以停止 
Sun StorEdge Configuration Service，然後關閉再重新開啟視窗，而不會影響代理程式。

▼ 停止 Sun StorEdge Configuration Service

1. 在指令提示處，請鍵入

2. 重新執行程式。 

視窗重新顯示，而不會影響到代理程式。

# ssconsole stop
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功能表、工具列和標籤

查閱主視窗很有用，因為它包括功能表列、標籤及存取主要功能的工具列。

功能表列

下圖顯示各主功能表選項。

工具列

功能表列下面的工具列提供一些供您快速存取常用功能的圖示。選擇圖示以啟動其功能。
根據主視窗中可用資源的不同，工具列圖示可能會顯示為使用中或非現用狀態 ( 灰色 )。

Login

Logout

Server List Setup

Save Report

Exit

View Report

View Group

View Server

View Controller

View Logical Drive

View Physical Drive

View Enclosure 

View FRU

Event Log

File View

Configure Host/WWN (Fibre Channel only) 

LUN Filter Properties (Fibre Channel only)

Save Configuration

Load Configuration

Standard Configure

Custom Configure

Configuration Array Administration

Controller Assignment

Controller Maintenance

Download FW for Devices

View Peripheral Device

Rebuild

Parity Check

Schedule Parity Check

Contents

About sscsConsole

Help

Array Admin Progress

Agent Options Management

Display HDD under LD
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圖示 說明

Server List Setup 加入由主控台管理的伺服器、編輯伺服器資訊，
或指定可以管理的伺服器。

事件日誌。檢視諸如儲存裝置狀態變更、硬體狀態變更或操作通
知等事件。

儲存事件日誌。顯示 Save Event Log File 對話方塊，它可以讓您
很方便地儲存事件日誌，不用移至 Event Log 視窗。

刪除事件日誌。手動刪除 eventlog.txt 檔案的內容 ( 程式會累積事
件一直到達到 10,000 件的限制為止，這時 Event Log 會自動減少
為 近的 500 件事件 )。

儲存報告建立一個文字檔案，其中包含選定伺服器上每個儲存元
件到目前日期為止的資料。

標準配置在所選擇的陣列控制器上，建立一個或多個擁有一個 
RAID 等級的邏輯磁碟機。使用於您想要 Sun StorEdge 
Configuration Service 自動配置儲存的預先定義配置時。

Custom Configuration 以選取陣列控制器上各種不同 RAID 等
級，提供配置或重新配置邏輯磁碟機或邏輯磁碟區的多種選擇。
使用於您想要手動定義配置時 ( 包括設定或變更控制器 ID 和參
數，以及定義或修改 RAID 集和備用磁碟機 )。
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標籤

工具列下的標籤讓您能夠快速移動到其他 Sun StorEdge Configuration Service 視圖。

實體磁碟機 ( 硬碟 )
當陣列完全配置之後，主視窗會顯示多項元件。組成邏輯磁碟機的實體磁碟機預設會顯
示；不過，如果要讓主視窗更容易瀏覽，您可以藉由取消選取 View → Display HDD
under LD 不顯示實體磁碟機 ( 硬碟 )。 

瀏覽

程式符合標準的 Java 程式語言鍵盤和瀏覽操作。

標籤 說明

按一下以進入 Sun StorEdge Configuration Service 主視窗。

按一下以進入 Resource Allocation View ( 保留作為將來使用 )。

按一下以進入 LUN Filter View ( 僅適用光纖通道 )。
42 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



▼ 新增伺服器

監視或配置伺服器之前，您必須透過 Server List Setup 將伺服器加入到 Managed Servers
清單。

1. 啟動 Sun StorEdge Configuration Service ( 如果還沒有執行 )。

2. 選擇 File → Server List Setup。 

顯示 Server List Setup 視窗。

3. 將伺服器組織到群組中：

a. 按一下 Server List Setup 視窗中的 Groups。 

會顯示 Group List Setup 視窗。
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b. 在 Group Name 欄位中鍵入名稱，然後按一下 Add。

c. 如果要刪除群組，從 Available Groups 清單選擇群組名稱，然後按一下 Delete。

d. 加入或或刪除群組後，按一下 OK。 

會顯示 Server List Setup 視窗。

4. 加入伺服器：

a. 按一下 Available Servers 清單下的 Add。 

會顯示 Add Server 視窗。

b. 在 Server name 欄位中鍵入伺服器的名稱，然後按 Return。 

這是用於識別伺服器的名稱。如果該名稱位於網路的名稱伺服器資料庫中，Sun
StorEdge Configuration Service 會決定伺服器的 IP 位址並將位址顯示在 IP
Address 欄位中。

如果程式無法找到該名稱的 IP 地址，可能是因為名稱鍵入不正確，或者該名稱沒有
記錄在伺服器名稱資料庫中。
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c. 如有必要，請在 IP Address 欄位中鍵入伺服器的 TCP/IP 位址。

例如 192.168.100.1。

如果程式還沒有顯示 IP 位址 ( 如上一個步驟所示 )，應手動鍵入 IP 位址。

選擇 IP Address 欄位下的 Get IP Address by Name，也可以讓程式搜尋並自動顯示
IP 位址。如先前步驟中所述，網路必須擁有名稱伺服器資料庫，並且您必須鍵入該資
料庫所記錄的伺服器名稱才會起作用。否則就必須手動鍵入 IP 地址。

5. 選擇或取消選擇伺服器的 Automatic Discovery：

a. 如果您需要一個非常安全的環境，即使存取伺服器庫存資料也要受到限制，請對 Auto
Discovery 選擇 No。

如果選擇 No，程式就不會在啟動時擷取伺服器資訊。伺服器的圖示顯示為白顏色編
碼 ( 而不是亮紫色 )，以表示它未被發現。在未被發現的伺服器上按兩下時，Sun
StorEdge Configuration Service 提示您輸入 ssmon 使用者密碼。或者，您也可以選
擇伺服器，然後選擇 File → Login。

對 Auto Discovery 選擇 Yes，會在主控台啟動時擷取有關這個伺服器的所有可用資
訊。 

b. 如果為 Auto Discovery 選擇 Yes，應鍵入之前在伺服器 ( 或如果有網域或 NDS 樹，
則為伺服器群組 ) 上建立 ssmon 使用者時鍵入的密碼。

使用 Auto Discovery 建立伺服器之後，登入 Sun StorEdge Configuration Service
時就不需要鍵入 ssmon 密碼；您會自動擁有監視權限。

但是，每次選擇執行管理或配置活動的指令時，都會顯示一個登入對話方塊，提示您
鍵入先前為 ssadmin 或 ssconfig 使用者建立的密碼，以變更安全性等級。

c. 按一下 OK。

6. 設定電子郵件位址： 

a. 如果要讓 Sun StorEdge Configuration Service 使用電子郵件傳送事件訊息，請選
擇 Mailing Lists 標籤並繼續執行下列操作。 

使用者可能想要鍵入自己的電子郵件位址或選定使用者的位址，以實現接收關於伺服
器關鍵事件資訊的目的。
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注意 – 如果不想讓主控台一直在前景執行，您可以使用 Sun StorEdge Diagnostic 
Reporter ( 一種以背景服務方式執行的 Sun StorEdge Configuration Service 附屬公用程
式) 將訊息從主機和陣列發送到指定的電子郵件位址。如需詳細資訊，請參閱《Sun StorEdge
3000 Family Diagnostic Reporter 使用者指南》。為了確保 Sun StorEdge Configuration
Service 接收電子郵件，如需設定陷阱的資訊請參閱第 229 頁 「電子郵件和 SNMP」。
如果需要其他接收事件警示的方法，請參閱第 241 頁「不使用 Sun StorEdge Configuration
Service 而傳送 SNMP 陷阱」。

b. 對於每一個使用者，將電子郵件位址鍵入 Mail Address 欄位中。

c. 在 Severity 清單方塊中，捲動嚴重等級清單並選擇下列任何項目：

Critical – 要求網路管理員介入的訊息，例如裝置、電源或風扇出現故障。

Warning – 通常指示內部程式事件的訊息。如果看到這些訊息大量出現，可能表示伺
服器或網路存在問題。 

Informational – 關於伺服器上裝置的訊息，不需要網路管理員進行介入。
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無論選擇的等級如何，都會接收到該等級以及任何更高嚴重等級的事件訊息。例如，
如果選擇 Informational，則會通知您有關任何類型的故障訊息。相反的，如果只需
要在發生嚴重情況時收到通知，可以選擇 Critical，這樣就不會獲得任何 Informational
或 Warning 事件通知。

d. 按一下 Add to List。

若要從清單中刪除使用者，選擇郵件地址並按一下 Delete from List。

e. 指示要使用的郵件伺服器。 

請注意，Setup Mail Server 按鈕與 Change Mail Server 按鈕會依據先前是否已經定
義郵件伺服器而相互切換。

對於新設定，請按一下 Setup Mail Server。將顯示類似下面的 Mail Server Setup 視
窗。

f. 鍵入簡單郵件傳輸通訊協定 (SMTP) 郵件伺服器的 IP 位址或名稱，該郵件伺服器是
用於將電子郵件訊息傳送到先前所指定的目標位址。

g. 如果對 Mail Server 視窗中的資訊感到滿意，則按一下 OK。 

會顯示 Add Server 視窗，其中有 Mailing Lists 標籤。
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7. 完成 Add Server 功能：

a. 如果您希望這個伺服器成為某個群組的一部分，請選擇 Grouping 標籤。 

會顯示 Add Server 視窗。

b. 選擇清單方塊，以查看可用選項。 

c. 選擇需要的群組並放開滑鼠按鈕。

d. 按一下 OK 以登記變更。

8. 如果要新增更多的伺服器，應為每台伺服器重複步驟 3 到 7。

9. 將您想要這個主控台控制的伺服器移動到 Managed Servers 清單 ( 請參閱第 43 頁「新
增伺服器」 )。

■ 如果要讓該主控台管理所有可用的伺服器，按一下對話方塊頂部的 Add All。

■ 如果要將單獨伺服器移動到受管理的欄，應單獨選擇每台伺服器，並按一下兩個清單
方塊之間的 Add。

■ 如果在新增伺服器過程中需要進行修改，請參閱第 191 頁 「編輯伺服器項目」。

10. 新增伺服器後，按一下 OK 返回主視窗。

注意 – 如果陣列連接到多台主機，且每個主機上都安裝了代理程式，則必須輸入每個主
機的 IP 位址，並且將它們加入到 Managed Servers 清單。
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▼ 登入和登出

登入和登出功能提供了程式內的安全性。安全性等級是透過設定三個使用者建立：
ssmon、ssadmin 和 ssconfig，每一個都有密碼

■ ssmon 代表軟體的監視等級，它顯示來自控制器的警示。  

■ ssadmin 代表軟體的管理等級，可提供對 Rebuild、Parity Check、Schedule Parity
Check 以及監視功能的存取。 

■ ssconfig 代表配置等級，可提供對配置指令和程式所有方面的存取。

1. 如果要登入，請選擇 File → Login。

只有在作為監視使用者時才維持連續存取。選擇需要管理或配置等級的指令時，會顯示
登錄對話方塊，您可以使用適當的密碼登入到該等級。完成活動後登出。

2. 如果要登出，請選擇 File → Logout。 

如果從管理或配置等級登出，將提供您擁有登出到監視模式或從整個伺服器登出的選項。
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▼ 選擇管理控制器的伺服器

為了管理和監視陣列，代理程式需要存取一個已對應到邏輯磁碟機 ( 已分配給陣列的主
控制器 ) 分割區的主機 LUN。  

代理程式會忽略所有已對映到邏輯磁碟機 ( 已分配給複式配置陣列中的次控制器 ) 分割
區的主機 LUN。

注意 – 如果需要針對邏輯磁碟機和 LUN 的討論，請參閱第 195 頁「RAID 基本知識」。 

如果同一個陣列與多台伺服器連接，有可能讓每台伺服器上執行的代理程式嘗試管理和
監視同一個陣列。因為限制一次只能有一台伺服器將監視指令傳送到控制器，所以如果
多台伺服器同時傳送監視指令，有些指令可能會失敗。這可能會導致報告不準確，或者
程序停止回應。為避免發生這種情況，可以將代理程式配置成在伺服器上啟用 / 停用陣
列監視。

透過主控台分配控制器

可以從主控台執行下列過程，將伺服器的控制權分配給控制器。

1. 請確保所有直接連接的伺服器，都是依照第 43 頁 「新增伺服器」中的指示進行新增。 

這確保兩個主機名稱都出現在 Controller Assignments 下。

2. 從主視窗按一下 Array Administration → Controller Assignment。 

會顯示 Assign Server to Manage a RAID Controller 視窗。 

3. 從 Server to manage this controller 清單選擇伺服器，然後按一下 Apply。

這會啟用選定的伺服器來管理陣列控制器，也會讓所有其他列出的伺服器停止管理相同
的陣列。
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4. 按一下 Close 以關閉檢視。

主視窗只會在已對這個陣列啟用監視的伺服器下顯示陣列控制器裝置圖示。 
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變更伺服器分配 

當您分配伺服器來管理控制器時，會產生有關管理伺服器的資訊。程式會將這項資訊儲
存在控制器上，並且用它來追蹤這個管理伺服器。萬一關閉了伺服器 ( 例如進行維護 )，
而且您嘗試分配另一台伺服器來管理這個控制器，程式會從控制器讀取儲存的伺服器資
訊，並且警告您這個控制器已經受到管理。

注意 – 如果您希望強制執行新的伺服器分配，可以置換目前的伺服器分配。

您可以使用名為 view and edit Host luns → Edit Host-ID/WWN Name List 的韌體應
用程式功能表來檢視管理伺服器名稱。

如果您要變更伺服器分配，例如要將陣列移到新的位置，在移動陣列之前，您必須先依
照第 53 頁 「取消分配管理伺服器」中的步驟取消分配管理伺服器。 

如果已經移動了陣列，當啟動陣列時，您可能會看到這個控制器已經由另一個伺服管理
的警告訊息。您必須依照第 53 頁 「使用終端機視窗以手動方式刪除伺服器」中的步驟
以手動方式刪除這個伺服器。如果需要有關存取韌體應用程式的資訊，請參閱陣列的
《Sun StorEdge 3000 Family RAID Firmware User's Guide》。

伺服器名稱儲存在
ASCII 字元集的
十六進位值中。
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▼ 取消分配管理伺服器

1. 從主視窗按一下 Array Administration → Controller Assignment。

2. 選擇要取消分配之伺服器的陣列控制器。

3. 從 Server to manage this controller: 清單方塊，選擇 none。

對顯示的下列警告訊息 ( 確認選取的控制器將不再受到某個伺服器管理 )，按一下 Close。

4. 依照第 50 頁 「透過主控台分配控制器」中的步驟，選擇要管理這個控制器的伺服器。

▼ 使用終端機視窗以手動方式刪除伺服器

如果需要有關存取韌體應用程式的資訊，請參閱陣列的 《Sun StorEdge 3000 Family
RAID Firmware User's Guide》。

1. 從主功能表選擇 view and edit Host luns，然後按 Return。

2. 選擇 Edit Host-ID/WWN Name List，然後按 Return。

3. 從 Name List 選擇 sscsMgr，然後按 Return。

4. 選擇 Delete Host-ID/WWN Name List，然後按 Return。

5. 選擇 Yes，然後按 Return。
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▼ 配置代理程式參數 ( 選擇性項目 )
本節提供使用 View → Agent Options Management  指令配置代理程式參數的步驟，
其中包括輪詢時間、週期性裝置發現時間、智慧監視和頻外儲存管理。 

1. 從主視窗中，選擇 View → Agent Options Management。 

會顯示 Agent Options Management 視窗。

注意 – 如果已經配置一個或多個群組，並且在主視窗中選擇了其中一個群組，則 Agent
Options Management 無法使用。如果要啟用它，請選擇一個圖示而不是一個群組，然
後按一下 View。

2. 對於 Monitoring Frequency in Seconds，以秒為單位鍵入需要的數目。

這個值是代理程式連續向裝置、陣列控制器和機箱監視輪詢狀態更改的間隔。預設值為
60 秒。如果想要主控台更頻繁地更新裝置狀態，請減少這個值。
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注意 – 增加輪詢間隔可能會在大量 I/O 負荷的情況下對錯誤訊息處理產生負面影響。

3. 對於 Periodic Device Discovery，以分鐘為單位鍵入想要檢查新裝置的值。

週期性裝置發現值用來確定掃描每個裝置 ID 發現新裝置的頻率。預設值 0 表示不掃描
新裝置。請注意，當數值增加時，掃描裝置 ID 的頻率就會降低。

反之，當數值減少時，掃描裝置 ID 的頻率就會提高。五分鐘是 小值。

4. 對於 Interval of trap generation，以秒為單位鍵入發送兩個陷阱訊息之間的間隔時間。 

如果值為 60 秒或更大，會按照這個時間間隔為該特定陷阱傳送訊息，直到事件清除或更
正為止。例如，如果風扇發生故障，則每隔 60 秒發送一個關於風扇故障的訊息，直到修
復為止。

如果值為 0，則 Sun StorEdge Configuration Service ( 以及 Sun StorEdge Diagnostic
Reporter) 只發送一個關於特定事件的訊息。例如，如果發生風扇故障，則只發送一封電
子郵件。

5. 對於 Timeout of heartbeat lost，設定發送故障伺服器消息之間以分鐘為單位的等待時
間。 

預設值為 15 分鐘；這個值的範圍是 1 至 30 分鐘。 

6. 如果要  Enable SMART Monitoring ( 啟用 SMART 監視 )，選擇該核取方塊。

SMART 監視是報告硬碟磁碟機預測故障的方法。大多數磁碟供應商都提供含有此功能
的磁碟機。代理程式透過發出主動請求感應，對該功能進行監視。如果這個請求與基礎
的主機作業環境和系統裝置驅動程式衝突，可以將 SMART 監視功能關閉。如果需要
SMART 監視的相關資訊，請參閱陣列的 《Sun StorEdge 3000 Family RAID Firmware
User's Guide》。

7. 如果要 Enable JBOD support ( 啟用 JBOD 支援 )，請參閱第 56 頁「啟用 JBOD 支援
( 僅適用於 SCSI)」。

8. Controller Primary Agent Information 之下包含 Password 欄位的參數和頻外管理有
關。如果需要配置這些參數的資訊，請參閱第 129 頁 「使用頻外管理」。

9. 如果選擇前面的任何選項，按一下 OK 以儲存變更。

會顯示 Setting Agent Options 通知訊息方塊，顯示伺服器的 TCP/IP 位址。
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10. 按一下 OK 以完成過程。

▼ 啟用 JBOD 支援 ( 僅適用於 SCSI)
如果是 Sun StorEdge 3310 SCSI Array，必須有直接連接到工作站的 JBOD，才可以使
用「一群磁碟機」 (Just a Bunch of Disks/JBOD) 支援。這使得您能夠監視週邊裝置的
狀況和事件。如果有連接到 RAID 陣列的 JBOD，RAID 控制器會為您監視 JBOD 狀況
和事件。 

注意 – 啟用 JBOD 支援可能會影響 I/O。

1. 請依照第 54 頁 「配置代理程式參數 ( 選擇性項目 )」中的步驟進行。

2. 選擇 Enable JBOD support。

如果需要有關監視 JBOD 的詳細資訊，請參閱第 211 頁「監控 JBOD ( 僅適用於 SCSI)」。
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▼ 驗證儲存配置

安裝 Sun StorEdge Configuration Service 和新增所有要管理的儲存伺服器後，需要驗
證儲存配置。 

注意 – 大部分陣列出貨時都已預先配置。如果想要完全刪除現有配置並重新開始，請參
閱第 65 頁「完全配置」。如果想要更改現有的配置或增加到其中，請參閱第 151 頁「更
新配置」。

1. 確定伺服器圖示是連線中 ( 也就是伺服器符號是紫色 )。  

在重新開機過程中，Sun StorEdge Configuration Service 會自動啟動。

2. 觀察主視窗並檢查儲存配置。

3. 如果有多台受管理的伺服器，請選擇要檢查的伺服器。 

如果伺服器圖示不是紫色，請確定伺服器的狀態 ( 請參閱表 9-1)。如果伺服器圖示附有
碟形衛星天線 ，則伺服器可能正處於發現程序中，可以在短暫延遲後使用。  

4. 按一下出現在要檢查其儲存設備的伺服器左面的容器符號 。

如下圖所示，程式會以圖形方式顯示連接到該伺服器的每個陣列控制器。 
第 6 章 設定 Sun StorEdge Configuration Service 57



5. 如果要查閱其他詳細資訊，請按一下您要檢查儲存裝置的陣列控制器旁邊的容器符號
。

如果還沒有配置陣列，則不會顯示任何邏輯磁碟機 ( 控制器的 LUN)。

如果已經完全配置陣列，程式會顯示與所選擇陣列控制器相關的裝置和邏輯磁碟機。它
看起來應該類似下圖中顯示的裝置。  

選擇任何邏輯磁碟機左側的容器符號 能夠顯示其分配的實體磁碟機。

注意 – 您可以藉由選取或取消選取 View → Display HDD under LD，來檢視組成邏輯
磁碟機的實體裝置 ( 硬碟 )。

根據您安裝的陣列產品的不同，配置可能與之前圖中的顯示有很大的差別。

如果沒有配置陣列，請參閱第 65 頁 「完全配置」中有關配置陣列的指令。

6. 檢查 RAID 等級和邏輯磁碟機結構。

7. 如果已經配置陣列，而且配置符合您的要求，請繼續前進到下一節。 

如果您想要更改配置，請參閱第 65 頁 「完全配置」。 
58 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



▼ 儲存邏輯磁碟機配置

雖然邏輯磁碟機配置資訊儲存在陣列控制器以及連接到他們的實體磁碟機上，但是像火
災這類極端情況仍然會造成控制器和磁碟機的損壞。因此，請務必在陣列以外的軟碟或
其他外部媒體上保留目前邏輯磁碟機 ( 或 LUN) 的多個備份。至少應該將一個備份副本
保存在密室或其他遠離現場的安全地點。配置的備份副本可讓您將配置恢復到新控制器
上，而不必完全重新配置陣列。如果沒有目前配置的備份副本，則可能會損失資料。

無論下列何種情況下，應隨時將陣列控制器配置儲存在檔案中：

■ 安裝新的儲存系統機箱，或更改現有機箱中控制器的 SCSI ID

■ 更換陣列控制器

■ 重新配置或將邏輯磁碟機加入陣列控制器

■ 從故障磁碟機將資料重建到備用磁碟機

如果要從檔案上恢復配置，請參閱第 143 頁 「恢復邏輯磁碟機配置」。

1. 選擇含有要儲存其配置的控制器。

2. 選取 Configuration → Save Configuration。 

會顯示 Save Configuration 視窗。
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3. 瀏覽到必要的磁碟機和檔案夾，找出要更新的配置檔 ( 該檔案是以 .cfg 副檔名表示 )。

將檔案儲存在軟碟片或陣列以外的磁碟機。也就是說，將這些配置檔的副本保存在遠離
現場的地方。

4. 指定配置檔案名稱，然後按一下 Save。 

會顯示 Save Configuration 視窗。

5. 為您要儲存的配置鍵入說明，然後按一下 OK。

控制器配置資訊儲存在 .cfg 檔案。

▼ 在執行 Solaris 作業環境系統上的伺服器上
建立分割

如果儲存配置正確的話，就可以針對這個作業環境進行儲存陣列分割。 

下列步驟是一般的準則。如果要獲得詳細資訊，請閱讀 Sun Solaris 作業環境手冊中關
於建立分割區和檔案系統的內容。
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1. 鍵入以下指令以標示新 LUN

format 指令會顯示系統磁片以及連接到陣列的其他磁碟機。

新的 LUN 必須先用 format 指令標示，然後才能設定供陣列使用。啟動 format 指令
時，將顯示可用的 LUN 和硬碟。  

2. 選擇要使用的裝置。 

如果出現提示，則標示這項裝置。

3. 輸入 partition 來檢視現有的分割區表格。

4. 視需要編輯分割區表格，如果做了變更，請加上標示。

5. 使用 newfs 指令在分割區上建立檔案系統。

6. 使用 mount 指令，或編輯 /etc/vfstab 並使用 mountall 指令，可以安裝檔案系統。

# format
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▼ 在 Windows NT 作業系統的伺服器上建立分割

開始本節之前需要重新啟動電腦，以便讓 Windows NT 辨識新的儲存容量。下列步驟是
一般性準則，如果需要詳細資訊，請參閱 Windows NT 文件說明。

注意 – 不能在遠端完成此步驟。必須在伺服器上執行這個步驟。

1. 選擇 [ 開始 ] → [ 程式集 ] → [ 系統管理工具 ] → [ 磁碟管理 ]。

2. 在每個 Disk Administrator 訊息方塊中選擇 Yes。

3. 將游標移動到水平列，然後按一下滑鼠左鍵，選擇邏輯磁碟機。

4. 選擇 Disk Administrator Partition → Create。

顯示提示視窗，詢問是否要建立預設容量為整個邏輯磁碟機容量的分割區。

5. 如果要在邏輯磁碟機上建立多個分割區，應輸入需要的分割區大小。

重複該步驟直到已使用所有邏輯磁碟機容量為止。

6. 選擇 Disk Administrator Partition → Commit Changes Now。

此功能用於格式化並使用邏輯磁碟機，而無需重新啟動 Windows NT 作業系統。

7. 選擇新建立的邏輯磁碟機分割區。

8. 選擇 Disk Administrator Tools → Format。選擇 NTFS (NT 檔案系統 ) 格式。

重複步驟 7 和 8 以格式化每一個在邏輯磁碟機上建立的分割區。

9. 格式化完成後，請關閉 Disk Administrator。
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▼ 在 Windows 2000 作業系統上的伺服器上
建立分割

下列步驟是一般性準則，如果需要詳細資訊，請參閱 Windows 2000 文件說明。

1. 選擇 [ 設定 ] → [ 控制台 ] → [ 系統管理工具 ] → [ 電腦管理 ] → [ 磁碟管理 ]。

請確認您可以看到 [ 磁碟管理 ] 之下以磁碟圖示  標示的新磁碟機。

2. 用滑鼠右鍵按一下要寫入簽名的磁碟，然後選擇 [ 寫入簽名 ]。

3. 選擇要建立分割區的磁碟，然後按一下 [ 確定 ]。

4. 用滑鼠右鍵按一下這個磁碟機 ( 已顯示磁碟機容量 )，然後選擇 [ 建立磁碟分割 ]。

5. 正確地回應分割區精靈的提示。 

用滑鼠右鍵按一下
要寫入簽名的磁碟。

用滑鼠右鍵按一下
要建立分割區的磁碟機。
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下一個步驟

現在已經安裝、設定並準備好可以使用 Sun StorEdge Configuration Service ( 主控台和
代理程式 )。請參閱下列的章節，以瞭解其他工作：

■ 第 99 頁 「監視陣列」，可以獲得如何使用 Sun StorEdge Configuration Service 監
視儲存裝置的資訊。

■ 第 135 頁「維護陣列」，可以獲得有關維護陣列的資訊。其中包含詳細的資訊，說明
同位檢查、排程同位檢查、重建故障磁碟機以及從備份檔案恢復配置。

■ 第 151 頁「更新配置」，用於想要更新儲存陣列配置時。其中也涵蓋變更控制器功能、
建立或變更備用磁碟機，並編輯關於可用伺服器的資訊。
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第  章7

完全配置

出貨之前，Sun 已在陣列上預先配置邏輯磁碟機。如果陣列尚未配置，或者想要完全移
除現有配置並且重頭開始，才需要閱讀本章。如果要變更現有的配置，請參閱第 151 頁
「更新配置」。

完全配置包括下列主題：

■ 第 66 頁 「配置邏輯磁碟機和邏輯磁碟區」

■ 第 66 頁 「使用 Standard Configuration 來對邏輯磁碟機進行配置」

■ 第 69 頁 「使用 Custom Configuration 配置邏輯磁碟機和邏輯磁碟區」

■ 第 80 頁 「建立和分割邏輯磁碟區」

■ 第 82 頁 「清除配置」

■ 第 82 頁 「登出配置等級」

■ 第 83 頁 「主機 LUN 分配」

■ 第 83 頁 「新增 ( 對應 ) 主機 LUN」

■ 第 85 頁 「刪除 ( 取消對應 ) 主機 LUN」

■ 第 85 頁 「配置檔案」

■ 第 86 頁 「將配置儲存到備份檔案」

對於 Sun StorEdge 3310 SCSI Array，如果您計劃設定叢集配置，請參閱第 219 頁「使
用叢集配置 ( 僅適用於 SCSI)」。

如果正在執行陣列管理程序 ( 如同位檢查等 )，可能會暫時停用某些 Configuration 功能
表指令和工具列圖示。在主控台正在更新伺服器上的庫存時，功能表指令也遭到停用。
在更新過程中，碟形天線圖示將附加到伺服器圖示上。
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小心 – 配置陣列之前請先將任何現有的資料備份到外部裝置。重新配置將會覆寫任何現
有的邏輯磁碟機配置。覆寫現有邏輯磁碟機配置時，將會實際刪除所有資料。

配置邏輯磁碟機和邏輯磁碟區
您可以依據是否要使用一個或多個 RAID 等級，使用 Standard Configuration 或 Custom
Configuration 來配置邏輯磁碟機。邏輯磁碟區則只能使用 Custom Configuration 建
立。 

注意 – 在 Sun StorEdge 3310 SCSI Array 上， 多可以建立 8 個邏輯磁碟機，每個邏輯
磁碟機 多可有 32 個分割區。 多可以分配 128 個 LUN。一個邏輯磁碟區 多可以劃
分為 32 個分割區。在 Sun StorEdge 3510 FC Array 上， 多可以建立 8 個邏輯磁碟
機，每個邏輯磁碟機 多可有 128 個分割區。 多可以分配 1024 個 LUN ( 分配給每個
主機 ID 的 LUN 大數目為 32 個 )。一個邏輯磁碟區 多可以劃分為 128 個分割區。 

▼ 使用 Standard Configuration 來對邏輯磁碟機
進行配置

使用 Standard Configuration 選項可以使用一個 RAID 等級快速配置連接到陣列控制
器的所有儲存裝置。所需要提供的全部資訊就是 RAID 控制器、 佳化模式和 RAID 等
級。您也必須指定是否需要備用磁碟機。然後 Sun StorEdge Configuration Service 自
動為您配置儲存設備，根據 RAID 等級和可用的磁碟機數目建立一個或多個邏輯磁碟機。
寫回快取記憶體依預設值選擇。您可以在配置完成前查看結果，並選擇接受或拒絕。

小心 – 使用 Standard Configuration 之前，請將任何現有的資料備份到外部裝置。
Standard Configuration 會覆寫任何現有的邏輯磁碟機配置。覆寫現有邏輯磁碟機配置
時，將實際刪除所有資料。
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1. 以 ssconfig 使用者身份登入。

2. 在主視窗選擇所需的 RAID 控制器。

3. 判斷邏輯磁碟機的 佳化模式是 Sequential I/O ( 預設值 ) 還是 Random I/O。陣列中
的所有邏輯磁碟機都必須套用 佳化模式。您的選擇會影響您可以在陣列中包括的磁碟
機 大數目。

在 Change Controller Parameters 視窗的 Cache 標籤上設定 佳化。如果需要 Sequential
I/O 和 Random I/O 的詳細資訊，以及設定 佳化的步驟，請參閱第 180 頁 「Cache
標籤」。

4. 選取 Configuration → Standard Configure。 

會顯示 Standard Configuration Warning 訊息。按一下 OK 繼續進行。

會顯示 Standard Configuration Options 視窗。如果目前還沒有以 ssconfig 登入，則
會顯示登入對話方塊。 
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依據可用的磁碟機數量以及系統的伺服器上是執行 Solaris 作業環境或 Windows NT 作
業系統而定，視窗中的某些選項可能是停用的。

NT Cluster 選項會建立一個仲裁 RAID 5 邏輯磁碟機 (100 MB)，然後將剩餘容量分配
在兩個大型的 RAID 5 邏輯磁碟機上。如要獲得該選項，需要三台或更多實體磁碟機。

5. 驗證顯示在視窗頂部的伺服器和控制器 ID 是否正確。

如果顯示在視窗的上方伺服器和控制器不正確，請按一下 Cancel 結束這個配置視窗並
返回主視窗。選擇適當的裝置，然後再次選擇該視窗。

6. 指示是否要使用其中一台磁碟機作為備用磁碟機。

如果選擇 Use a standby drive，程式將會停用不使用備用磁碟機的 RAID 等級 ( 例如，
RAID 0 沒有容錯功能，因此備用磁碟機沒有任何助益 )。

7. 從可用的 RAID 等級，為要配置的邏輯磁碟機選擇適合的 RAID 等級。

如果需要有關 RAID 等級的定義，請參閱第 195 頁 「RAID 基本知識」。

如果選擇 RAID 3 或 5，則 Standard Configuration 通常會配置一個大的邏輯磁碟機。
但是，如果陣列擁有超過 31 個實體磁碟機，則會建立一個以上的邏輯磁碟機。同時，您
至少要有三個磁碟機才能使用 RAID 3 或 5。

如果選擇了 RAID 1，每個邏輯磁碟機都需要至少兩台實體磁碟機。如果選擇四個以上
的磁碟機，就會以 RAID 1+0 建立邏輯磁碟機。

如果選擇 RAID 0，陣列如果擁有超過 36 個磁碟機，就會建立一個以上的邏輯磁碟機 

8. ( 僅適用於 Solaris 作業環境 )。如果要自動標示新的邏輯磁碟機好讓作業環境使用磁碟
機，請按一下 Write a new label to the new LD。
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9. 選擇 RAID 等級之後，請按一下 OK。

會出現 Confirm Configuration Operation，並且顯示新的配置。 

10. 按一下 OK 按照指示接受配置；否則按一下 Cancel 返回主控台。

▼ 使用 Custom Configuration 配置邏輯磁碟機和
邏輯磁碟區

Custom Configuration 讓您有多種選擇，可以使用不同的 RAID 等級和其他 RAID 參
數來配置或重新配置邏輯磁碟機；也可以讓您選擇將新建立的邏輯磁碟機新增到邏輯磁
碟區。

1. 以 ssconfig 使用者身份登入。 

2. 在主視窗選擇所需的 RAID 控制器。

3. 選取 Configuration → Custom Configure。 

顯示 Custom Configuration Options 視窗。
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■ New Configuration – 以不同的 RAID 等級和其他 RAID 參數配置新邏輯磁碟機，而
且可以讓您將新的邏輯磁碟機新增到邏輯磁碟區。New Configuration 指令會刪除陣
列控制器上之前的配置。

■ Add LDs/LVs to the Current Configuration – 將新的邏輯磁碟機 / 邏輯磁碟區新增
到現有的配置。此指令不會刪除已經在控制器上配置的其他邏輯磁碟機。

■ Dynamically Grow and/or Reconfigure LDs/LVs – 讓您可以擴充邏輯磁碟機和邏
輯磁碟區的容量、將 SCSI 磁碟機新增到現有的邏輯磁碟機和邏輯磁碟區，以及利用
高容量的磁碟機複製並替換所有成員磁碟機。

■ Make or Change Standby Drives – 新增一台或多台要與陣列控制器關聯的新備用磁
碟機。

■ Change Host LUN Assignments – 讓您可以將邏輯磁碟機、邏輯磁碟區和分割區分
配給主機通道。

■ Change Controller Parameters – 讓您可以修改控制器參數。 
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■ Manage Existing LDs/LVs and Partitions – 讓您可以刪除個別邏輯磁碟機和邏輯磁
碟區，以及從現有的邏輯磁碟機和邏輯磁碟區建立或刪除分割區。

■ Configure Web Server( 需要 Sun StorEdge Enterprise Storage Manager Topology
Reporter 軟體) – 讓您可以配置 Web 伺服器，以便利用 Web 瀏覽器管理或監視陣列。 

本章詳細說明 New Configuration 選項。Configure Web Server 會在第 132 頁「透過
網路管理儲存設備」中說明；其餘選項會在第 151 頁 「更新配置」中說明。 

New Configuration 選項

New Configuration 選項讓您可以自訂邏輯磁碟機配置，以滿足環境的特定需要。您可
以用不同的 RAID 等級來配置和分割一個或多個邏輯磁碟機，然後您可以將兩個或更多
( 未分割的 ) 邏輯磁碟機新增到一個邏輯磁碟區，並將這個邏輯磁碟區 多分割成 32 個
適用於 SCSI 的分割區，和 128 個適用於光纖通道的分割區。

注意 – 在執行 Solaris 作業環境的系統上，如果主控台在使用時鎖住，您可以依照第 39
頁 「如果主控台在使用中鎖住」中的說明取得程序編號，然後關閉再重新開啟視窗。

使用 New Configuration 之前

第一次使用 New Configuration 建立邏輯磁碟機或邏輯磁碟區之前， 好先熟悉下列步
驟中的相關資訊。先瞭解這些資訊可以讓建立邏輯磁碟機或邏輯磁碟區的過程更順暢。 

1. 判斷邏輯磁碟機的 佳化模式是 Sequential I/O ( 預設值 ) 還是 Random I/O。陣列中
的所有邏輯磁碟機都必須套用 佳化模式。您的選擇會影響您可以在陣列中包括的磁碟
機 大數目。

在 Change Controller Parameters 視窗的 Cache 標籤上設定 佳化。如果需要 Sequential
I/O 和 Random I/O 的詳細資訊，以及設定 佳化的步驟，請參閱第 180 頁 「Cache
標籤」。
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2. 根據選擇的 佳化模式，決定要包含在邏輯磁碟機中的實體磁碟機總數。

如果安全性對您的資料而言很重要的話，請保留一些剩餘磁碟做為備用磁碟機。

如果需要每個邏輯磁碟機用於隨機和順序 佳化的 大磁碟數目和 大可使用容量的資
訊，請參閱第 181 頁「磁碟的 大數目以及 Random 和 Sequential 佳化的 大未用
容量」。

注意 – 如果邏輯磁碟機將大於 253 GB，請參閱第 73 頁「準備大於 253 GB 的邏輯磁碟
機」。

3. 決定是否要讓任何備用 ( 後備 ) 磁碟機成為本機或全域磁碟機。

備用磁碟機是一個標示為「備用」的磁碟機，用於在與邏輯磁碟機相關的實體磁碟機發
生故障後支援自動重建資料。如果要讓備用磁碟機取代另一部磁碟機，它的大小至少應
該和故障的磁碟機一樣大。而且，故障的磁碟機本身必須是來自 RAID 1、3 或 5。 

本機後備磁碟機是分配用做單一指定之邏輯磁碟機的後備磁碟機。當指定之邏輯磁碟機
的某一成員磁碟機發生故障時，本機後備磁碟機就會成為成員磁碟機，並且自動開始重
建。

全域後備磁碟機不單只為一個指定的邏輯磁碟機服務。當任何邏輯磁碟機的成員磁碟機
發生故障時，全域後備磁碟機就會加入該邏輯磁碟機，並且自動開始重建。

4. 決定 RAID 等級；程式會自動計算可以在該 RAID 等級建立的 大邏輯磁碟機大小。

5. 決定是否要分割邏輯磁碟機。

分割區是對邏輯磁碟機 ( 或邏輯磁碟區 ) 的邏輯劃分。分割區可以讓您建立獨立的邏輯
磁碟機 ( 或邏輯磁碟區 ) 外觀，以便於檔案管理、多使用者或其他用途。

注意 – 可以在初始配置時或建立邏輯磁碟機後建立分割區。

注意 – 已經分割的邏輯磁碟機不能新增到邏輯磁碟區。
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6. 瞭解 New Configuration 視窗中顯示的磁碟容量。

■ Max Drive Size (MB) – 顯示每個選取的實體磁碟 大磁碟機容量 ( 每個磁碟的總容
量 )。

減小該值可以建立較小的邏輯磁碟機。日後可以藉由擴充磁碟機來使用剩餘部分 ( 如
第 163 頁 「擴充邏輯磁碟機或邏輯磁碟區的容量」中所示 )。

■ Available Size (MB) – 顯示所有磁碟的總容量，也就是邏輯磁碟機或邏輯磁碟區的總
容量。

注意 – 邏輯磁碟機的 大未用容量等於 小實體磁片大小。例如，如果新增一片 18 GB
的磁片然後又新增一片 70 GB 的磁片作為邏輯磁碟機的一部分，則每個磁碟機的 大未
用容量為 18 GB。

7. 決定邏輯磁碟機是否要作為邏輯磁碟區的一部分。 

注意 – 已經分割的邏輯磁碟機不能新增到邏輯磁碟區。

8. 決定是否要分割邏輯磁碟區。

注意 – 分割可以在初始配置時進行，也可以在建立邏輯磁碟區之後進行。

9. 決定 Background Rate ( 背景工作優先權 )，這是分配給陣列管理活動 ( 如重建磁碟機、
檢查同位檢查、初始化 ) 的可用陣列控制器 CPU 時間的百分比。 

如果 background rate 設定為 100%，陣列管理活動比其他系統活動具有更高的優先順
序。如果為 0%，則只有在陣列控制器上沒有其他活動時才會進行陣列管理活動。

▼ 準備大於 253 GB 的邏輯磁碟機
Solaris 作業環境需要磁碟機幾何資訊供各種作業使用，包括 newfs。為了讓大於 253
GB 的邏輯磁碟機能向 Solaris 作業環境呈現正確的磁碟機幾何資訊，您必須使用韌體應
用程式配置 Host Cylinder/Head/Sector Mapping Configuration。如果需要有關存取
韌體應用程式的資訊，請參閱陣列的《Sun StorEdge 3000 Family RAID Firmware User's
Guide》。
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1. 在韌體應用程式中，選擇主功能表上的 view and edit Configuration parameters。

2. 選擇 Host-Side SCSI Parameters。

3. 選擇 Host Cylinder/Head/Sector Mapping Configuration。

4. 選擇 Sector Ranges 並且指定 255。

5. 選擇 Head Ranges 並且指定 64。

6. 選擇 Cylinder Ranges 並且指定 <65536。

▼ 使用 New Configuration 建立和分割邏輯磁碟機

第一次使用 New Configuration 建立和分割邏輯磁碟機之前， 好先複習第 71 頁「使
用 New Configuration 之前」中的步驟。

下列步驟提供了對新邏輯磁碟機建立新配置的工作範例。範例中選取了三個邏輯磁碟機，
並且配置成一個 RAID 5 邏輯磁碟機，接著會建立和分割一個小邏輯磁碟機。

小心 – 使用 New Configuration 指令之前，請將任何現有的資料備份到外部裝置。Sun
StorEdge Configuration Service 會自動初始化陣列控制器上所定義的新邏輯磁碟機。

1. 以 ssconfig 使用者身份登入。 

2. 在主視窗選擇所需的 RAID 控制器。

3. 選取 Configuration → Custom Configure。 

4. 按一下 New Configuration。 

會顯示 New Configuration Warning 訊息方塊。
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5. 按一下 OK。 

6. 驗證顯示在視窗頂部的 Server 和 Controller 是否正確。

如果顯示的伺服器和控制器不正確，請按一下 Cancel 結束 New Configuration 視窗並
返回主視窗。選擇適當的磁碟控制器，然後重新選擇 New Configuration。

7. 如果需要，請為控制器設定 Background Rate。 

8. 在 Select disks for Logical Drive 清單方塊中，選擇第一個磁碟並按一下 Add Disk。 

繼續新增後面兩個磁碟，讓這三個磁碟都顯示在清單方塊的下方。 

如果操作錯誤或改變決定，可以從磁碟機清單中選擇磁碟機，然後按一下 Remove Disk。

注意 –因為這個邏輯磁碟區還沒有分割，所以 Part Size (MB) 與  Available Size (MB) 兩
者容量是一樣的。一個單一的邏輯磁碟機會被視為一個單一分割區。
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9. 選擇 RAID Level。對這個範例而言，選擇 RAID Level 5。

這應用於邏輯磁碟機中的所有磁碟。 

在這個範例中，新邏輯磁碟機是由三個實體磁碟組成，總計 103428 MB，如 Available
Size (MB) 欄位中所示。

對於每個 RAID 等級，每一個邏輯磁碟機的 大磁碟數目如下：

■ RAID 0 -36
■ RAID 1 - 2
■ RAID 1+ 0 - 36
■ RAID 3 或 5 - 31

對於 RAID 1，請注意，如果選擇四個或更多磁碟機，就會建立有 RAID 1+0 的邏輯磁
碟機。

10. 設定 Max Drive Size。

Max Drive Size 顯示每個磁碟的總容量。減少這個值可以建立較小的邏輯磁碟機。

Max Drive Size – 顯示
每個磁碟的總容量

Available Size – 顯示所
有磁碟的總容量，也就是
邏輯磁碟機的總容量
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注意–如果不變更 Max Drive Size 但是變更了 Partition Size，會依照指定的分割大小建
立新的分割區。剩餘的邏輯磁碟機大小容量移動至上一個分割區。然後可以透過擴展磁
碟機來利用剩餘容量 ( 如第 163 頁 「擴充邏輯磁碟機或邏輯磁碟區的容量」所示 )。在
建立分割區後，就不能再編輯磁碟機容量。

11. 從 Channel 和 SCSI ID 清單方塊中，選擇要將新邏輯磁碟機對應到其上的主機通道和
SCSI ID。

注意–如果這時還不想對應這個邏輯磁碟機，請從 Channel 清單方塊選擇 Do Not Map。

注意 – 在 Sun StorEdge 3310 SCSI Array 上， 多可以建立 8 個邏輯磁碟機，每個邏輯
磁碟機 多可有 32 個分割區。 多可以分配 128 個 LUN。一個邏輯磁碟區 多可以劃
分為 32 個分割區。在 Sun StorEdge 3510 FC Array 上， 多可以建立 8 個邏輯磁碟
機，每個邏輯磁碟機 多可有 128 個分割區。 多可以分配 1024 個 LUN ( 分配給每個
主機 ID 的 LUN 大數目為 32 個 )。一個邏輯磁碟區 多可以劃分為 128 個分割區。

12. 這個步驟要看您接下來想要做什麼：

■ 如果要建立另一個邏輯磁碟機，請按一下 New LD 並且重複步驟 1 至 11。 

■ 如果要將這個邏輯磁碟機新增到邏輯磁碟區，請按一下 Add to LV，並請參閱第 80
頁 「建立和分割邏輯磁碟區」。

■ 如果要分割這個邏輯磁碟機，請執行下列步驟：在這個範例中，建立和分割了一個小
邏輯磁碟機。 

13. 如果要建立小邏輯磁碟機，請在 Max Drive Size 欄位中鍵入 2000。 

注意 – 邏輯磁碟機的總容量會顯示為 4000 MB，而不是 6000 MB，因為這是 RAID 5 等
級，您會損失相當於一個磁碟機的容量 (2000 MB) 供同位檢查使用。
第 7 章 完全配置 77



14. 如果要建立分割區，請在 Part Size 欄位中鍵入 1000，然後按一下 Add Partition。

注意 – 如果您打算將邏輯磁碟機新增到邏輯磁碟區，請不要分割它。分割邏輯磁碟機之
後，就不能將其新增到邏輯磁碟區。

若要建立同樣大小的多個分割區，想建立多少個分割區就按多少次 Add Partition。您也
可以在 Part Size 欄位中鍵入分割區的大小，並且以您要建立的分割區數目來乘 (*) 它，
例如 100*128。任何剩餘的 MB 都會加到 後一個分割區。

新增分割區時，Available Size (MB) 中顯示的剩餘容量會依原來容量減去分割區大小的
容量。

如下列範例中所示，在原來的 4000 MB 中，有 1000 MB 分配給 Partition 0。剩下的
3000 MB 則自動被移到 Partition 1。剩餘的可用容量會顯示在 Available Size (MB) 欄
位中
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15. ( 僅適用於 Solaris 作業環境 )。如果要自動標示新的邏輯磁碟機好讓作業環境使用磁碟
機，請按一下 Write a new label to the new LD。

16. 按一下 Commit 結束邏輯磁碟機配置，或者按一下 New LD 配置另一個邏輯磁碟機。 

按下 New LD 時，將會顯示任何尚未使用的可用磁碟。

完成這個陣列的邏輯磁碟機配置後，請按一下 Commit， 然後再按一下 OK。會顯示已
完成的配置。 

注意 – 按一下 OK 後就不能變更邏輯磁碟機的配置。 

注意 – 在初始化過程中，LD/LV 的大小會顯示為 0 MB。
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▼ 建立和分割邏輯磁碟區 
邏輯磁碟區是由兩個以上邏輯磁碟機組成， 多可以分成 32 個適用於 SCSI 的分割區，
和 128 個適用於光纖通道的分割區。操作期間，主機將未分割的邏輯磁碟區或邏輯磁碟
區的分割區視為單一實體磁碟機。 

1. 請依照第 74 頁「使用 New Configuration 建立和分割邏輯磁碟機」中步驟 1 至 11 的
說明建立邏輯磁碟機。

注意 – 不要分割您要新增到邏輯磁碟區的邏輯磁碟機。已經分割的邏輯磁碟機不能新增
到邏輯磁碟區。

2. 在按下 Commit 將邏輯磁碟機新增到邏輯磁碟區之前，請先按 Add to LV。

邏輯磁碟機就會新增到 LV Definition 方塊。邏輯磁碟區的總容量會顯示在 Available
Size (MB) 欄位中。 

注意 –因為這個邏輯磁碟區還沒有分割，所以 Part Size (MB) 與  Available Size (MB) 兩
者容量是一樣的。一個單一的邏輯磁碟區會被視為一個單一分割區。
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3. 如果要建立另一個邏輯磁碟機用來新增到邏輯磁碟區，請按一下 New LD。

4. 按一下 Add to LV 即可建立邏輯磁碟機並將它新增到邏輯磁碟區。

針對您要新增到邏輯磁碟區的每一個邏輯磁碟機重複這個步驟。

5. 如果要建立分割區，請在 Part Size 欄位中鍵入分割區的大小，然後按一下 Add Partition。

若要建立同樣大小的多個分割區，想建立多少個分割區就按多少次 Add Partition。您也
可以在 Part Size 欄位中鍵入分割區的大小，並且以您要建立的分割區數目來乘 (*) 它，
例如 100*128。

新增分割區時，Available Size (MB) 中顯示的剩餘容量會依原來容量減去分割區大小的
容量。

當邏輯磁碟機新增到
邏輯磁碟區的時候，它們
會顯示在 LV Definition
方塊中

Available Size – 顯示
所有磁碟的總容量，
也就是邏輯磁碟機
的總容量
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6. 完成新增邏輯磁碟機到邏輯磁碟區之後，如果要建立另一個邏輯磁碟區或個別的邏輯磁
碟機，請按一下 Commit LV。

完成建立邏輯磁碟區之後，如果不想建立個別的邏輯磁碟機，請按一下 Commit。

注意 – 如果您完成建立邏輯磁碟區之後想要結束 New Configuration 視窗，但是不小
心按了 Commit LV ( 而不是 Commit)，那麼您必須建立另一個邏輯磁碟機；否則，
就必須按一下 Cancel 並且再次配置邏輯磁碟區。

如果要在現有配置中新增或刪除邏輯磁碟區，或者分割邏輯磁碟區，請參閱第 151 頁
「更新配置」。

▼ 清除配置

在配置過程中如果對 New Configuration 視窗中的配置不滿意，您隨時可以清除它。

1. 按一下 Clear 從顯示內容中刪除所有實體和邏輯磁碟機。 

2. 按一下 New LD 定義新的邏輯磁碟機，或按一下 Commit。

3. 在按一下 Commit 時，將顯示警告提示，可以按一下 OK。 

Sun StorEdge Configuration Service 在所選擇的陣列控制器上初始化整個配置。

注意 – 在邏輯磁碟機完成初始過程後，將自動對應主機 LUN。

▼ 登出配置等級

完成配置活動時，應重新登入程式的監視等級。 

1. 選擇 File → Logout。

2. 選擇 Logout to monitoring mode，然後按一下 OK。
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主機 LUN 分配
為了讓伺服器能識別邏輯磁碟機或邏輯磁碟區，必須先將它對應到某個主機通道或 ID。
當邏輯磁碟機或邏輯磁碟區對應到主機通道或 ID 之後，它就會成為一個 LUN。下一節
是說明如何將邏輯磁碟機或邏輯磁碟區對應到主機通道，以及如何將其移除。

注意 – 當邏輯磁碟機或邏輯磁碟區剛建立好的時候，除非已經選擇了 Do Not Map，否
則在邏輯磁碟機或邏輯磁碟區完成初始化過程之後，LUN 就會自動對應。

注意 – 在 Sun StorEdge 3310 SCSI 陣列上， 多可以建立 8 個邏輯磁碟機，每個邏輯磁
碟機 多可有 32 個分割區。 多可以分配 128 個 LUN。一個邏輯磁碟區 多可以劃分
為 32 個分割區。在 Sun StorEdge 3510 FC Array 上， 多可以建立 8 個邏輯磁碟機，
每個邏輯磁碟機 多可有 128 個分割區。 多可以分配 1024 個 LUN ( 分配給每個主機
ID 的 LUN 大數目為 32 個 )。一個邏輯磁碟區 多可以劃分為 128 個分割區。

▼ 新增 ( 對應 ) 主機 LUN
1. 選取 Configuration → Custom Configure。

2. 從 Custom Configuration Options 功能表，選擇 Change Host LUN Assignments。 

會顯示 Change Host LUN Assignments 視窗。
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3. 使用 Select Host Channel and SCSI ID 清單方塊，選擇要為其分配 LUN 的通道和
ID。

所有可用的 LUN 都會顯示在 Partitions 之下。順便一提，Used LUNs 會顯示某個指定
之通道的 LUN 清單，而 Partition Assignment 則會顯示通道、ID 和已經分配給分割區
的 LUN 的清單。 

注意 – 新增或建立邏輯磁碟機或邏輯磁碟區之後，它會被分配為主要或次要 ( 控制器分
配 )。然後邏輯磁碟機或邏輯磁碟區將會初始化並且對應到主要或次要通道 ID。如果您
取消對應邏輯磁碟機或邏輯磁碟區，然後將它重新對應到另一個有不同控制器分配的主
機通道 ID，就必須重新設定控制器。如果您取消對應邏輯磁碟機或邏輯磁碟區，然後將
它重新對應到另一個有相同控制器分配的主機通道 ID，就不需要重新設定控制器。如果
邏輯磁碟機或邏輯磁碟區擁有仍然對應的其他分割區，則已經取消對應的分割區只能對
應到相同控制器分配的主機通道 ID。

4. 從 LD/LV 欄位選擇需要的分割區，然後按一下 Assign Host LUN 接受變更。 

如果要對應多個分割區 ( 多 32 個 )，請選擇第一個分割區，捲動到 後一個分割區，
按住 Shift 鍵並同時按一下滑鼠，選取中間的所有項目。然後按一下 Assign Host LUN。

因此，Delete Host LUN 就變成啟用狀態。
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5. 完成時，按一下 OK 以儲存變更並返回主功能表。

注意 – 對應主機通道時如果發生顯示錯誤消息的事件，應重複步驟 1 到 5。

▼ 刪除 ( 取消對應 ) 主機 LUN
1. 在 Change Host LUN Assignments 視窗顯示時，從 Host LUN Assignments 欄位選

擇要刪除的 LUN。

2. 按一下 Delete Host LUN。

3. 完成時，按一下 OK 以儲存變更並返回主功能表。

配置檔案
在軟碟或陣列之外的外部裝置上，保存目前配置的備份副本。即使配置資訊儲存在陣列
控制器或連接到它們的實體磁碟機上，仍可能發生火災或水災等情況，造成控制器和磁
碟機的損壞。配置的備份副本用於將配置恢復到新控制器，而不必完全重新配置儲存陣
列。 

無論何時發生下列情況，應隨時將陣列控制器配置儲存到檔案：

■ 安裝新的儲存系統機箱，或更改現有機箱中控制器的 SCSI ID

■ 更換陣列控制器

■ 重新配置或將邏輯磁碟機加入陣列控制器

■ 從故障磁碟機將資料重建到備用磁碟機
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▼ 將配置儲存到備份檔案

1. 選擇含有要儲存其配置的控制器。

2. 選取 Configuration → Custom Configure。

會顯示 Save Configuration 視窗。

3. 如有必要，請瀏覽您要儲存檔案的磁碟機和檔案夾。 

將檔案儲存在軟碟片或陣列以外的磁碟機。

4. 指定配置檔案名稱，然後按一下 Save。

會顯示 Save Configuration 視窗。

5. 鍵入要儲存配置的說明。

6. 按一下 OK。 

控制器配置資訊儲存在 .cfg 檔案。
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載入配置

如果磁碟機或控制器損壞並且需要更換，請參閱第 143 頁「恢復邏輯磁碟機配置」，其
中說明了如何載入配置檔，以及如何恢復邏輯磁碟機配置。
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第  章8

LUN 篩檢 ( 僅適用光纖通道 ) 

本章說明如何建立適用於 Sun StorEdge 3510 光纖通道陣列的 LUN 篩檢程式，以維護
共用通用儲存裝置的大型光纖通道網路。本章涵蓋下列主題：

■ 第 89 章 「概述」
■ 第 91 章 「分配 LUN 篩檢程式」

■ 第 91 章 「存取 LUN Filter View」
■ 第 92 章 「以手動方式新增 HBA 裝置」
■ 第 94 章 「移除標準主機對應」
■ 第 95 章 「將邏輯磁碟機對應到主機」
■ 第 98 章 「刪除 LUN 篩檢程式」

概述
資料是否隨時隨地能夠存取和是否安全，是有效維護儲存基礎架構很重要的一部分。Sun
StorEdge Configuration Service 運用 LUN 篩檢支援，提供了一種保護集中式儲存裝置
存取管理的公用程式。 

對於連接到同一個陣列的多部伺服器，LUN 篩檢可提供從伺服器到邏輯磁碟機的獨有路
徑，而且會實質上隱藏或排除其他連接的伺服器，不讓它們看到或存取同一個邏輯磁碟
機。換言之，LUN 篩檢程式會組織從主機裝置存取和檢視陣列裝置的方式，而且通常只
讓一項陣列裝置對應到一部主機，讓其他的主機無法存取和使用同一項陣列裝置。必要
時，LUN 篩檢也可以讓多項邏輯磁碟機或分割區對應到同一個 LUN 號碼，讓不同的伺
服器有自己的 LUN 0 可以用來啟動。透過集線器檢視時，每個 HBA 通常會看見邏輯磁
碟機數目的兩倍，在這種情況下 LUN 篩檢對於澄清對應就非常重要了。
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每一項光纖通道裝置都會分配到一個唯一的識別碼，稱為世界通用名稱 (World Wide
Name，WWN)。WWN 是由 IEEE 分配的，很類似 IP 中的 MAC 位址或網際網路上的
URL。這些 WWN 會在裝置的整個生命週期中都跟隨著它。LUN 篩檢就是利用這個
WWN 來指定哪個伺服器對於特定的邏輯磁碟機擁有獨佔的使用權。通常會使用一種簡
便的拖放方式，將每個邏輯磁碟機對應到某個主機的光纖通道 HBA 卡 (以 WWN 識別)。 

如下列範例中所示，如果將 LUN 01 對應到主機通道 0 並且選擇 WWN1，伺服器 A 會
擁有該邏輯磁碟機的專屬路徑。所有伺服器仍然可以看見到和存取 LUN 02 和 LUN 03，
除非在它們上面另外建立了篩檢程式。

圖 8-1 LUN 篩檢範例

LUN 篩檢的優點是它可以讓更多主機 ( 例如 Windows NT) 透過共同的光纖通道連接埠
連接到陣列，而且仍然能夠維護 LUN 的安全。

02 03

WWN
(1) 210000E08B021D15

(2) 210000E08B02DE2F

(3) 210000E08B22DE2F

LUN ID LUN ID LUN ID
01 XX XX

XX 02 XX

XX XX 03

WWN1 WWN2 WWN3

A B C

01
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分配 LUN 篩檢程式
分配 LUN 篩檢程式涉及下列步驟：

■ 存取 LUN Filter 視窗

■ 以手動方式新增 HBA 裝置 ( 如果看不到想要的 HBA)

■ 移除標準對應

■ 將邏輯磁碟機對應到主機

▼ 存取 LUN Filter View
1. 按一下 Filter View 標籤存取 LUN Filter View。 

2. 按一下容器符號 展開裝置樹狀圖，檢視左邊的伺服器詳細資訊，和右邊的陣列裝置
詳細資訊。 
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▼ 以手動方式新增 HBA 裝置

如果在顯示的 Hosts 之下看不到想要的 HBA，請透過 Configure Host/WWN 視窗以
手動方式進行新增。

1. 選擇 Configuration → Configure Host/WWN。

2. 在 Available Hosts 清單中，選擇擁有要新增之 HBA 裝置的主機，然後按一下 Edit。

如果這個主機是在 Connected Hosts 清單之下，請選擇這個主機並且按一下 Remove，
將這個主機置於 Available Hosts 清單之下。

3. 在 Add/Edit Host 方塊中，按一下 Add。
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4. 在下一個 Add/Edit HBA 方塊中，鍵入新的 Adapter Name 和適當的 WWN，然後按
一下 OK。

如果需要有關判斷 WWN 的詳細資訊，請參閱第 225 章 「判斷主機世界通用名稱 ( 僅
適用光纖通道 )」。

5. 在 Configure Host/WWN 視窗中，選擇剛才編輯的主機，然後按一下 Add 將這個編輯
過的主機移到 Connected Hosts 清單，然後再按一下 OK。 

當您返回 LUN Filter View 時，這個新的 HBA 裝置會呈現灰色，可以供 LUN 篩檢使用。 
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▼ 移除標準主機對應

標準對應可以讓所有主機看見所有以標準對應的邏輯磁碟機。LUN 篩檢則會將對應限制
為特定的主機。分配 LUN 篩檢之前，您必須先從陣列移除標準主機對應 ( 以 M 標籤

表示 )。 

1. 按一下每一個 All Hosts 項目，然後拖放到 Storage Pools 中。

2. 對下面的訊息按一下 OK： 

會顯示確認已成功刪除標準主機 LUN 對應的訊息。

3. 如果這個主機不是陣列的主代理程式，而且您希望讓裝置對應到這個主機，請選擇
Configuration → Configure Host/WWN。

4. 從 Available Hosts 清單選擇想要的主機，然後按一下 Add 將這個主機新增到 Connected
Hosts 清單。 

會顯示確認新增主機伺服器的訊息。 

5. 按一下 Close 儲存配置資訊並且結束視窗。

6. 如果您要對應多部主機到某個陣列，請選擇 Configuration → LUN Filter Properties，
然後從下拉式功能表選取陣列。 

7. 選擇 Hardware Filter 和 Map to Multiple Hosts 核取方塊，然後按一下 OK。 

注意 – 如果取消選取 Hardware Filter 核取方塊，就不能建立篩檢程式對應；只能建立標
準對應。

會刪除所有邏輯磁碟機 X 分割區 X 的標準對應。是否要繼續？
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▼ 將邏輯磁碟機對應到主機

1. 確認您仍然在 LUN Filter View 中；如果不是，請按一下 Filter View 標籤。

2. 從 Storage Pools 中選擇邏輯磁碟機，並且拖放到 Hosts 下的適當 HBA 卡。 

如果不清楚連接到陣列的 HBA 卡，請將邏輯磁碟機拖放到該主機。 

程式會提示您對主機中的每一張 HBA 卡篩檢這個陣列 (這表示與其連接的 HBA 卡可以
看到它，而對其他 HBA 卡則不會顯示 )。

3. 看到確認對應的提示後，請按一下 OK。
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會顯示 Specify Map Information 視窗。請注意，如果 HBA 卡不止一張，程式會自動
將邏輯磁碟機對應到主機中所列的第一張 HBA 卡。

4. 將邏輯磁碟機 ( 以及想要的通道和 LUN ID 號碼 ) 分配給主控制器或次控制器，然後按
一下 OK。 

將主控制器或次控制器分配給 HBA 卡是對初始 LUN 篩檢程式分配選擇的，除非刪除
LUN 篩檢程式分配並且重來一次，否則無法變更。 
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如果要將 LUN 篩檢程式套用到一個陣列的第二部主機，重複第 92 章 「以手動方式新
增 HBA 裝置」下的步驟 6 一直到第 95 章 「將邏輯磁碟機對應到主機」下的步驟 3。 

這時會顯示一項警告提示，告訴您兩位使用者在同一時間存取同一個邏輯磁碟機將會造
成資料損毀；按一下 OK 即可加入這個額外的主機。 

在下面的範例中，Sun StorEdge 3510 光纖通道裝置擁有兩部個別主機的 LUN 篩檢程式
( 請留意代表篩檢程式的字母 F)。
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▼ 刪除 LUN 篩檢程式

1. 選擇相關的 WWN。

2. 將它拖放到 Storage Pools。 

3. 當顯示確認刪除對應的提示時，請按一下 OK。 

4. 看到第二次確認時，再按一下 OK。 
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第  章9

監視陣列 

本章說明如何使用 Sun StorEdge Configuration Service 來監視陣列。其中說明在主視
窗中按兩下圖示時，出現的主視窗和元件視圖視窗。也說明了 Event Log  的運作方式以
及如何使用報告功能。本章組織成下列各節：

■ 第 99 頁 「主視窗」
■ 第 106 頁 「檢視詳細裝置資訊」
■ 第 120 頁 「事件日誌」
■ 第 124 頁 「Save Report」
■ 第 127 頁 「View Report」
■ 第 127 頁 「頻外儲存管理」
■ 第 132 頁 「透過網路管理儲存設備」

主視窗
主視窗會提供所有陣列裝置的狀態瀏覽。這個視窗會指出連接到受主控台監視之伺服器
的裝置和邏輯磁碟機的狀態。裝置包括陣列控制器、磁片儲存機箱、實體磁碟機和其他
SCSI 裝置。

這個視窗的樹狀結構針對連接到每台伺服器的所有裝置提供詳細資訊。樹狀圖左側的
 或  容器符號代表裝置的顯示是展開還是折疊。  容器符號表示按一下可以顯示

更多裝置。  容器符號表示已經顯示該等級和該等級以下的所有裝置。
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下圖顯示主視窗的擴展視圖範例。 

 

注意 –SN# 代表陣列的唯一 ID。

下圖顯示折疊視圖的範例。
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如果需要詳細資訊，可以按兩下圖示開啟元件視圖視窗。將在本章的後續各節中說明元
件視圖。

主視窗的另一個特點是裝置狀況以顏色和符號編碼的，所以能夠輕易地識別出處於需要
注意狀態的裝置。該狀態透過裝置樹狀圖傳送，允許您跟蹤故障到裝置等級。請參閱
表 9-1 中有關裝置狀態的詳細資訊。

線上說明

如果要使用線上說明，請選擇 Help → Contents。線上說明為 HTML 格式，可以透過
Internet Explorer 或 Netscape 執行。其中包括有關程式主要功能的資訊。

產品配置的樹狀檢視圖

對於每個伺服器 ( 或伺服器群組 )，樹狀檢視圖中的裝置是按照層級結構的順序排列，伺
服器 ( 或群組 ) 位於頂端，然後是陣列控制器。其餘裝置 ( 邏輯磁碟機、實體磁碟機和
機箱 ) 的顯示方式，會依據顯示的陣列和控制器的不同而略有差別。本節提供可以在樹
狀檢視圖中描述的視窗檢視圖。

表 9-1 裝置狀態狀況

顏色 符號 狀態

紫色 無 群組、伺服器或裝置連線。 

白色 無 使用者還沒有登入這個伺服器。

黃色 這個群組或伺服器中的一個或多個元件工作不正常，但是
陣列仍然可以運作。例如，其中一個實體磁碟機發生故障
的邏輯磁碟機在降低效能狀況下執行。

紅色 這個群組或伺服器的一個或多個元件沒有運作。擁有兩個
故障磁碟機的邏輯磁碟機，或一個含有三個故障風扇的機
箱會處於危急狀況。

灰色 群組、伺服器或裝置沒有回應。

?
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群組

群組是裝置樹狀結構中的伺服器邏輯集合。這個新的資料物件允許多個伺服器包含在單
一類別下。 

群組物件的外觀 和行為與所有樹狀結構物件相似。它擁有一個圖示化表示，用來代
表伺服器的狀態。下表顯示擴充為顯示從屬或基礎伺服器物件的群組圖示。

群組是一個新資料物件，它允許多個伺服器包含在單一類別下。群組的概念類似網域。
讓您可以組織伺服器。取代所有被管理伺服器的線性樹狀結構的是，您可以將伺服器組
織成相似的集或群組。

群組的顏色和符號編碼與伺服器相似。關於該方案，帶有對應顏色的狀態擁有如下的優
先順序： 

■ 緊急 – 紅色 ( 高 )
■ 無回應 – 灰色
■ 低效能 – 黃色
■ 良好 – 紫色
■ 未登入 – 白色

伺服器圖示擁有任何儲存系統的 高狀態的顏色。同樣的，除了下列包括不回應或未登
入伺服器的例外情況，群組圖示擁有其任何伺服器的 高狀態。
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停用群組圖示 ( 非活動 ) 時，表示所有連接到該組的伺服器都不回應，如果不是組中所
有的伺服器都不回應，則群組圖示顯示為紅色，這表示緊急狀況。例如，如果組中有四
台伺服器，三台或少於三台伺服器不回應，則群組圖示為紅色顏色編碼。

群組圖示的顏色編碼為白色時 ( 未登入 )，表示群組中的一台或多台伺服器未完全配置，
或者表示處於狀態變化過程中。表 9-2 提供了一個雙伺服器群組的不同顏色編碼範例。 

群組不是必須的。例如，可以設定程式為沒有群組但有十五台伺服器，或者一個群組下
有十台伺服器而 上層另有五台伺服器。程式允許任何的組合。

許可的群組數和群組內伺服器的數量僅受到可用系統記憶體的限制。如果伺服器是群組
的成員，而使用者從群組清單方塊中刪除了該群組，會將群組內的伺服器重新分配給無
群組類別。在主視窗中重新對應樹狀結構。

表 9-2 雙伺服器群組顏色

伺服器 1
圖示顏色

伺服器 2
圖示顏色 群組圖示顏色

灰色
灰色

灰色
黃色、紅色、紫色或白色

灰色 ( 無回應 )
紅色 ( 緊急 )

白色 白色 白色 ( 未登入 )

白色 黃色 黃色 ( 低效能 )

白色 紅色 紅色 ( 緊急 )

白色
紅色

紫色
任何顏色

紫色 ( 佳狀態 )
紅色 ( 緊急 )

黃色
紫色

黃色或紫色
紫色

黃色 ( 低效能 )
紫色 ( 良好 )
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監視過程 
主控台監視器和伺服器上的代理程式通訊來儲存網路上的裝置。

程式啟動時，如果在配置伺服器時指定了 Auto Discovery，則主控台軟體一開始就會與
每台管理伺服器上的代理程式建立通訊。如果沒有指定 Auto Discovery，您必須在每台
伺服器按兩下並且提供密碼，才能啟動該伺服器的發現程序。

根據網路複雜程度的不同，在主控台與每台伺服器上的代理程式之間建立 TCP/IP 連線
並接收庫存資訊可能要花幾分鐘的時間。發生這種情況時，主視窗中的伺服器圖示在其
右側顯示一個碟形衛星天線圖示。更新庫存後，碟形衛星天線符號將被啟用中的伺服器
標誌取代。

每台伺服器上的代理程式都會定期掃描其庫存，檢查是否發生變化。如果發生變化，代
理程式會傳送事件到主控台。根據事件的不同，主控台可能會從該伺服器的上次掃描請
求庫存，用來更新主視窗中顯示的伺服器。在這個過程中，碟形衛星天線圖示附加到伺
服器圖示上，只有在更新程序完成並且主控台主視窗更新後，才能進行配置並執行陣列
活動指令。

如果程式正在執行，而且伺服器代理程式和主控台已經連線，則代理程式會定期發送
Ping 測試信號到主控台以驗證伺服器的狀態。如果主控台沒有從代理程式接收到特定數
量的連續回應 ( 握手 )，則主控台將伺服器標示為離線並從伺服器中斷連線。伺服器圖示
會變為非現用，並且旁邊出現一個問號。

如果非現用伺服器 初是透過 Auto Discovery 功能成為啟用狀態，則主控台會定期嘗
試重新建立伺服器的通訊。

您有時可能想在兩次定期狀態掃描之間執行庫存檢查。如果要這樣做，請按兩下伺服器
圖示顯示 Server View 視窗，然後按一下該視窗中的 Rescan。
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Auto Discovery 選項

如果選擇了 Auto Discovery 選項 ( 在將伺服器新增到 Managed Servers 清單的過程中
執行，請參閱第 45 頁「選擇或取消選擇伺服器的 Automatic Discovery：」 )，程式會
在這些伺服器上自動掃描並執行庫存檢查。不需要提供監視密碼就可以擷取程式提供的
資訊。根據網路的複雜程度和伺服器數目的不同，完成發現程序可能需要幾分鐘時間。

但是，如果選擇啟動時不使用 Auto Discovery 選項，則伺服器的圖示為白色，表示目
前沒有用於這些伺服器的資訊。這種情況需要按兩下每個伺服器圖示，並指定適當的監
視密碼。 

您也可以選擇 File → Login。只要為伺服器指定密碼，發現程序會開始執行對所選擇伺
服器的庫存檢查。 

注意 – 如果需要一個即使對伺服器庫存資料進行存取都要受到限制的非常安全環境，則
應為 Auto Discovery 選擇 No ( 請參閱第 45 頁「選擇或取消選擇伺服器的 Automatic
Discovery：」 )。
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檢視詳細裝置資訊 
Sun StorEdge Configuration Service 會提供有關每個代理程式或伺服器以及與其連接
之陣列裝置的詳細資訊。根據磁片控制器功能的不同，每個視圖上的欄位有所不同。

除了 Save Report 和 View Report ( 位於 File 功能表下 ) 以外，本節說明的各種指令和
視窗都視是透過 View 功能表存取。

■ View Group
■ View Server
■ View Controller Configuration
■ 檢視 邏輯 磁碟機 
■ 檢視實體磁碟機 
■ View Enclosure
■ View FRU
■ Array Administration Progress
■ Agent Options Management
■ Save Report
■ View Report
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View Group 
View Group 會顯示在主視窗中選擇以組成群組的伺服器。

如果要存取 View Group，請按兩下主視窗中的群組圖示 ，或選擇群組圖示並選擇
View → View Group。

Server List 會顯示連接到指定之群組的所有伺服器。 

 

如果要檢視有關列出伺服器的詳細資訊，可以在清單中選擇適當的狀態記錄並按一下
View，或按兩下狀態記錄。顯示說明對應伺服器的視窗。
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View Server 
View Server 會顯示主視窗中所選擇之伺服器的特性。

如果要存取 View Server，請按兩下主視窗中的伺服器圖示 ，或選擇伺服器圖示並選
擇 View → View Server。

 

注意 – 將雙埠 HBA 顯示為獨立項目，因為它們擁有供裝置連接的單獨通道。
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作為 TCP/IP 網路的一部分，插座連接埠在伺服器和用戶端之間建立連線。

■ Rescan – 將指令傳送到所選擇的伺服器，以重新掃描現有的庫存並更新主控台。通常
每個管理伺服器對其庫存執行定期掃描，如果發生變化則更新主控台。如果想要對所
有分配的裝置執行診斷，按一下 Rescan；選擇這個按鈕將完全阻止狀態的定期和自
動更新。

■ Probe – 將指令傳送到所選擇的伺服器，以探測新的庫存 ( 例如，RAID 控制器、JBOD
和擴充單元 )。每當加入了新裝置或變更了裝置名稱，而且想要讓它立即顯示在主視
窗樹狀檢視圖中，請按一下 Probe。

■ Card List – 顯示安裝在或連接到指定之伺服器的主機介面卡和陣列控制器。如果要檢
視有關任何主機介面卡和列出陣列控制器的詳細資訊，可以在清單中選擇適當的記錄
並按一下 View，或按兩下所選擇的狀態記錄。顯示說明對應主機介面卡或陣列控制
器的視窗。

View Controller Configuration
View Controller Configuration 會顯示組成陣列的元件。 

如果要存取 View Controller Configuration，請按兩下主視窗中的陣列圖示 ，或選
擇它並且選擇 View → View Controller。
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如果電池故障，陣列會在主視窗中顯示黃色的 ( 低效能 ) 裝置狀態符號，而在 Battery 欄
位則會指出 Bad。 

視窗底部的標籤提供關於 RAID 控制器的 LUN、與它連接的實體磁碟機、控制器所在
的機箱、以及週邊設備配置的詳細資訊。如果要獲得有關視圖內其他標籤的資訊，可按
一下標籤。

Controllers 標籤

如果要存取這個視窗，請按兩下主視窗中的陣列圖示 ，或選擇它並選擇 
View → View Controller。然後按一下 Controller 標籤。 

Controller 標籤列出了兩個控制器。如果要檢視其中一個控制器的詳細資訊，請按兩下
該控制器，或者選擇該控制器然後按一下 View。View Primary 或 View Secondary
Controller Configuration 視窗的顯示取決於控制器是主控制器還是次控制器。請參閱
第 113 頁 「View Primary/Secondary Controller Configuration」。
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Physical Drives 標籤

如果要存取這個視窗，請按兩下主視窗中的陣列圖示 ，或選擇它並選擇 
View → View Controller。然後按一下 Physical Drives 標籤。 

下圖所示為顯示 Physical Drives 標籤的 View Controller Configuration。

Physical Drives 標籤會列出與陣列相關的實體磁碟機。如果要檢視關於任何所列出實體
磁碟機的詳細資訊，請按兩下該磁碟機或選擇磁碟機，再按一下 View。會顯示 View
Physical Drive 視窗。

如果需要 View Physical Drive 的詳細資訊，請參閱第 116 頁 「檢視實體磁碟機」。
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Enclosure Info 標籤

如果要存取這個視窗，請按兩下主視窗中的 Enclosure 圖示 ，或選擇陣列圖示 
並選擇 View → View Controller.。選擇 Enclosure Info 標籤。選擇機箱並按一下 View。

Enclosure Info 標籤中含有電源狀態、風扇和機箱溫度的資訊。如果需要 View Enclosure
的詳細資訊，請參閱第 117 頁 「View Enclosure」。

View FRU

僅限於 Sun StorEdge 3310 SCSI Array，若要顯示陣列的現場更換零件 (FRU) 識別資
訊，請按一下 View FRU。如果需要範例 FRU ID 資訊，請參閱第 119 頁「View FRU」。

View Controller 參數

按一下 View Controller Parameters 以檢視關於 Channels、RS 232、Cache、Disk Array,
Drive I/F、Host I/F 和 Redundancy 的詳細資訊。如果要檢視資訊，請按一下對應到
所要檢視項目的標籤。如果要變更控制器參數，請參閱第 175 頁 「變更控制器參數」。
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View Primary/Secondary Controller Configuration

View Primary 和 View Secondary Controller Configuration 視窗顯示在主視窗中選擇
的 RAID 控制器屬性。如果要顯示主控制器特性，請從主視窗選擇主控制器，並選擇
View → View Controller，或按兩下主控制器。

以下兩個範例顯示主控制器。

View FRU 沒有為
Sun StorEdge 3510
Fibre Channel Array
顯示出來。
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以下兩個範例顯示次控制器。

View FRU 沒有為
Sun StorEdge 3510
Fibre Channel Array
顯示出來。
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Logical Drives 標籤

如果要存取這個檢視視窗，請按兩下主視窗中的主要或次要 RAID 控制器圖示 ，或
選擇控制器圖示並選擇 View → Controller。

按一下 View Controller Params 可以在 RAID Controller Parameters 視窗中取得可編
輯元件參數。

如果要檢視邏輯磁碟機，選擇並從 Logical Drives 標籤按兩下磁碟機，或選擇磁碟機並
按一下 View。

檢視 邏輯 磁碟機

View Logical Drive 會顯示主視窗中所選擇的邏輯磁碟機特性。 

如果要存取該檢視視窗，可以使用下列其中一個方法。 

■ 按兩下主視窗中的邏輯磁碟機圖示 。 

■ 選擇邏輯磁碟機圖示並選擇 View → View Logical Drive。 

■ 按兩下 RAID 控制器圖示 ，選擇清單方塊中的邏輯磁碟機，然後按一下 View。 

如果需要有關所列出磁碟機的詳細資訊，請按兩下磁碟機狀態記錄，或選擇磁碟機並按
一下 View。會顯示 View Physical Drive 視窗。 
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檢視實體磁碟機 
View → View Physical Drive 會顯示所選取實體裝置的各項特性。根據所選擇裝置的不
同，顯示的檢視視窗標題也會不同。

■ 對於磁碟機 ，則稱為 View Physical Drive 視窗。
■ 對於磁帶機 ，則稱為 View Tape 視窗。
■ 對於 CD-ROM ，則稱為 View CD-ROM 視窗。 

如果要存取其中一個視窗，請按兩下主視窗中的實體裝置，或選擇該裝置並選擇 
View → View Physical Drive。
116 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



■ Associated Partitions – 在選擇的裝置與一個或多個邏輯磁碟機分割區相關時才會顯
示。

■ View – 當有相關邏輯磁碟機時才會啟用。

上圖顯示 View Physical Drive 視窗的範例，在該視窗中選擇的實體磁碟機與單一分
割區相關。 

■ Remaining Size – 表示在磁碟機的部分容量已經用於一個或多個邏輯磁碟機時的剩餘
未用容量。

■ RPM – 實體磁碟機的每分鐘轉速。

■ SMART Drive – 表示磁碟機是否有故障預測能力。

您也可以選擇實體磁碟機，然後選擇 View。View Logical Drive 視窗會以無表格方式顯
示。

View Tape 和 View CD-ROM 視窗很類似上圖中顯示的視窗，但是類別稍有不同。 

View Enclosure
View Enclosure 會顯示主視窗中所選擇之陣列機箱的元件和警報特性 ( 對於 SCSI，
EMU 用名稱 Sun StorEdge 3310 A 識別；Id 一定是 14 或 15。對於 Fibre Channel，
SES 用名稱 Sun StorEdge 3510 A 識別；Id 一定是包含 SES 機箱中的 Id)。

1. 選擇 EMU (SCSI) 或 SES ( 光纖通道 ) 圖示 。

2. 選擇 View → View Enclosure。

視窗上半部的兩個部分可識別機箱並提供相關資訊。請注意，如果擁有一個含多個機箱
的陣列，您可以使用 Enclosure Number 清單方塊 ( 位於視窗的右上角 ) 來反映連接到
同一個陣列控制器的另一個機箱。

如果要顯示 FRU ID 和陣列中所有 FRU 的資訊，請按一下 View FRU。
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如果您擁有配備 SCSI Accessed Fault-Tolerant Enclosure (SAF-TE) ( 用於 SCSI 陣列 )
或 SCSI Enclosure Services (SES) ( 用於光纖通道陣列 ) 卡的陣列，視窗的 Alarm State
部分才適用。

■ 如果 Alarm State 欄位顯示 Alarm! 並且 Reset 按鈕顯示為作用中，表示有磁碟機、
風扇、電源或電池故障、或機箱中的溫度異常造成的警報狀態。方塊中的警報聲響起。

■ 如果要使程式在警報條件啟動後繼續進行監視，必須按一下該視窗中的 Reset，或是
也可以按一下陣列機箱上的 Reset。 

■ 只有擁有配置安全性權限的使用者，才可以透過程式來 Reset ( 重設 ) 警報。更換故障
元件，或者在機箱內部溫度異常的情況下，對機箱進行檢查。

視窗的下半部分提供視窗中各個元件的狀態。插槽中有裝置時，它由一個帶有顏色的磁
碟機圖示和一個代表其裝置狀況的符號代表。
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View FRU
FRU 是現場更換零件。是一種用來組裝新系統或維修現場系統的組件。Sun FRU ID ( 現
場更換零件識別 ) 程式是 Sun 的解決方案，能夠擷取、傳送並分析特定 FRU 配置、診
斷及 FRU 上的故障資訊。 

選擇 View → View FRU 以顯示陣列中的 FRU ID 和所有 FRU 的資訊，包括 Serial
Number、Model、Description、Vendor ID、Time (FRU 的程式設計時間 ) 和 Location。

注意 – 您也可以按一下 View Controller Configuration 視窗、View Primary Controller
Configuration 視窗和 View Secondary Controller Configuration 視窗中的 View FRU
來檢視特定控制器的 FRU。
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Array Administration Progress
Array Admin Progress 會顯示新邏輯磁碟機的初始化進度。如果要存取這個命令，請選
擇 View → Array Admin Progress。

Agent Options Management
Agent Options 可以讓您自訂代理程式選項，包括輪詢時間、定期裝置發現時間和 SMART
監視。

如果要存取 Agent Options，請選擇 View → Agent Options Management。如果需要
更詳細的資訊，請參閱第 54 頁 「配置代理程式參數 ( 選擇性項目 )」。

事件日誌
主控台會接收、記錄並顯示由管理伺服器和主控台自身產生的事件。

大部分事件是由管理伺服器上的代理程式在發生下列情況時產生：

■ 因為裝置故障、功能異常或中斷連接，管理伺服器上的任何裝置狀態都在變化，其中
也包括伺服器自身的變化

■ 庫存變化 ( 裝置的增加或減少 )

■ 配置變化 ( 初始配置設定和後續配置更改 )

■ 伺服器上執行的陣列程序 ( 初始化、同位檢查、重建 )

雖然陣列程序是由主控台啟動的，但是操作通知事件是由伺服器代理程式在這些程序從
伺服器上啟動後產生的。

主控台產生的事件數目相對而言很少。例如，如果它沒有從管理伺服器接收到特定數目
的連續活動訊號，將會產生一個事件。

當主控台接收到任何事件時，會將事件記錄到事件日誌檔 (eventlog.txt)，並將其顯
示在 Event Log 視窗中。另外，如果事件發生在伺服器上，事件的通知會傳送到伺服器
的作業環境 / 系統事件日誌。在 NT 伺服器上，事件的通知會進入 NT 事件日誌中。另
外，如果事件發生在伺服器上並且伺服器設定為將陷阱發送到例如 HP OpenView 等
SNMP 企業管理主控台，則伺服器代理程式還將陷阱訊息發送到該電腦。
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根據接收事件的不同，主控台可能會啟動更新程序，從伺服器上次所進行的週期性掃描
請求庫存，使控制台能夠更新主視窗中的伺服器庫存。 

在這個重新整理過程中，碟形衛星天線圖示附加到伺服器圖示上，只有在完成更新程序
且更新主控台主視窗後，才能進行配置並執行陣列活動指令。

事件日誌檔

Event Log 視窗一次 多可以顯示 500 個事件。如果事件超過 500 項，則只有 新的 
500 項會顯示在 Event Log 視窗中，但是在記錄的事件超過 10,000 項之前，程式不會從
事件日誌檔 (eventlog.txt) 刪除任何事件。

■ 記錄 10,000 項事件後，程式會將事件日誌檔減少到 新的 500 項事件，然後開始累
積事件，直到再次超過 10,000 項的限制為止。

■ 事件記錄的每個欄位由分號分隔，因此可以很容易地匯入資料庫中。

■ eventlog.txt  位於主控台程式檔案的安裝目錄中。

注意 – 如果事件日誌看起來不包含受管理陣列的所有事件，關閉主控台後重新開啟。

即使主控台不在執行中，來自代理程式的事件仍會記錄到安裝代理程式的主機系統日
誌中。在 Solaris 作業環境中，事件會記錄到 /var/adm/messages 並在主控台上顯
示。在 Linux 作業環境中，事件會記錄到  /var/log/messages。在 Windows NT 和
2000 中，事件會記錄到系統的應用程式日誌中，可以使用事件檢視器加以檢視。您也可
以從檔案 /opt/SUNWsscs/sscsconsole/eventlog.txt 直接讀取事件日誌。
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Event Log 視窗

如果要存取事件日誌，請選擇 View → Event Log。按一下 Close 可以隱藏這個視窗，
並且可以在不遺失任何內容的情況下重新開啟 ( 從 View 功能表 )。

無論 Event Log 視窗是否開啟，主控台只要在執行時就會開始接收事件。

1. 如果要刪除日誌檔，請按一下 Delete Logfile。 

會顯示 Confirmation 視窗，提示您儲存日誌檔。

2. 選擇下列其中一個選項：

■ 在提示上選擇 yes，選擇檔案夾和檔案名稱，並且儲存日誌檔。 

■ 看到提示時選擇 no。

日誌檔的內容就會被刪除。
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注意 – 您也可以使用工具列上的 Save Event Log 和 Delete Event Log 圖示來儲存和刪
除 eventlog.txt 檔案的內容。

每個事件記錄都包含下表顯示的欄位。

嚴重等級
■ Critical ( 嚴重 )。需要網路管理員介入的訊息，例如裝置、電源或風扇發生故障。

■ Warning (警告 )。 警告訊息一般用來指示內部程式事件。但如果看到大量的此類訊息，
則可能表示伺服器或網路有故障。

■ Informational ( 資訊 )。 關於伺服器上裝置的訊息，不需要網路管理員進行介入。

接收為所選擇的等級和任何擁有其他更高嚴重等級轉發的警報。因此，如果選擇
Informational，將會收到所有警報情況的通知。但是，如果選擇 Critical，則只會收到
Critical 警報。

如果需要這些訊息的詳細資訊，請參閱第 243 頁 「疑難排解」。 

表 9-3 事件記錄欄位

Date 事件發生時伺服器的日期。

Time 事件發生時伺服器的時間。

Server 伺服器的 IP 位址和伺服器名稱。

Card 如果適用，則是事件的卡名。

Severity
三個嚴重等級之一：Critical ( 嚴重 )、Warning ( 警告 ) 或 Informational 
( 資訊 ) ( 在下面的子章節中說明這些狀況 )。

Error Code 由破折號分隔的基本錯誤代碼和擴展錯誤代碼。

Text Message 說明事件的文字訊息。
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Save Report 
Save Report 選項會建立文字檔案，包含所有程式可用、和特定陣列有關的資訊。

1. 選擇 File → Save Report。 

會顯示確認伺服器 ID 的 Report 對話方塊。Exportable to spreadsheets 選項讓您可以
用分割元儲存報告 ( 逗號、分號、Tab、冒號和直條 ) 來匯出到試算表。

2. 選擇 Save report。 

會顯示 Save Report File 視窗。
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3. 輸入識別檔案的檔名，然後按一下 Save。 

程式會寫入報告，其中包含所選擇的伺服器及其裝置的庫存和狀態。 

報告檔案的預設儲存位置在安裝目錄中，預設副檔名則是 .xml。 好建立一個儲存報
告的子目錄，因為這樣可以使安裝目錄避免出現混亂。

報告包含下列資訊：

■ 一般陣列詳細資料
■ 陣列名稱、狀態、製造商、型號
■ 韌體版本
■ 開機記錄版本
■ MAC、IP、網路遮罩和閘道位址
■ 控制器序號

■ 陣列配置的一般概述
■ 邏輯磁碟機、邏輯磁碟區和分割區的總數

■ 控制器參數
■ 主機和磁碟機通道設定及 ID

■ 每個邏輯磁碟機的詳細清單
■ RAID 等級
■ 邏輯磁碟機上實體磁碟機的數目和大小
■ 每個邏輯磁碟機和其對應的分割區數目及大小

■ SAF-TE/SES 資訊
■ FRU 清單
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■ 實體 ( 硬碟 ) 磁碟機的詳細資訊

下文摘錄自 Sun StorEdge 3510 Fibre Channel Array .xml 格式的範例報告，可用來當
作輸入到其他程式的內容。 .

程式碼範例 9-1 Sun StorEdge 3510 Fibre Channel Array 報告摘錄

<raidbaseview>
    <raidsystem>
        <name> SUN StorEdge 3510 A-A Array SN#000198 </name>
        <status>Good</status>
        <manufacturer>SUN</manufacturer>
        <model>StorEdge 3510</model>
        <firmware_version>3.27K</firmware_version>
        <bootrecord_version>1.31H</bootrecord_version>
        <mac_address>00:C0:FF:00:01:98</mac_address>
        <ip>206.235.238.198</ip>
        <netmask>255.255.255.0</netmask>
        <gateway>206.235.238.1</gateway>
        <primary_sn>3341275</primary_sn>
        <secondary_sn>3341258</secondary_sn>
        <controller_name>198</controller_name>
        <unique_id>198</unique_id>
        <id_of_nvram_defaults>327K 3510 v2.39</id_of_nvram_defaults>
        <total_logical_drives>8</total_logical_drives>
        <total_logical_volumes>0</total_logical_volumes>
        <total_partitions>278</total_partitions>
        <total_physical_drives>24</total_physical_drives>
        <total_safte_ses_devices>1</total_safte_ses_devices>
        <cache_size>1024MB ECC SDRAM</cache_size>
        <cpu>PPC750</cpu>
        <battery>Good</battery>
        <node_name>206000C0FF000198</node_name>
        <fru>
            <idx>0</idx>
            <item></item>
            <serial_number></serial_number>
            <revision></revision>
            <vendor_jedec_id></vendor_jedec_id>
            <manufacturing_date></manufacturing_date>
            <manufacturing_location></manufacturing_location>
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View Report 
使用 View Report 選項，可以檢查已建立的報告。

1. 選擇 File → View Report。 

會顯示用於選擇報告的 Open 對話方塊。

2. 選擇要檢查的報告，並按一下 Open。

頻外儲存管理 
頻外儲存管理能力讓您可以在使用 TCP/IP 的網路上監視並管理陣列。與頻內儲存管理
( 標準儲存管理方法 ) 不同的是，頻內儲存管理要求代理程式在實體連接記憶體的伺服器
上執行，而頻外儲存管理不要求代理程式在實體連接記憶體的伺服器上執行。使用頻外
儲存管理，如果附加到儲存設備的伺服器關機，監視和維護也不會受到影響。

下列各圖舉例說明各種頻內和頻外儲存管理配置。
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圖 9-1 頻內管理

圖 9-2 頻外管理

 主控台

1.1.1.1

SCSI/FC SCSI/FC

Array

1.1.1.3 1.1.1.4Agent 1.1.1.2

主控台正在和安裝在伺服器
1.1.1.1 上的代理程式透過乙太

 

 

網路通訊。代理程式正在和陣列
透過 SCSI/FC 連線通訊。
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SCSI/FC RJ45
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代理程式

SCSI/FC
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上的代理程式通訊。代理程式正在和
陣列透過乙太網路直接通訊。
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▼ 使用頻外管理

注意 – 無法透過頻外管理升級控制器、SAF-TE 和磁碟機韌體。

1. 請確定已經為陣列設定靜態或動態 IP 位址。

如果程式已經配置為透過頻內管理陣列，您可以透過 Change Controller Parameters 設
定 IP 位址。如果要設定 IP 位址，請參閱第 188 頁「Network 標籤」。如果尚未配置程
式，您可以透過 RS-232 終端埠設定 IP 位址。請參閱陣列的《Sun StorEdge 3000 Family
安裝、操作和維修手冊 》。

2. 設定 IP 位址後，請重設控制器。 

選擇 Array Administration → Controller Maintenance，然後按一下 Issue Reset to 
the Controller。

3. 選擇伺服器。

4. 選擇 View → Agent Options Management。 

5. 在 Agent Options Management 視窗中，選取 Out-Of-Band Agent preferred over 
In-Band。 

注意 – 選擇這個選項後，頻外就成為儲存管理的偏好方法。如果刪除頻外配置，在啟動
或重新啟動服務後，程式會返回頻內儲存和監視。

6. 在 IP Address 欄位中鍵入陣列的 IP 位址，然後按一下 Add。

7. 如果您為陣列建立了密碼，在 Password 欄位中鍵入，然後在 Verify Password 欄位中
重新鍵入。

注意 – 根據預設，這個陣列沒有設定密碼。如果需要建立或變更密碼的相關資訊，請參
閱陣列的 《Sun StorEdge 3000 Family RAID Firmware User's Guide》。
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8. 為了讓程式識別頻外陣列並在主視窗中顯示，請選擇伺服器。

9. 選擇 View → View Server。

10. 按一下 Probe。
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11. 如果程式尚未配置以管理陣列，您需要指定伺服器以管理控制器。

選擇 Array Administration → Controller Assignment。從 Server to manage 
this controller 清單選擇伺服器，然後按一下 Apply。

主視窗中會顯示頻外 HBA。

注意 – 如果視窗中沒有顯示頻外 HBA，請重設控制器。

▼ 從頻外管理移除陣列

1. 選擇伺服器。

2. 選擇 View → Agent Options Management。

3. 選擇要從 Managed Primary Agent 清單中刪除的陣列，並按一下 Remove。

HBA 仍然會顯示在主視窗中，如果要將其移除，您必須停止並重新啟動服務。
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透過網路管理儲存設備 
網路儲存管理功能讓您可以方便地透過網路管理陣列，而不必載入整個 Sun StorEdge
Configuration Service 套裝軟體。下列步驟說明如何設定陣列進行網路型管理，以及如
何透過網路瀏覽器進行存取。 

注意 – 這個功能需要 Sun StorEdge Enterprise Storage Manager Topology Reporter 
( 包括在 Sun StorEdge Enterprise Storage Manager 軟體中 ) 安裝在 Solaris 主機上。
如果需要更詳細的資訊，請參閱陣列的 《Sun StorEdge 3000 Family Release Notes》中
＜ Other Supported Software ＞ ( 其他支援的軟體 ) 一節。

注意 –Linux 不支援這項功能；換言之，如果在執行 Linux 作業環境的系統上安裝了
代理程式，Custom Configure 視窗上的 Configure Web Server 選項將無法使用。您可
以使用 Linux 網路瀏覽器下載主控台，但是代理程式必須安裝在執行 Solaris 作業環境
的系統上。

網路瀏覽器需求 
Sun StorEdge Enterprise Storage Manager Topology Reporter 可以在任何連接到相同
網路的機器上透過 URL 檢視 ( 您必須在 Solaris 作業環境機器上擁有帳戶 )。

Solaris/Linux 作業環境
■ Netscape 4.79
■ Java Plug-in 1.2.2_02
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Windows NT/2000 作業系統
■ Internet Explorer 5.0 ( 含 ) 以後版本
■ Java Plug-in 1.2.2_02

或者

■ Netscape 4.76
■ Java Plug-in 1.2.2_02

設定陣列

雖然不需要將整個 Sun StorEdge Configuration Service 套裝軟體下載到要從網路存取
陣列的機器上，但是需要一些程式檔案；因此，必須將整個 Sun StorEdge Configuration
Service 套裝軟體安裝到其他伺服器上，才能從它傳輸檔案到陣列。以下程序說明如何方
便地傳輸必要檔案來設定網路管理。

1. 請確認您擁有從網路到陣列的乙太網路連接，而且已經建立了該陣列的 IP 位址。

2. 從已經安裝整個 Sun StorEdge Configuration Service 套裝軟體的伺服器，選擇
Configuration → Custom Configure。

3. 選擇 Configure Web Server。

4. 驗證管理代理程式 ( 也就是在直接連接到儲存裝置的伺服器上執行的代理程式 ) 的 IP 位
址。

5. 鍵入要傳輸檔案的陣列的 IP 位址，然後按一下 OK。

注意 – 根據預設，這個陣列沒有設定密碼。不過如果您已經使用韌體應用程式建立了密
碼，您必須鍵入這個密碼。如果需要建立或變更密碼的相關資訊，請參閱陣列的 《Sun
StorEdge 3000 Family RAID Firmware User's Guide》。
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這些檔案傳輸完成之後，就會顯示確認訊息，然後就可以透過網路存取主控台了。

▼ 從網路瀏覽器存取主控台

1. 開啟網路瀏覽器。

2. 鍵入下面的 URL 位址：

3. 如本指南中適當章節所解釋的繼續監視、維護和更新儲存設備。

http:// 工作站的 IP 位址 /esm.html
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第  章10

維護陣列 

本章說明如何使用 Array Administration 來維護陣列的完整性。本章涵蓋下列主題：

■ 第 135 頁 「陣列管理活動」
■ 第 136 頁 「進行同位檢查」
■ 第 137 頁 「排程同位檢查」

■ 第 139 頁 「磁碟機故障」
■ 第 139 頁 「使用備用磁碟機自動重建磁碟機」
■ 第 140 頁 「不使用備用磁碟機重建裝置」
■ 第 140 頁 「檢查重建過程的進度」
■ 第 141 頁 「手動重建故障磁碟機」
■ 第 143 頁 「恢復邏輯磁碟機配置」
■ 第 146 頁 「重新設定控制器」
■ 第 146 頁 「將控制器蜂鳴器設定為靜音」
■ 第 147 頁 「恢復故障控制器的連線」
■ 第 149 頁 「顯示效能統計資料」

陣列管理活動
Array administration ( 陣列管理 ) 活動，例如初始化、磁碟機重建及同位檢查，都可能
要花一些時間，視涉及的邏輯磁碟機或實體磁碟機大小而定。

其中一個程序開始後，會顯示 Controller Array Progress 視窗。關閉視窗後，若要檢視
進度，請按一下 Progress Indicator 圖示 ，或選擇 View → Array Admin Progress。 
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▼ 進行同位檢查

同位檢查是容錯邏輯磁碟機或 LUN (RAID 3 和 5) 上複式資料完整性的檢查過程。

1. 選擇要進行同位檢查的邏輯磁碟機。

2. 選擇 Array Administration → Parity Check。

注意 – 您必須以 ssadmin 或 ssconfig 的身份登入才能存取此功能表上的選項。

3. 顯示 Logical Drive Parity Check 視窗時，選擇要在其上執行同位檢查的邏輯磁碟機。
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要對多個磁碟機進行同位檢查時，使用 Array Administration → Schedule Parity
Check 指令來排程近期內 ( 如三分鐘內 ) 的同位檢查。執行所排程的同位檢查時，會自
動逐一執行檢查。

4. 按一下 Parity Check 按鈕，啟動同位檢查程序。

同位檢查開始後，將自動顯示 Progress Indicator。如果這個視窗已關閉，選擇 
View → Array Admin Progress 或按一下 Progress Indicator 圖示就可以重新開啟視
窗。出現一個視窗顯示每個陣列完成進度的百分比。

▼ 排程同位檢查      
選擇 Array Administration → Schedule Parity Check，按照排程間隔 ( 例如在非尖峰
時間 ) 對特定的邏輯磁碟機陣列進行同位檢查。

■ 您可以選擇排程在管理伺服器上所配置任意數目的邏輯磁碟機，但是，在每一個陣列
控制器上您只能建立一個排程。

■ 在排程多個邏輯磁碟機時，按從邏輯磁碟機編號低到高的順序進行檢查。

■ 同位檢查時，每 1 GB 儲存平均需要五分鐘的時間。

■ 透過變更背景工作優先權，可以控制分配給同位檢查的系統資源量。

■ 同位檢查開始後，可以立即停止。這個操作不會導致任何資料損壞。

注意 – 您必須以 ssadmin 或 ssconfig 的身份登入才能存取此功能表上的選項。

1. 選擇要進行同位檢查的控制器。

2. 選擇 Array Administration → Schedule Parity Check。

顯示 Schedule Parity Check 視窗。
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3. 在視窗中適當的欄位內選擇。

■ Listed Logical Drives – 可用的容錯邏輯陣列的清單。使用 Shift 鍵選擇多個磁碟機。

■ Background Rate – 分配給陣列管理活動的陣列控制器 CPU 可用時間的百分比。從
Custom Configuration Options 視窗選擇 Change Controller Parameters，變更
background rate。

■ How Often – 指定同位檢查的頻繁程度。

■ Starting Day – 指定星期幾要開始這個排程。

■ Starting Time – 指定這個排程在開始日的啟動時間。

■ Existing Schedule – 目前的同位檢查排程：邏輯磁碟機、頻率、開始日和時間。

■ Next Parity Check – 下次您想要同位檢查開始的日期和時間。

4. 排程完成後，請按一下 OK。
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磁碟機故障 
本節包含使用或不使用備用磁碟機恢復磁碟機故障的程序。如果因為某些原因無法啟動
重建過程，也有手動重建故障磁碟機的說明。

小心 – 在發生故障之前，預先為每個邏輯磁碟機陣列安裝和配置本機或通用備用磁碟機。
根據使用的 RAID 等級類型以及執行歸檔程序的不同，在發生單一或多個磁碟機故障時，
可能會損失大量資料。此外，應在現場準備好經過測試的後備磁碟機，在發生故障時立
即取代。 

▼ 使用備用磁碟機自動重建磁碟機

當與容錯邏輯磁碟機相關的磁碟機發生故障時，且備用磁碟機已預先安裝和配置為通用
或者本機後備時，將會自動替換故障的磁碟機，並且使用指定的後備磁碟機重建其資料。
為使該過程正確無誤地完成，後備磁碟機的容量必須永遠等於或大於所替代的故障磁碟
機。 

重建過程通常在一到兩分鐘內開始。這個過程在背景中執行，在控制器沒有其他活動的
情況下，每 1 GB 大約需要八分鐘的時間。

在自動重建過程中，正常活動可以繼續，但是效能會降低。效能降低的程度取決於控制
器設定的背景工作優先權。

當您選擇 View → Array Admin Progress 時，就會顯示重建過程的進度。

1. 使用陣列的《Sun StorEdge 3000 Family 安裝、操作和維修手冊》中的指示，更換故障
的磁碟機來重新建立自動重建功能。

2. 在取下故障磁碟機後和插入新磁碟機之前，至少等待 60 秒。 

確保替換用磁碟機至少等於機箱中 大磁碟機的容量。將替換用磁碟機插入故障磁碟機
的同一個插槽中 ( 磁碟機托架 )，替換用磁碟機就成為新的後備磁碟機。

3. 重建過程完成且邏輯磁碟機再次連線後，將陣列控制器的配置備份到外部磁碟機或軟碟
上的檔案。

請參閱第 59 頁 「儲存邏輯磁碟機配置」。
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▼ 不使用備用磁碟機重建裝置

如果陣列中沒有備用磁碟機，必須在故障重建過程開始前更換故障的磁碟機。

1. 沒有備用磁碟機而要從磁碟機故障恢復時，應使用 《Sun StorEdge 3000 Family 安裝、
操作和維修手冊》中的指示更換故障的磁碟機。 

2. 在取下故障磁碟機後和插入新磁碟機之前，至少等待 60 秒。 

確定替代磁碟機的容量至少等於故障磁碟機的容量。將替代磁碟機安裝在和故障磁碟機
相同的位址 ( 磁碟機托架 )。

3. 在同一個插槽中更換了故障的磁碟機之後，您必須將它掃描進來。

如需掃描磁碟機的詳細說明，請參閱第 168 頁 「掃描新的硬碟」。

4. 掃描磁碟機後，必須選擇 Array Administration → Rebuild，以手動方式重建磁碟機。

▼ 檢查重建過程的進度

1. 選擇 View → Array Admin Progress 或按一下視窗右上角的 Progress Indicator 圖示
。 

顯示 Controller Array Progress 視窗，其中會顯示重建完成的百分比。但是，如果在多
重控制器上有陣列活動 ( 如初始化、重建或同位檢查 ) 發生，會先顯示 Select Controller
Progress 視窗。 

2. 選擇要檢視進度的控制器，然後按一下 OK。 

顯示 Controller Array Progress 視窗，其中會顯示所選取控制器的陣列進度。請參閱
第 135 頁 「陣列管理活動」。
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▼ 手動重建故障磁碟機

在大多數情況下，不必使用手動重建過程，因為替代的磁碟機會自動重建。 

如果故障發生時沒有後備磁碟機，或由於某些原因磁碟機無法重建時，可以使用 Rebuild
手動啟動重建過程。此外，如果重建過程因重新開機而中斷，請使用 Rebuild 重新啟動
重建過程。

1. 依照《Sun StorEdge 3000 Family 安裝、操作和維修手冊》中的指示來更換故障的磁碟
機。

2. 在取下故障磁碟機後和插入新磁碟機之前，至少等待 60 秒。 

確定替換用磁碟機的容量至少等於機箱內 大磁碟機的容量。 

3. 選擇 Array Administration → Rebuild。 

顯示 Rebuild 視窗。 
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4. 選擇替代磁碟機的狀態記錄。

5. 按一下 OK 以啟動重建過程。

重建過程是在背景中執行，當陣列控制器上沒有其他活動時，每 1 GB 資料大約需要八
分鐘的處理時間。在重建期間，雖然效能會降低，但是正常活動仍可以繼續。效能降低
的程度取決於控制器設定的背景工作優先權。

6. 若要檢查重建過程的進度，選擇 View → Array Admin Progress 或按一下視窗右上角
的 Progress Indicator 圖示。

顯示 Controller Array Progress 視窗，其中會顯示重建完成的百分比。

但是，如果在多重控制器上有陣列活動 ( 如初始化、重建或同位檢查 ) 發生，會先顯示
Select Controller Progress 視窗。

7. 選擇要查看進度的控制器，然後按一下 OK。 

顯示 Controller Array Progress 視窗，其中會顯示該控制器的陣列重建狀態。 
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▼ 恢復邏輯磁碟機配置 
本節說明如何從備份檔案中恢復陣列配置資訊。您必須已經使用 Save 指令儲存備份檔
案，如第 85 頁 「配置檔案」中所示。如果陣列控制器及其磁碟機損壞，可以將陣列配
置恢復至新的控制器，而不必完全重新配置儲存陣列。

小心 – 配置檔必須是 新的，才可從檔案恢復陣列配置。恢復過時的或不正確的配置會
導致資料損失。

如果確定備份檔案包含正確的陣列配置資訊，繼續下面的程序來恢復配置。

1. 為適當的陣列選擇控制器。

2. 選擇 Configuration → Load Configuration。 

顯示 Select Configuration File 視窗。 

3. 指定備份配置檔的名稱和位置，然後按一下 Open。
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顯示 Load Configuration 視窗。若要查看配置的樹狀檢視圖，請按一下 Configuration
View 標籤。

Saveset Description 標籤會顯示建立配置檔時指定的檔案說明。
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4. ( 僅適用於 Solaris 作業環境 )。如果要自動標示邏輯磁碟機好讓作業環境使用磁碟機，
請按一下 Write a new label to the new LD。

5. 若要載入已儲存的配置，選擇 OK。

顯示 Load Configuration Confirmation 視窗。

決定繼續前，請仔細檢查 Load Configuration Confirmation 視窗中顯示的資訊。

6. 按一下 Apply 載入此配置，或按一下 Cancel 終止這項功能。

按下 Apply 會繼續配置操作，並顯示進度視窗。

注意 – 請不要在恢復陣列配置備份檔案的內容後初始化 LUN。

7. 如果是在 Windows NT 上執行，應關閉並重新啟動作業系統。

若要啟用邏輯磁碟機配置以讓 Windows NT 識別，需要重新初始化作業系統。
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▼ 重新設定控制器

只要是對控制器參數做出更改，都會詢問是否要重新設定控制器以使變更生效。如果做
出多項變更，您可能不想在每次變更後都停止並重新設定控制器。請使用 Issue Reset to
the Controller 選項，在進行多項參數變更後，以手動方式重新設定控制器。

1. 在主視窗中選擇任何儲存圖示。 

2. 選擇 Array Administration → Controller Maintenance。

3. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。

4. 按一下 Issue Reset to the Controller。

注意 – 在 Sun StorEdge 3310 SCSI 陣列上重新設定控制器，有時可能會出現主機方面的
錯誤訊息，例如同位檢查錯誤和同步錯誤訊息。您不必做任何處理，當控制器重新初始
完畢後，這個狀況會自行更正。

▼ 將控制器蜂鳴器設定為靜音

當引起控制器發出蜂鳴聲的事件發生時 ( 例如邏輯磁碟機故障、重建期間或者新增 SCSI
磁碟機時 )，您可以用兩種方法中的一種將控制器蜂鳴器設定為靜音。

1. 在主視窗選擇控制器圖示。 

2. 選擇 Array Administration → Controller Maintenance。

3. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。

4. 按一下 Mute Controller Beeper。

或者
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1. 在主視窗選擇所需的控制器圖示。 

2. 選擇 Configuration → Custom Configure。

3. 選擇 Change Controller Parameters。

4. 選擇 Mute Beeper。

▼ 恢復故障控制器的連線

如果控制器故障，用兩種方法中的一種恢復連線。

1. 在主視窗選擇所需的控制器圖示。 

2. 選擇 Array Administration → Controller Maintenance。

3. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。

4. 按一下 Deassert Failed Redundant Controller。

或者

1. 在主視窗選擇所需的控制器圖示。 

2. 選擇 Configuration → Custom Configure。

3. 選擇 Change Controller Parameters。

4. 選擇 Redundancy 標籤。

5. 從 Set Controller Config 欄位，選擇 Redundant Deassert Reset。
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▼ 將雙控制器陣列轉換為單控制器陣列

如果一個控制器在雙陣列控制器配置中故障，您會希望在一段延伸的時間內執行單控制
器，好讓陣列在主控台中不會顯示為低效能。

1. 確認您知道要移除的控制器序號。

您可以檢查事件日誌找到故障控制器的序號，或檢查主控台並記下主控制器的序號。

2. 將其他控制器的複式設定變更為停用。

您必須使用韌體應用程式以停用控制器上的複式設定。如需有關存取韌體應用程式的資
訊，請參閱陣列的 《Sun StorEdge 3000 Family RAID Firmware User's Guide》，然後繼
續下列步驟。

a. 從主功能表選擇 view and edit Peripheral devices，然後按 Return。

b. 選擇 Set Peripheral Device Entry，然後按 Return。

c. 選擇 Redundant Controller - Primary，然後按 Return。

d. 選擇 Disable redundant controller，然後按 Return。

3. 根據作業環境 / 系統安裝章節中的說明停止代理程式。

4. 切換到 /var/opt/SUNWsscs/ssagent，並編輯檔案 sscontlr.txt。

檔案的 後一行包含兩個控制器的序號。從此行移除故障控制器的序號。

5. 根據作業環境 / 系統安裝章節中的說明啟動代理程式。

6. 如果主控台在這個程序中保持開啟，請重新掃描主控台。

# RAID_CONTROLLER=Enable:3197861:3179746
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▼ 顯示效能統計資料

使用 Performance Statistics，您可以判斷資料的傳輸速率，也就是陣列執行的速率。

1. 選擇 Array Administration → Controller Maintenance。

2. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。

3. 按一下 Performance Statistics。

顯示 Performance Statistics 視窗。
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第  章11

更新配置

想要變更目前配置或新增內容時，請參閱本章。本章說明下列工作：

■ 第 152 頁 「新增邏輯磁碟機或從新的邏輯磁碟機新增邏輯磁碟區」

■ 第 156 頁 「刪除邏輯磁碟機或邏輯磁碟區」

■ 第 159 頁 「建立分割區」

■ 第 161 頁 「刪除分割區」

■ 第 163 頁 「擴充邏輯磁碟機或邏輯磁碟區的容量」

■ 第 165 頁 「將 SCSI 磁碟機新增到現有邏輯磁碟機」

■ 第 166 頁 「複製並替換成員磁碟機」

■ 第 168 頁 「掃描新的硬碟」

■ 第 169 頁 「下載 RAID 控制器韌體」

■ 第 172 頁 「升級韌體和開機記錄」

■ 第 173 頁 「升級硬碟上的韌體」

■ 第 174 頁 「升級 SAF-TE/SES 裝置的韌體」

■ 第 175 頁 「變更控制器參數」

■ 第 176 頁 「儲存已變更值」

■ 第 189 頁 「將控制器蜂鳴器設為靜音」

■ 第 190 頁 「指定或變更備用磁碟機」

■ 第 191 頁 「編輯伺服器項目」

如果正在執行陣列管理程序 ( 如同位檢查等 ) ，則可能會暫時停用 Configuration 功能
表指令和工具圖示。在主控台正在更新伺服器上的庫存時，功能表指令也會顯示為停用。
在重新整理的過程中，碟形衛星天線圖示會附加到伺服器圖示 。

如果要使用 Configuration 選項，您必須使用 ssconfig 密碼登入軟體的 ssconfig 安
全等級。完成配置活動時，應登入回到程式的監控等級。
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▼ 新增邏輯磁碟機或從新的邏輯磁碟機新增邏輯
磁碟區

使用這個選項可新增一個或多個邏輯磁碟機到現有的 RAID 集配置，或者從新邏輯磁碟
機新增邏輯磁碟區。若要從現有的邏輯磁碟新增邏輯磁碟區，請參閱第 155 頁「從現有
邏輯磁碟機新增邏輯磁碟區」。

注意 – 如果邏輯磁碟機會大於 253 GB，請參閱第 73 頁「準備大於 253 GB 的邏輯磁碟
機」。

1. 選擇適當的陣列。

2. 選擇 Configuration → Custom Configure。

注意 – 除非選擇了有可用實體磁碟機的陣列，否則這個選項會呈非現用狀態。

3. 從 Custom Configuration Options 視窗，選擇 Add LDs/LVs to the Current 
Configuration。

4. 驗證顯示在視窗頂部的伺服器和控制器是否正確。

5. 選擇要包括在新邏輯磁碟區中的磁碟，然後按一下 Add Disk。

如果操作錯誤或變更決定，請選擇磁碟機然後按一下 Remove Disk。

6. 選擇 RAID Level。 

如需有關 RAID 等級的定義，請參閱第 195 頁 「RAID 基本知識」。 

7. 從 Channel 和 SCSI ID 清單方塊中，選擇要將新邏輯磁碟機對應到其上的主機通道和
SCSI ID。

8. 設定 Max Drive Size。 

Max Drive Size 顯示每個磁碟的總容量。降低這個值可以建立較小的邏輯磁碟機。
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注意 – 如果並未變更 Max Drive Size，但是變更了 Partition Size，會依照指定的分割大
小建立新的分割區。剩餘的邏輯磁碟機大小容量移動至上一個分割區。然後可以透過擴
展磁碟機來利用剩餘容量 ( 如第 163 頁「擴充邏輯磁碟機或邏輯磁碟區的容量」所示 )。
在建立分割區後，就不能再編輯磁碟機容量。

注意 – 如果想要在同一個控制器上建立另一個邏輯磁碟機，請按一下 New LD。會建立
剛才定義的邏輯磁碟機並回到視窗頂部，讓您可以建立另一個邏輯磁碟機。在 Sun
StorEdge 3310 SCSI 陣列上， 多可以建立 8 個邏輯磁碟機，每個邏輯磁碟機 多可有
32 個分割區。在 Sun StorEdge 3510 FC Array 上， 多可以建立 8 個邏輯磁碟機，每
個邏輯磁碟機 多可有 128 個分割區。 

9. 若要將此邏輯磁碟機新增到邏輯磁碟區，請按一下 New LD，並參閱第 154 頁「新增邏
輯磁碟機到邏輯磁碟區」。

10. 若滿意該視窗的選擇，並且不需要定義另一個邏輯磁碟機，按一下 Commit。 

確認視窗會顯示新的配置。按一下 OK 接受配置。
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11. 選擇 Cancel 回到主控台。

這會提供額外的容錯。可以根據需要，隨時將磁碟機的狀況改回可用。

注意 – 按一下 OK 後就不能變更邏輯磁碟機的配置。

注意 – 在初始化過程中，LD/LV 的大小會顯示為 0 MB。

▼ 新增邏輯磁碟機到邏輯磁碟區 

邏輯磁碟區是由兩個以上邏輯磁碟機組成， 多可以分成 32 個分割區。操作期間，主機
將未分割的邏輯磁碟區或邏輯磁碟區的分割區視為單一實體磁碟機。 

1. 請依照第 152 頁「新增邏輯磁碟機或從新的邏輯磁碟機新增邏輯磁碟區」中步驟 1-8 的
說明建立邏輯磁碟機。

注意 – 不要分割您要新增到邏輯磁碟區的邏輯磁碟機。已經分割的邏輯磁碟機不能新增
到邏輯磁碟區。

2. 在按下 Commit 將邏輯磁碟機新增到邏輯磁碟區之前，請先按 Add to LV。

邏輯磁碟機就會新增到 LV Definition 方塊。邏輯磁碟區的總容量會顯示在 Available
Size (MB) 欄位中。 

注意 – 因為這個邏輯磁碟區還沒有分割，所以 Part Size (MB) 與 Available Size (MB) 兩
者是一樣的。一個單一的邏輯磁碟區會被視為一個單一分割區。

3. 如果要建立另一個邏輯磁碟機用來新增到邏輯磁碟區，請按一下 New LD。

4. 按一下 Add to LV 即可建立邏輯磁碟機並將它新增到邏輯磁碟區。

針對您要新增到邏輯磁碟區的每一個邏輯磁碟機重複這個步驟。

5. 若要建立分割區，請參閱第 159 頁 「建立分割區」。

6. 完成新增邏輯磁碟機到邏輯磁碟區之後，如果要建立另一個邏輯磁碟區或個別的邏輯磁
碟機，請按一下 Commit LV。

完成建立邏輯磁碟區之後，如果不想建立個別的邏輯磁碟機，請按一下 Commit。
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注意 – 如果您完成建立邏輯磁碟區之後想要結束 New Configuration 視窗，但是不小心
按了 Commit LV ( 而不是 Commit)，那麼您必須建立另一個邏輯磁碟機；否則，就必
須按一下 Cancel 並且再次配置邏輯磁碟區。

▼ 從現有邏輯磁碟機新增邏輯磁碟區

注意 – 從現有的邏輯磁碟機新增邏輯磁碟區之前，您必須取消對應邏輯磁碟機。

1. 選擇適當的陣列。

2. 選擇 Configuration → Custom Configure。

注意 – 除非選擇了有可用實體磁碟機的陣列，否則這個選項會呈非現用狀態。

3. 從 Custom Configuration Options 視窗，選擇 Add LDs/LVs to the Current 
Configuration。

4. 驗證顯示在視窗頂部的伺服器和控制器是否正確。

5. 選擇 Use existing LDs to create LVs。

如果在 Select a Logical Drive 之下未列出任何邏輯磁碟機，表示這些邏輯磁碟機尚未取
消對應，所以無法選取。您必須先取消對應這些邏輯磁碟機。

6. 選擇邏輯磁碟機並且按一下 Add to LV。

7. 完成新增邏輯磁碟機到邏輯磁碟區之後，如果要建立另一個邏輯磁碟區或個別的邏輯磁
碟機，請按一下 Commit LV。

完成建立邏輯磁碟區之後，如果不想建立個別的邏輯磁碟機，請按一下 Commit。

注意 – 如果您完成建立邏輯磁碟區之後想要結束 New Configuration 視窗，但是不小心
按了 Commit LV ( 而不是 Commit)，那麼您必須建立另一個邏輯磁碟機；否則，就必須
按一下 Cancel 並且再次配置邏輯磁碟區。
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▼ 刪除邏輯磁碟機或邏輯磁碟區

使用這個選項從 RAID 集的現有配置中刪除一個或多個邏輯磁碟機或邏輯磁碟區。

注意 – 刪除邏輯磁碟機或邏輯磁碟區之前，您必須先取消對應所有已分配的 LUN。

1. 選擇適當的陣列。

2. 檢視要刪除的邏輯磁碟機或邏輯磁碟區。

3. 只要任何邏輯磁碟機或邏輯磁碟區擁有主機 LUN 分配，請執行步驟 4；如果沒有，請
執行步驟 8。

4. 選擇 Configuration → Custom Configure。

5. 選擇 Change Host LUN Assignments。

如果選取 Use existing LDs
to create LVs 之後沒有列出
任何邏輯磁碟區，表示這些
邏輯磁碟機尚未取消對應。
您必須先取消對應這些邏輯
磁碟機。
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6. 選擇連接到要取消對應的邏輯磁碟機或邏輯磁碟區的主機 LUN，然後按一下 Unmap
Host LUN。

7. 按一下 OK，然後按一下 Close。

8. 選擇 Configuration → Custom Configure。

9. 從 Custom Configuration Options 視窗，選擇 Manage Existing LDs/LVs and 
Partitions。

10. 選擇 LDs/LVs 標籤。

11. 選擇要刪除的邏輯磁碟機或邏輯磁碟區，按一下 Delete，然後按一下 OK。

刪除邏輯磁碟區時，按下 Delete 之後這個邏輯磁碟區就會被刪除，但是仍然會顯示組成
這個邏輯磁碟機的邏輯磁碟機。

12. 按一下 Confirm Configuration Operation 視窗中的 OK 完成操作，然後按一下 Close。
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邏輯磁碟機 / 邏輯磁碟區號碼

每個邏輯磁碟機所參照的邏輯磁碟機 / 邏輯磁碟區號碼是動態的；它會隨著邏輯磁碟機
的建立或刪除而改變。這個號碼會顯示在一些視窗的邏輯磁碟機 (LDs/LVs) 欄位中，這
些視窗包括 Dynamically Grow and/or Reconfigure LDs/LVs、Change Host LUN
Assignments、Manage Existing LDs/LVs and Partitions 以及主視窗。

這個邏輯磁碟機號碼只是做為預留位置之用，讓您能以目視方式追蹤邏輯磁碟機，對於
控制器而言這個號碼並不重要。也就是說，控制器並不是依據這個號碼對邏輯磁碟機或
邏輯磁碟區報告。例如，如果有四個邏輯磁碟機，而且 LD2 被刪除了，那麼目前的 LD3
就會動態地變更為 LD2，而 LD4 則變更為 LD3。只有 LD/LV 號碼發生變化；邏輯磁
碟機上的所有 LUN 對應和資料仍然不變。 

由於控制器會報告邏輯磁碟機的總數 ( 在這個例子裡是三個 )，所以在 LD/LV 欄位中顯
示的實際 LD/LV 數目與此無關。在本例中，如果建立了新的邏輯磁碟機，則新邏輯磁
碟機會佔用被刪除的邏輯磁碟機的 LD 號碼，控制器報告總共有四個邏輯磁碟機。所有
現有的邏輯磁碟機回到原先的主 / 次指定。 

注意 – 如以下範例所示，韌體終端機功能表選項 View and Edit Logical Drives 上的 LG
號碼在目視上並非動態的。邏輯磁碟機被刪除之後，您可以看到空白的預留位置。從主
控台或終端機建立邏輯磁碟機時，新的邏輯磁碟機會使用這一個空的預留位置。
158 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



▼ 建立分割區

注意 – 建立分割區前，需要取消對應所有已分配的 LUN。

1. 選擇適當的陣列。

2. 檢視要建立分割區的邏輯磁碟機。

3. 只要任何邏輯磁碟機擁有主機 LUN 分配，執行步驟 4；如果沒有，執行步驟 8。

4. 選擇 Configuration → Custom Configure。

5. 選擇 Change Host LUN Assignments。

6. 選擇連接到要分割的一個或多個邏輯磁碟機的主機 LUN，然後按一下 Unmap Host LUN。

7. 按一下 OK，然後按一下 Close。

8. 選擇 Configuration → Custom Configure。

9. 從 Custom Configuration Options 視窗，選擇 Manage Existing LDs/LVs and 
Partitions。

Manage Existing LDs/LVs and Partitions 視窗 ( 圖右 ) 中的 LD 欄位是動態的，
在建立 / 刪除邏輯磁碟機時會變更。在這個範例中，刪除了 LD2，且 LD4 變成 LD3， 

LG 欄位不是動態的，空白的位置表示 LD2 已經刪除了。
LD 2 變成 LD1。在終端機功能表選項的 View and Edit Logical Drives ( 圖左 ) 中，
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10. 選擇 Partitions 標籤。

11. 選擇要分割的邏輯磁碟機或邏輯磁碟區。

12. 以 MB 為單位指定 Partition Size，然後按一下 Create。

若要建立同樣大小的多個分割區，想建立多少個分割區就按多少次 Add Partition。您也
可以在 Part Size 欄位中鍵入分割區的大小，並且以您要建立的分割區數目來乘 (*) 它，
例如 100*128。任何剩餘的 MB 都會加到 後一個分割區。

新增分割區時，Available Size (MB) 中顯示的剩餘容量會依原來容量減去分割區大小的
容量。

13. 若要變更已建立分割區的大小，請選擇邏輯磁碟機或邏輯磁碟區，然後按一下 Modify
Size。 

14. 在 Partition Size 對話方塊中指定新的大小 ( 以 MB 為單位 )，然後按一下 OK。

15. 按一下 Confirm Configuration Operation 視窗中的 OK 完成操作，然後按一下 Close。

邏輯磁碟機或邏輯磁碟區經過分割後，當您在主視窗選擇某一個邏輯磁碟機或邏輯磁碟
區時，就會顯示這些分割區 。
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邏輯磁碟機 / 邏輯磁碟區號碼

如需有關 Manage Existing LDs/LVs and Partitions 視窗中 LDs/LVs 欄位所顯示邏輯
磁碟機/邏輯磁碟區號碼的詳細資訊，請參閱第 158 頁「邏輯磁碟機/邏輯磁碟區號碼」。

▼ 刪除分割區

注意 – 若要刪除邏輯磁碟機或邏輯磁碟區上的分割區，您必須先取消對應所有已分配的
LUN。

1. 選擇適當的陣列。

2. 檢視要刪除分割區的邏輯磁碟機或邏輯磁碟區。 

只要磁碟機上的任何分割區已經有 LUN 對應，執行步驟 3；如果沒有，執行步驟 7。

3. 選擇 Configuration → Custom Configure。

4. 選擇 Change Host LUN Assignments。

5. 選擇對應到要刪除的邏輯磁碟機或邏輯磁碟區分割區的 LUN，然後按一下 Unmap 
Host LUN。

6. 按一下 OK，然後按一下 Close。

7. 選擇 Configuration → Custom Configure。

8. 從 Custom Configuration Options 視窗，選擇 Manage Existing LDs/LVs and 
Partitions。

9. 選擇 Partitions 標籤。
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10. 從邏輯磁碟機或邏輯磁碟區內的 後一個分割區開始，選擇要修改或刪除的分割區。

11. 按一下 Delete，然後按一下 OK。

12. 按一下 Confirm Configuration Operation 視窗中的 OK 完成操作，然後按一下 Close。
162 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



▼ 擴充邏輯磁碟機或邏輯磁碟區的容量

使用這個選項擴充現有邏輯磁碟機或邏輯磁碟區的容量。例如，您可能原先有一個 
18 GB 的磁碟機，但只選擇了 9 GB 的空間來建立邏輯磁碟機。若要利用剩餘的 9 GB，
您需要擴充邏輯磁碟機。 

注意 – 若要擴充邏輯磁碟區，您必須先擴充組成這個邏輯磁碟區的邏輯磁碟機。

1. 選擇適當的陣列。

2. 選擇 Configuration ∅ Custom Configure。

3. 從 Custom Configuration Options 視窗，選擇 Dynamically Grow and/or Reconfigure
LDs/LVs。

4. 選擇要擴充的邏輯磁碟機或邏輯磁碟區。

5. 選擇 Expand LD/LV 標籤。
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6. 在 Maximum Drive Expand Capacity 欄位中以 MB 為單位指定要在邏輯磁碟機上擴
充的容量，然後按一下 OK。 

Maximum Drive Expand Capacity 不能超過 Maximum Available Drive Free Capacity。

7. 按一下 Confirm Configuration Operation 視窗中的 OK 完成操作，然後按一下 Close。

邏輯磁碟機 / 邏輯磁碟區號碼

如需有關 Dynamically Grow and/or Reconfigure LDs/LVs 視窗中 LD/LV 欄位所顯
示邏輯磁碟機 / 邏輯磁碟區號碼的詳細資訊，請參閱第 158 頁「邏輯磁碟機 / 邏輯磁碟
區號碼」。

如果用完了邏輯磁碟機建立
時的所有容量，就會顯示 0；
除非新增其他邏輯磁碟機，
否則這裡已經沒有擴充的
空間。
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▼ 將 SCSI 磁碟機新增到現有邏輯磁碟機 
1. 選擇適當的陣列。

2. 選擇 Configuration → Custom Configure。

3. 從 Custom Configuration Options 視窗，選擇 Dynamically Grow and/or Reconfigure
LDs/LVs。

4. 選擇要新增 SCSI 磁碟機的邏輯磁碟機。

5. 選擇 Add SCSI Drives 標籤。

6. 從 Available disks 清單中，選擇要新增到邏輯磁碟機的磁碟機。

7. 按一下 Add Disk。 

磁碟機已移到 Add disk(s) to LD 清單中。

如果您操作錯誤或變更決定，請從 Add disk(s) to LD 清單中選擇磁碟，然後按一下
Remove。

8. SCSI 磁碟機都新增完畢後，按一下 OK。

9. 按一下 Confirm Configuration Operation 視窗中的 OK 完成操作，然後按一下 Close。
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邏輯磁碟機 / 邏輯磁碟區號碼
如需有關 Dynamically Grow and/or Reconfigure LDs/LVs 視窗中 LD/LV 欄位所顯
示邏輯磁碟機 / 邏輯磁碟區號碼的詳細資訊，請參閱第 158 頁「邏輯磁碟機 / 邏輯磁碟
區號碼」。

▼ 複製並替換成員磁碟機

您可以複製更高容量的磁碟機並替代現有的磁碟機成員。例如，原來含有三個成員磁碟
機 ( 每個成員各有 18 GB 的容量 ) 的邏輯磁碟機，可以替換成每個成員各為 36 GB 容量
的新磁碟機，如下圖所示。

圖 11-1 複製並替換成員磁碟機

1. 選擇適當的陣列。

2. 選擇 Configuration → Custom Configure。

3. 從 Custom Configuration Options 視窗，選擇 Dynamically Grow and/or Reconfigure
LDs/LVs。

18 GB18 GB18 GB
新磁碟機

36 GB

36 (GB)36 (GB) 36 (GB)

RAID5 (4 GB)

使用中

未使用

新磁碟機
36 GB

新磁碟機
36 GB

RAID5 (4 GB)
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4. 選擇要進行複製和替換操作的邏輯磁碟機。

5. 在 Dynamically Grow and/or Reconfigure LDs/LVs 視窗，選擇 Copy and Replace
Drive 標籤。

6. 從 Drive to Copy Data From 清單，選擇新的硬碟。

7. 從 Drive to Copy Data To 清單中，選擇要替換的硬碟，然後按一下 OK。

若要使用新磁碟機提供的更多容量，請依照第 163 頁「擴充邏輯磁碟機或邏輯磁碟區的
容量」中的操作指示。

8. 按一下 Confirm Configuration Operation 視窗中的 OK 完成操作，然後按一下 Close。

9. 當完成操作後，關閉進度視窗。
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邏輯磁碟機 / 邏輯磁碟區號碼
如需有關 Dynamically Grow and/or Reconfigure LDs/LVs 視窗中 LD/LV 欄位所顯
示邏輯磁碟機 / 邏輯磁碟區號碼的詳細資訊，請參閱第 158 頁「邏輯磁碟機 / 邏輯磁碟
區號碼」。

▼ 掃描新的硬碟

您可以在不需關閉陣列的情況下掃描及使用硬碟。

1. 按兩下適當的陣列。

2. 顯示 View Controller Configuration 視窗。

3. 選擇 Physical Drives 標籤，然後按一下 Scan SCSI Drive。
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4. 選擇輸入磁碟機中的正確通道和 ID。

如果掃描成功，會正確地顯示磁碟機並且成為可用。

▼ 下載 RAID 控制器韌體

可以使用以下程序為單一或複式控制器配置升級控制器韌體。

1. 在主視窗選擇所需的控制器圖示。 

2. 選擇 Array Administration → Controller Maintenance。

3. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。
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4. 如果只升級韌體 ( 而不升級開機記錄 )，選擇 Download Firmware 選項。 

顯示 Select Firmware File 視窗。
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5. 選擇要下載的韌體，然後按一下 Open。

顯示 Confirmation Dialog 提示。

6. 按一下 Yes。 

將韌體下載到 RAID 控制器會顯示一個進度列。

7. 當進度列達到 100% 時，按一下 OK。 

8. 下載韌體完畢後，檢查設定確定已正確地配置。
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▼ 升級韌體和開機記錄

1. 到 Array Administration → Controller Maintenance。

2. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。

3. 選擇 Download Firmware with Boot Record。

顯示 Select Boot Record File 視窗。

4. 選擇開機記錄並按一下 Open。 

5. 選擇適當的韌體檔案。 

顯示 Select Firmware File。

6. 按一下 Open。 

顯示 Confirmation Dialog 視窗。

7. 重複前一小節的步驟 6 到 8。
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下載用於裝置的韌體
這個選項讓您可以升級硬碟和 SAF-TE/SES 裝置上的韌體。

▼ 升級硬碟上的韌體

1. 選擇適當的陣列。

2. 選擇 Array Administration → Download FW for Devices。

3. 按一下 Download FW for Disks 標籤。

4. 選擇 To All disks under Controller，並從功能表選擇一個陣列，或選擇 To All disks
under LD，並從功能表選擇邏輯磁碟機。

■ 如果有不想下載新韌體的磁碟機，請在 Selected Disks 中加以選取，然後按一下 Remove。

■ 如果有要新增的邏輯磁碟機，從 Available Disks 選擇並按一下 Add。

■ 如果有多個磁碟機具有不同的產品 ID，則一定要從 Product ID 清單方塊選擇想要下
載韌體的磁碟機的產品 ID。
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5. 按一下 Browse 並找到下載韌體檔案。 

選擇 Open。

6. 選擇要下載的韌體檔案，按一下 Open，然後按一下 OK。

開始下載韌體。

7. 當進度達到 100% 時，按一下 OK。

8. 若要確認韌體已成功下載，選擇 View → View Physical Drive，並確保在 Product
Revision 欄位中的韌體版本已變更。

▼ 升級 SAF-TE/SES 裝置的韌體

注意 –SAF-TE 裝置是由 SCSI 陣列使用，而 SES 裝置則是由光纖通道陣列使用。

1. 選擇陣列。

2. 選擇 Array Administration → Download FW for Devices。

3. 按一下 Download FW for SAFTE/SES Devices 標籤。

■ 若要新增裝置，可以從 Available SAF-TE Devices 中選擇裝置，並按一下 Add。
■ 若要移除裝置，可以從 Selected SAF-TE Devices 中選擇裝置，並按一下 Remove。
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4. 按一下 Browse 並找到下載韌體檔案。 

5. 選擇要下載的韌體檔案，按一下 Open，然後按一下 OK。

開始下載韌體。

6. 當進度達到 100% 時，按一下 OK。

7. 若要確認韌體是否已成功下載，選擇 View → View Enclosure，確保在 Firmware Rev
欄位中的韌體版本已變更。

▼ 變更控制器參數

1. 從主功能表選擇適當的陣列控制器。

2. 選擇 Configuration → Custom Configure。 

如有必要，使用 ssconfig 密碼登入程式的配置等級。顯示 Custom Configuration
Options 視窗。

3. 從 Custom Configuration Options 視窗，選擇 Change Controller Parameters。 

顯示 Change Controller Parameters 視窗，其中 Channel 標籤已選取。
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注意 – 如果是 Sun StorEdge 3510 FC Array，CurClk 為 2.0GHz。

■ Controller Name – 如果需要設定控制器名稱，選擇 Controller Name 並輸入想要的
名稱。按一下 OK 儲存變更。

■ Controller Unique ID – 歲 o 個 ID 是自動設定的。

▼ 儲存已變更值

Change Controller Parameters 視窗上的某些選項需要重設控制器，以使變更生效。如
果變更需要控制器重設，會在視窗左下方顯示以下訊息：

[Controller reset is required for changes to take effect.]

若要重設控制器和儲存變更值，您可以在變更時選取 Issue Controller Reset 核取方塊，
或稍後透過 Controller Maintenance 視窗重設控制器 ( 請參閱第 146 頁「重新設定控制
器」 )。如果做出多項變更，您可能不想在每次變變更後都停止並重新設定控制器。如果
您沒有選取 Issue Controller Reset 核取方塊，而變更需要重設才能生效的話，在按下
OK 時會顯示警告訊息。
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1. 選取 Issue Controller Reset 核取方塊。

2. 進行變更並按一下 OK。

或者

1. 不選取 Issue Controller Reset 核取方塊。

2. 進行變更並按一下 OK。

3. 稍後依據第 146 頁 「重新設定控制器」中的說明重設控制器。

Channel 標籤

1. 從 Channel Settings 標籤中，選擇要編輯的通道。

2. 按一下 Change Settings。

顯示 Change Channel Settings 視窗。為了讓伺服器識別陣列，主機通道必須將一個 ID
分配給邏輯磁碟機，並且將一個邏輯磁碟機對應到該主機通道和 ID。這個視窗可以讓您
設定主機 / 磁碟機通道。
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3. 從 Channel Mode 清單方塊中，選擇 Host 或 Drive。 

磁碟機就是連接到 Drive 通道 ( 內部或外部 )。連接到伺服器的就是 Host 通道。

注意 – 根據控制器配置的不同，可能需要按照以下步驟說明，選擇主通道 ID 和次通道
ID。

4. 從 Available SCSI IDs 清單方塊中，先選擇標示為 PID 的主通道 ID。然後按一下 Add
PID。

5. 如果您安裝了兩個控制器，則從 Available SCSI IDs 清單方塊中選擇次通道 ID，然後
按一下 Add SID。

6. 重設控制器以使變更生效。
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變更光纖配置中的主機 ID

1. 如果您希望 ID 高於 15，請按一下 Select SCSI ID Range 並且選擇想要的範圍。 

注意 – 每個通道的 ID 都必須在相同的範圍之內。

2. 按一下 Remove 以移除 PID 或 SID。

3. 完成選擇之後，請按一下 OK 重新顯示先前的視窗。

RS 232 標籤

1. 完成所有通道的設定後，從 Change Controller Parameters 視窗，選擇 RS 232 標籤。

2. 選擇想要的連接埠，然後按一下 Change Settings。 

顯示 Change RS232 Port Settings 視窗。
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3. 選擇包括 9600 預設設定在內的任何傳輸速率，然後按一下 OK 回到上一個視窗。 

Cache 標籤

Optimization

從 Cache 標籤，可選擇邏輯磁碟機的 佳化模式，其指示跨陣列中每個磁碟機寫入的資
料量。Sequential I/O 表示大的資料區塊 (128 KB)。Random I/O 表示小的資料區塊
(32 KB)。 

陣列使用的應用程式類型會決定應該套用 Random 或 Sequential I/O。視訊 / 影像應
用程式的 I/O 大小可以是 128、256、512 KB，或 多到 1 MB，所以應用程式是以大區
塊及依序排列檔案的方式來讀取並寫入磁碟機資料。資料庫 / 交易處理應用程式是以小
區塊及隨機存取檔案的方式，來讀取及寫入磁碟機資料。

佳化模式有兩種限制：

■ 陣列中的所有邏輯磁碟機都必須套用 佳化模式。

■ 一旦選擇 佳化模式並將資料寫入邏輯磁碟機之後，變更 佳化模式的唯一方法是先
將所有資料備份到另一個位置，然後刪除所有磁碟機的邏輯設定、為邏輯磁碟機重新
設定新的 佳化模式， 後重新啟動陣列。

注意 – 佳化為 Sequential I/O 的邏輯磁碟機的可用大小上限是 2 TB。 佳化為
Random I/O 的邏輯磁碟機的可用大小上限是 512 GB。當所建立的邏輯磁碟機大於這
些限制時，會顯示錯誤訊息。
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磁碟的 大數目以及 Random 和 Sequential 佳化的 大未用容量

選擇 Random 或 Sequential 佳化會影響陣列中可包括的 大磁碟數目，及邏輯磁碟
機的 大未用容量。下列表格包含每個邏輯磁碟機中 大磁碟數目及其 大未用容量。

注意 – 使用 1 個陣列及 2 個擴充單元，您 多可有 8 個邏輯磁碟機及 36 個磁碟。

注意 – 當使用 36 146 GB 磁碟時可能無法使用所有磁碟資料。其餘的磁碟都可做為備用
磁碟。

表 11-1 每個 2U 陣列的邏輯磁碟機之 大磁碟數目

磁碟容量 
(GB)

RAID 5 
Random

RAID 5 
Sequential

RAID 3 
Random

RAID 3 
Sequential

RAID 1 
Random

RAID 1 
Sequential

RAID 0 
Random

RAID 0 
Sequential

36.2 14 31 14 31 28 36 14 36

73.4 7 28 7 28 12 30 6 27

146.8 4 14 4 14 6 26 3 13

表 11-2 每個 2U 陣列的邏輯磁碟機之 大未用容量 (GB)

磁碟容量 RAID 5 
Random

RAID 5 
Sequential

RAID 3 
Random

RAID 3 
Sequential

RAID 1 
Random

RAID 1 
Sequential

RAID 0 
Random

RAID 0 
Sequential

36.2 471 1086 471 1086 507 543 507 1122

73.4 440 1982 440 1982 440 1101 440 1982

146.8 440 1908 440 1908 440 1908 440 1908
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回寫快取記憶體

回寫快取記憶體是一個快取記憶體寫入策略，控制器會接收要寫入磁碟的資料，並將資
料儲存在記憶體緩衝區中，然後立即向主機操作環境發送訊號，表示已完成寫入操作，
而不必等待資料實際寫入磁碟機。回寫快取記憶體功能提高了寫入操作的效能和控制器
卡的流量處理。直寫快取記憶體是一個快取記憶體寫入策略，控制器在向主機操作環境
發送訊號表示已完成程序之前，即將資料寫入磁碟機。直寫快取的寫入操作能力較低；
但是，在電源故障情況下也較為安全。因為已安裝電池模組，故可將電源提供給記憶體
中的資料快取，並在回復電源後完成快取寫入。

1. 從 Change Controller Parameters 視窗，選擇 Cache 標籤。

2. 從清單方塊中選擇 Optimization 或接受目前的設定。

3. 若要指定 Write Back 快取記憶體，請按一下清單方塊並選擇 Enabled。

如果停用 Write Back，則會選擇 Write-Through 做為快取記憶體寫入策略。

4. 重設控制器以使變更生效。
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Disk Array 標籤

1. 從 Change Controller Parameters 視窗，選擇 Disk Array 標籤。 

2. 從三個 Write Verify 清單方塊選擇 Disabled 或 Enabled。

通常當硬碟寫資料時可能會發生錯誤。要避免寫入錯誤，控制器能夠強制硬碟驗證寫入
的資料。

■ Write Verify on Initialization - 初始化邏輯磁碟機時，執行寫後驗證。

■ Write Verify on Rebuild - 在重建過程中執行寫後驗證。

■ Write Verify on Normal - 在一般 I/O 要求中執行寫後驗證。

3. 從 Rebuild Priority 清單方塊中的四個可用選項中進行選擇：Low、Normal、
Improved 或 High。

RAID 控制器提供了背景重建能力。表示控制器可以在重建邏輯磁碟機時同時服務其他
I/O 請求。重建磁碟機集所需的時間，主要取決於要重建的邏輯磁碟機的總容量。另外，
重建過程對於主機電腦和作業環境而言，是完全透明的。

■ Low - 使用控制器 少資源進行重建的預設值

■ Normal - 加速重建過程

■ Improved - 配置更多的資源給重建過程

■ High - 使用控制器的 高資源以 短的時間來完成重建過程
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Drive I/F 標籤

1. 從 Change Controller Parameters 視窗，選擇 Drive I/F 標籤。

2. 從 SCSI Motor Spin Up 欄位，選擇 Disabled 或 Enabled。

SCSI Motor Spin Up 決定如何啟動磁碟陣列中的 SCSI 磁碟機。當電源供應器無法向同
時通電啟動的硬碟和控制器提供足夠的電流時，將各個硬碟磁碟機順序啟動是耗費較低
啟動電流的 佳方法之一。在預設的情況下，通電時所有硬碟都會開始運轉。 

3. 從 Power Up SCSI Reset 欄位，選擇 Enabled 或 Disabled。

在預設情況下，當控制器通電時，會將 SCSI 匯流排重設指令傳送到 SCSI 匯流排。如果
停用，在下一次通電時就不會傳送 SCSI 匯流排重新設定指令。

在將雙主機電腦連接到同一 SCSI 匯流排時，SCSI 匯流排重設將中斷所有執行中的讀 /
寫請求。這可能會造成某些作業環境或主機電腦運作不正常。通電時停用 Power Up
SCSI Reset 可以避免這個情況發生。
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4. 設定 Disk Access Latency。

本功能設定在開啟電源後控制器嘗試存取硬碟前的延遲時間。預設值為 15 秒鐘。

5. 設定 Tag Count Per drive。

這是同時可發送到每個磁碟機的標記的 大數目。磁碟機具有內建快取記憶體，用於對
發送給磁碟機的所有 I/O 請求 ( 標記 ) 進行排序，讓磁碟機能夠更快地完成這些請求。

快取記憶體的大小和標記的 大數量根據磁碟機品牌和型號不同而有所差別。使用預設
值 32。將 大標記數變更為 Disable 會引起磁碟機內部快取記憶體被忽略 ( 不使用 )。

控制器支援標記指令佇列，可調整標記計數為 1 到 128。

6. 從 SAF-TE Polling Period (Sec) 欄位，選擇清單方塊中顯示的可變時間選項，或者選
擇 0.0 以停用該功能而不對所有安裝的事件記錄模組 (ERM) 進行輪詢。

7. 從 SCSI I/O Timeout (Sec) 欄位，選擇 0.5 到 10 秒之間的一個值。

SCSI I/O Timeout 是控制器等待磁碟機反應的時間間隔。如果控制器嘗試從磁碟機讀取
資料或將資料寫入磁碟機，但磁碟機在 SCSI I/O 逾時值範圍內沒有回應，則認為是故
障磁碟機。

SCSI I/O Timeout 的預設設定是光纖通道為 30 秒，SCSI 為 15 秒。不要變更這個設定。
如果將逾時設定為較低的值會導致磁碟機仍在重新嘗試或無法評斷 SCSI 匯流排時，會
造成控制器判斷磁碟機為故障。將逾時設定為較高的值，會導致控制器持續等待某一磁
碟機，使得有時會引起主機逾時。

如果從磁碟機碟片上讀取資料時，磁碟機檢測到媒體錯誤，會再次嘗次前一讀取操作或
再校準磁頭。當磁碟機遇到媒體上損壞的區塊時，會將損壞區塊重新分配給同一磁碟機
上的另一個後備區塊。但是，這些操作都需要花費一些時間。依磁碟機品牌和型號的不
同，執行這些操作的時間有所差別。

在 SCSI 匯流排仲裁期間，具有較高優先順序的裝置可以先使用匯流排。當更高優先順
序的設備持續使用匯流排時，較低優先順序的裝置有時會接收到 SCSI I/O Timeout。

8. 從 Drive Check Period (Sec) 欄位，選擇 0.5 到 30 秒之間的一個值。

Periodic Drive Check Time 是控制器用來檢查 SCSI 匯流排上裝置的時間間隔。預設值
為 Disabled，這意味著如果匯流排上沒有活動，控制器無法知道磁碟機是發生了故障還
是已被刪除。設定一個間隔，讓程式在沒有任何陣列活動時偵測磁碟機故障；但是效能
會因此而降低。
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Host I/F 標籤

1. 從 Change Controller Parameters 視窗，選擇 Host I/F 標籤。

2. 設定 Max Queued IO Count。 

此功能讓您可以從主機電腦以位元組為單位，設定控制器可接受的 I/O 佇列的 大大
小。預設值為 256。預先定義範圍為 1 至 1024 個位元組，也可以選擇 Auto Computer
( 自動設定 ) 模式。

3. 設定 LUNs Per Host。

此功能用於改變每個主機 SCSI ID 的 LUN 數量。預設設定為 32 個 LUN；預先定義的
可用 LUN 範圍為 1 至 32 個。

4. 重設控制器以使變更生效。
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Redundancy 標籤

1. 從 Change Controller Parameters 視窗，選擇 Redundancy 標籤。 

會顯示三個唯讀欄位：Controller Configuration、Controller Status 和 
Secondary Serial No。

2. 從 Set Controller Config 欄位選擇一個選項。 

■ Redundant Deassert Reset - 如果控制器故障，而且您要使其恢復連線。

■ Redundant Force Sec Fail - 如果您要強制次控制器故障。

■ Redundant Force Pri Fail - 如果您要強制主控制器故障。
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注意 – 須將兩個控制器都設定成 Redundant Primary 配置。然後控制器會決定主控制器
和次控制器。這避免了控制器之間可能發生的衝突。

3. 重設控制器以使變更生效。

4. 按一下 Close 返回主功能表。

Network 標籤

1. 從 Change Controller Parameters 視窗，選擇 Network 標籤。

2. 若要手動配置 IP 位址、子網路遮罩或閘道位址，請按一下 Change Settings。

3. 如果已在 DHCP/RARP 伺服器環境中安裝了陣列，可以選擇 Enable Dynamic IP 
Assignment，讓陣列自動從網路取得 IP 位址。 
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▼ 將控制器蜂鳴器設為靜音

當引起控制器發出蜂鳴聲的事件發生時 ( 例如邏輯磁碟機故障、重建期間或者新增 SCSI
磁碟機時 )，您可以用兩種方法中的一種將蜂鳴器設定為靜音。

1. 在主視窗選擇所需的控制器圖示。 

2. 選擇 Array Administration → Controller Maintenance。

3. 如果還沒有以 ssconfig 身份登入，會顯示要求輸入密碼的提示；請鍵入 ssconfig 的
密碼。 

顯示 Controller Maintenance Options 功能表。

4. 按一下 Mute Controller Beeper。

或者
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1. 在主視窗選擇所需的控制器圖示。 

2. 選擇 Configuration → Custom Configure。

3. 選擇 Change Controller Parameters。

4. 選擇 Mute Beeper。

▼ 指定或變更備用磁碟機

備用磁碟機作為後備用，在容錯 ( 非 RAID 0) 邏輯磁碟機中的實體磁碟機發生故障後，
用於支援自動資料重建。如果備用磁碟機要替代另一個磁碟機，其大小必須與故障磁碟
機的大小至少相等，而且與故障磁碟相關的所有邏輯磁碟機都必須是複式磁碟機 (RAID
1、3、5 或  1+0)。

您可使用該功能指定一個通用或本機備用磁碟機，也可將一個就緒的磁碟機狀態變更為
備用或將一個備用磁碟機的狀態變更為就緒。如現有磁碟機成員故障，指定為通用後備
的磁碟機將進行重建。可將一個或多個備用磁碟機與陣列控制器關聯起來。通用備份必
須被指定到一個特定邏輯磁碟機，且僅用於該邏輯磁碟機成員的重建。

1. 在主視窗中，選擇想要的陣列控制器。

2. 選擇 Configuration → Custom Configure 或按一下 Custom Configuration 工具。

如有必要，請使用 ssconfig 密碼登入程式的配置等級。顯示 Custom Configuration
Options 視窗。

3. 從 Custom Configuration Options 視窗，選擇 Make or Change Standby Drives。

顯示 Make or Change Standby Drives 視窗。
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4. 檢查視窗上方的伺服器和控制器 ID。

如果要選擇不同的伺服器或控制器，按一下 Cancel 返回主視窗，從樹狀檢視圖中選擇
正確的伺服器或控制器，並重複步驟 2 和 3。

5. 選擇要分配或變更的磁碟機。

6. 透過選擇 Ready、Global StandBy 或 StandBy for LD# ( 本機 ) 來變更或分配磁碟機
狀態。

7. 按一下 Modify。

8. 按一下 Apply，然後按一下 Close。

9. 無論何時變更配置，都請將新的配置儲存至檔案 ( 如需詳細資訊，請參閱第 85 頁 「配
置檔案」 )。 

可用伺服器
您有時可能需要從 Server List Setup 視窗的 Available 或 Managed Servers 清單編輯
或刪除項目。

▼ 編輯伺服器項目

1. 選擇 File → Server List Setup。顯示 Server Setup 視窗。 

如有必要，將伺服器名稱從 Managed Servers 清單中移到 Server List Setup 視窗的
Available Servers 清單中。注意，只有 Available Servers 清單中的伺服器項目才可以編
輯。
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2. 在 Available Servers 清單中選擇伺服器名稱，並按一下 Edit。 

顯示 Edit Server 視窗。 

 

192 Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



3. 根據需要變更。按一下 OK 登記變更。

如需這個視窗中各個欄位的說明，請參閱第 43 頁「新增伺服器」。Add Server 與 Edit
Server 視窗含有相同的欄位。 

IP Address 捷徑：如果網路位址已變更，按一下 Get IP Addr by Name。如果使用者鍵
入的伺服器名稱與其在網路使用的名稱服務所記錄的名稱相同，程式會進行搜索並顯示
正確的 IP 位址。 

如果伺服器使用的名稱與伺服器的網路名稱不同，或者命名服務尚未更新，刪除該伺服
器後再新增一次。

4. 將伺服器名稱移至 Managed Servers 清單。

5. 按一下 OK 離開 Edit Server 視窗。
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附錄 A

RAID 基本知識

本附錄提供有關 RAID 的背景資訊，包括 RAID 名詞術語概述和 RAID 等級。所涵蓋主
題如下：

■ 第 195 頁 「RAID 名詞術語概述」
■ 第 201 頁 「RAID 等級」
■ 第 207 頁 「本機和通用後備磁碟機」

RAID 名詞術語概述
獨立磁碟複式陣列 (RAID) 是一種用來增進儲存系統處理能力的儲存技術。這種技術的
主要目的是要在磁碟陣列系統中提供可靠性，並且充分運用多磁碟陣列優於單磁碟儲存
的效能優勢。

RAID 的兩項基本概念為： 

■ 將資料分散在多個硬碟上以增進效能。

■ 適當地使用多個磁碟機，如此在某一個磁碟機故障時不致損失資料，也不會造成系統
當機。

當某一個磁碟發生故障時，磁碟存取仍然能正常進行，主機系統不會察覺到這種故障情
況。
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邏輯磁碟機

邏輯磁碟機是一系列獨立實體磁碟機的陣列。藉由建立邏輯磁碟機，可以達成增進可用
性、容量和效能的目的。邏輯磁碟機在主機上的顯示與本機硬碟磁碟機相同。 

圖 A-1 包含多部實體磁碟機的邏輯磁碟機

邏輯磁碟區

邏輯磁碟區由兩個以上邏輯磁碟機組成；邏輯磁碟區 多可以分割成 32 個適用於 SCSI
的分割區，和 128 個適用於光纖通道的分割區。操作期間，主機將未分割的邏輯磁碟區
或邏輯磁碟區的分割區視為單一實體磁碟機。

本機後備磁碟機

本機後備磁碟機是分配用做單一指定之邏輯磁碟機的後備磁碟機。當指定之邏輯磁碟機
的某一成員磁碟機發生故障時，本機後備磁碟機就會成為成員磁碟機，並且自動開始重
建。

通用後備磁碟機

通用後備磁碟機不單只為一個指定的邏輯磁碟機服務。當任何邏輯磁碟機的成員磁碟機
發生故障時，通用後備磁碟機就會加入該邏輯磁碟機，並且自動開始重建。
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SCSI 通道

啟用 Wide 功能 (16- 位元 SCSI) 時，SCSI 通道 (SCSI 匯流排 ) 多可連接 15 個裝置 
( 不包括控制器本身 )。在一個迴圈中，光纖通道 多可以連接 125 個裝置。每個裝置都
具備一個唯一的 SCSI ID。

圖 A-2 說明這種概念。如果您要將檔案存放到機櫃中，必須先將檔案置於其中一個抽屜
中。從 SCSI 的觀點來看，SCSI ID 與機櫃類似，而抽屜就是 LUN ( 邏輯單元 )。每個
SCSI ID 多允許 32 個 LUN。資料可以儲存在 SCSI ID 的其中一個 LUN。大部分 SCSI
主機介面卡會將 LUN 視為另一項 SCSI 裝置。

圖 A-2 SCSI ID/LUN

邏輯磁碟機是由一組 SCSI 或者光纖通道磁碟機組成。在一個邏輯磁碟機中的實體磁碟
機不必來自同一個 SCSI 通道。同樣的，每一個邏輯磁碟機都可以設定為不同的 RAID
等級。
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磁碟機可以分配給一個指定的邏輯磁碟機做為本機後備磁碟機，或者做為通用後備磁碟
機。後備磁碟機不能用於沒有資料備份的邏輯磁碟機 (RAID 0)。 

圖 A-3 邏輯磁碟機配置中的磁碟機分配

磁碟機通道 0

邏輯磁碟機 1

通用後備磁碟機 LD1 的本機後備磁碟機

邏輯磁碟機 0

磁碟機通道 1

4
GB

4
GB

2
GB

2
GB

4
GB

4
GB

2
GB

2
GB

ID5 ID0

ID6 ID1 ID0 ID14

ID3 ID2

RAID 5
8 GB

RAID 3
6 GB
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您可以將邏輯磁碟機或者邏輯磁碟區分為幾個分割區，或者將整個邏輯磁碟機當作單一
的分割區來使用。

圖 A-4 邏輯磁碟機配置中的分割區

每一個分割區都會對應到主機 SCSI ID 或主機通道上 ID 之下的 LUN。每個 SCSI
ID/LUN 對於主機來說，相當於一個獨立的硬碟機。

邏輯磁碟機 0

RAID 5 (8 GB)

邏輯磁碟機 1

RAID 3 (6 GB)

分割區 0 2 GB

分割區 1 1 GB

分割區 2 5 GB

分割區 0 2.5 GB

分割區 1 1.5 GB

分割區 2 2 GB
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圖 A-5 將分割區對應至主機 ID/LUN

圖 A-6 將分割區對應至 ID 下的 LUN

ID 0 ID 1

LUN 0 LUN 0

LUN 1 LUN 1

LUN 2 LUN 2

邏輯磁碟機 1
分割區 0

邏輯磁碟機 0
分割區 1

邏輯磁碟機 1
分割區 2

邏輯磁碟機 0
分割區 2

邏輯磁碟機 1
分割區 1

邏輯磁碟機 0
分割區 0

2.5 GB

1 GB

5 GB

1.5 GB

2 GB

2.5 GB

ID 0

LUN 0LUN 1LUN 2LUN 3LUN 4LUN 5

邏輯磁碟機 0 邏輯磁碟機 1

主機 SCSI 通道

邏輯磁碟機 1

邏輯磁碟機 1
分割區 0

邏輯磁碟機 0
分割區 2

邏輯磁碟機 0
分割區 0

分割區 1分割區 1 分割區 2

4.5 GB 5 GB 2 GB

1 GB 1.5 GB 2 GB
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RAID 等級
有幾個應用 RAID 陣列的方式；例如使用鏡像、分割、雙工處理和同位等技術的各種組
合。這些不同的技術一般稱為 RAID 等級。每一種等級都會提供一種效能、可靠性與成
本的組合效果；每一種等級也會使用截然不同的演算法來執行容錯。

這裡有幾種 RAID 等級選擇：RAID 0、1、3、5、1+0、3+0 (30) 和 5+0 (50)。RAID 等
級 1、3 和 5 是 常使用的等級。

下表提供了 RAID 等級的簡略概述。 

容量是指可用於資料儲存的實體磁碟機總數 (N)。例如，如果容量為 N-1，而邏輯磁碟
機中的磁碟機總數為 6 個 36 MB 磁碟機，那麼可用於儲存的磁碟空間就等於 5 個磁碟
機 - (5 x 36 MB 或 180 MB)。這裡的 -1 是指在 6 個磁碟機上分割的總量，它是用來提
供資料備份，大小等於一個磁碟機。 

表 A-1 RAID 等級概述 

RAID 等級 說明 支援的磁碟機數量 容量 備份

0 分割 2-36 N 否

1 鏡像 2 N/2 是

1+0 鏡像和分割 4-36 ( 限偶數 ) N/2 是

3 具有專屬同位檢查
的分割

3-31 N-1 是

5 具有分散式同位檢
查的分割

3-31 N-1 是

3+0 (30) RAID 3 邏輯磁碟機
的分割

2-8 個邏輯磁碟機 N- 邏輯磁碟機
的數量

是

5+0 (50) RAID 5 邏輯磁碟機
的分割

2-8 個邏輯磁碟機 N- 邏輯磁碟機
的數量

是
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對於 RAID 3+0 (30) 和 5+0 (50)，容量是指實體磁碟機總數 (N) 針對磁碟區中每一個
邏輯磁碟機減去一個實體磁碟機 (#)。例如，假如邏輯磁碟機中的磁碟機總數為 20 個 
36 MB 磁碟機，而邏輯磁碟機總數為 2，那麼可用於儲存的磁碟空間就等於 18 個磁碟機
- 18 x 36 MB (648 MB)。

RAID 0
RAID 0 會執行區塊分割，其中的資料會分成多個邏輯區塊，並且分散到不同的磁碟機
上。與其他 RAID 等級的不同在於，它沒有備份的功能。萬一磁碟機發生故障，資料就
會遺失。

在區塊分割中，磁碟機總容量等於陣列中所有磁碟機容量的總和。這種磁碟機組合在系
統上會顯示為單一邏輯磁碟機。

RAID 0 可以提供 高的效能。因為資料可以同時在陣列中的每一個磁碟機往返傳輸，所
以速度快。此外，也可以同時進行處理讀取 / 寫入不同磁碟機的作業。

圖 A-7 RAID 0 配置

邏輯磁碟機

實體磁碟機

分割

區塊 1

區塊 2

區塊 3

區塊 5

區塊 7

區塊 1區塊 3

區塊 4

區塊 5

區塊 6

區塊 7

區塊 8

區塊 4

區塊 6

區塊 8

區塊 2
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RAID 1
RAID 1 會執行磁碟鏡像，相同資料的副本會記錄在兩個磁碟機上。在不同的磁碟上保
存資料副本，可以防止磁碟故障以保謢資料。萬一 RAID 1 陣列中的某一個磁碟機故障，
其餘的可用磁碟機 ( 副本 ) 仍然可以提供所有需要的資料，因此可以避免當機的情況。

在磁碟鏡像中，可用的總容量等於 RAID 1 陣列中一個磁碟機的容量。因此，假如組合
兩個 1 GB 磁碟機來建立一個單一邏輯磁碟機，可用的總容量則為 1 GB。這種磁碟機組
合在系統上會顯示為單一邏輯磁碟機。

注意 ñ RAID 1 不能進行擴充。RAID 等級 3 和 5 則可藉由新增磁碟機到現有陣列進行
擴充。

圖 A-8 RAID 1 配置

這個 RAID 等級除了擁有 RAID 1 提供的資料保護之外，也會增進效能。發生多重同時
I/O 的情況時，該 I/O 動作可以分散到各磁碟機副本，因而降低了有效資料存取的總時
間。

邏輯磁碟機

實體磁碟機

區塊 1

區塊 2

區塊 3

區塊 4

區塊 5

區塊 6

區塊 7

區塊 8

區塊 2

區塊 3

區塊 4

區塊 1

區塊 2

區塊 3

區塊 4

區塊 1
鏡像
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RAID 1+0

RAID 1+0 結合了 RAID 0 和 RAID 1，以提供鏡像和磁碟機分割。使用 RAID 1+0 是一
種能夠節省時間的功能，可以讓您僅使用一個步驟來配置大量磁碟機供鏡像之用。它不
是可以選擇的標準 RAID 等級選項；它不會出現在控制器支援的 RAID 等級選項清單
中。如果為 RAID 1 邏輯磁碟機選擇四個以上的磁碟機，會自動執行 RAID 1+0。

圖 A-9 RAID 1+0 配置

實體磁碟機

鏡像

分割

鏡像

邏輯磁碟機

區塊 1

區塊 2

區塊 3

區塊 4

區塊 5

區塊 6

區塊 7

區塊 8

區塊 2

區塊 3

區塊 4

區塊 1

區塊 2

區塊 3

區塊 4

區塊 1

區塊 6

區塊 7

區塊 8

區塊 5

區塊 6

區塊 7

區塊 8

區塊 5
204  Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



RAID 3
RAID 3 會執行具有專屬同位檢查的區塊分割。這個 RAID 等級會將資料區分為邏輯區
塊 ( 相當於磁碟區塊的大小 )，然後在各個磁碟機上分割這些區塊。有一個磁碟機是同位
檢查專用的磁碟機。萬一發生磁碟故障時，就可以利用同位檢查資訊和其他磁碟上的資
訊重建原始資料。

在 RAID 3 中，磁碟機總容量等於所有磁碟機容量的總和 ( 同位檢查磁碟機除外 )。因此，
假如組合四個 1 GB 磁碟機來建立一個單一邏輯磁碟機，可用的總容量則為 3 GB。這種
組合在系統上會顯示為單一邏輯磁碟機。

當以小區塊或循序方式讀取資料時，RAID 3 可以提供更快的資料傳輸速率。但是在不
需擴及每個磁碟機的寫入作業中，效能反而會降低，因為儲存在同位檢查磁碟機上的資
訊在每次寫入新資料時都必須重新計算並且重新寫入，無法進行同時 I/O。

圖 A-10 RAID 3 配置

邏輯磁碟機

區塊 1

區塊 2

區塊 3

區塊 1

分割

同位檢查 (1,2)

同位檢查 (3,4)

實體磁碟機

專屬同位檢查

區塊 3

區塊 4

區塊 5

區塊 6

區塊 7

區塊 8

區塊 7

區塊 5

區塊 4

區塊 2

區塊 8

區塊 6 同位檢查 (5,6)

同位檢查 (7,8)
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RAID 5
RAID 5 會執行具有分散式同位檢查的多區塊分割。這個 RAID 等級可以提供備份能力，
而且同位檢查資訊分散在陣列中所有磁碟上。資料及其同位檢查絕不會儲存同一個磁碟
上。萬一發生磁碟故障時，就可以利用同位檢查資訊和其他磁碟上的資訊重建原始資料。

圖 A-11 RAID 5 配置

以大區塊或隨機方式讀取資料時，RAID 5 可以提供更快的資料傳輸速率，並且可以在
有許多同時 I/O 循環的情況時，降低資料的存取時間。

邏輯磁碟機 實體磁碟機

分割 + 非專屬同位檢查

區塊 1

區塊 2

區塊 3

區塊 4

區塊 5

區塊 6

區塊 7

區塊 8

區塊 4

區塊 1

區塊 7

同位檢查 (5,6)

同位檢查 (3,4)

區塊 2

區塊 8

區塊 5

同位檢查 (3,4)

區塊 3

區塊 6

同位檢查 (7,8)
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進階的 RAID 等級

進階的 RAID 等級需要使用陣列的內建磁碟區管理員。這些 RAID 等級的組合可以提供
RAID 1、3 或 5 的保護優點，同時具有 RAID 1 的效能。如果要使用進階的 RAID，首
先要建立兩個以上 RAID 1、3 或 5 陣列，然後將它們聯結起來。下表提供了進階 RAID
等級的說明。

本機和通用後備磁碟機
外部 RAID 控制器可以提供本機後備磁碟機和通用後備磁碟機功能。本機後備磁碟機只
能使用於一個指定的磁碟機；而通用後備磁碟機則可使用於陣列上的任何邏輯磁碟機。 

本機後備磁碟機的優先順序一定高過通用後備磁碟機。因此，如果磁碟機故障而兩種類
型的後備磁碟機同時都可以使用時，或需要更大的大小來更換故障的磁碟機時，就會使
用本機後備磁碟機。

如果 RAID 5 邏輯磁碟機中有故障磁碟機，則可以將故障磁碟機更換為新的磁碟機，使
邏輯磁碟機能夠繼續工作。如果要找出故障的磁碟機，請參閱陣列的 《Sun StorEdge
3000 Family RAID Firmware User's Guide》。

小心 – 如果您在嘗試移除故障磁碟機時，移除了錯誤的磁碟機，將無法存取邏輯磁碟機，
因為您已經錯誤地造成另一台磁碟機發生故障。

本機後備磁碟機是分配用做單一指定之邏輯磁碟機的後備磁碟機。當指定之邏輯磁碟機
的某一成員磁碟機發生故障時，本機後備磁碟機就會成為成員磁碟機，並且自動開始重
建。

表 A-2 進階的 RAID 等級

RAID 等級 說明

RAID 3+0 (30) 使用陣列內建磁碟區管理員聯結在一起的 RAID 3 邏輯磁碟機。

RAID 5+0 (50) 使用陣列的磁碟區管理員聯結在一起的 RAID 5 邏輯磁碟機。
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本機後備磁碟機的優先順序必定高於通用後備磁碟機；換言之，如果有磁碟機故障，而
且本機後備磁碟機和通用後備磁碟機都可以使用時，則必定會使用本機後備磁碟機。 

圖 A-12 本機 ( 專用 ) 後備磁碟機

通用後備磁碟機可用於所有的邏輯磁碟機，而非僅服務一個邏輯磁碟機 ( 請參閱
圖 A-13)。當任一邏輯磁碟機的成員磁碟機發生故障時，通用後備磁碟機就會加入該邏
輯磁碟機，並且自動開始重建。

本機後備磁碟機的優先順序必定高於通用後備磁碟機；換言之，如果有磁碟機故障，而
且本機後備磁碟機和通用後備磁碟機都可以使用時，則必定會使用本機後備磁碟機。 

圖 A-13 通用後備磁碟機

本機後備磁碟機

邏輯磁碟機 0

通用後備磁碟機

邏輯磁碟機 1 邏輯磁碟機 2

通用後備磁碟機
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同時擁有本機和通用後備磁碟機

在圖 A-14 中，邏輯磁碟機 0 中的成員磁碟機為 9 GB 磁碟機，而邏輯磁碟機 1 和 2 中
的成員磁碟機都是 4 GB 磁碟機。 

圖 A-14 本機和通用後備磁碟機混合

本機後備磁碟機的優先順序必定高於通用後備磁碟機；換言之，如果有磁碟機故障，而
且本機後備磁碟機和通用後備磁碟機都可以使用時，則必定會使用本機後備磁碟機。 

在圖 A-14 中，無法讓 4 GB 的通用後備磁碟機加入邏輯磁碟機 0，因為它的容量不足。
萬一邏輯磁碟機 0 故障，9 GB 的本機後備磁碟機會協助這個邏輯磁碟機。如果故障的磁
碟機是在邏輯磁碟機 1 或 2 中，則 4 GB 的通用後備磁碟機會立即協助故障的磁碟機。

本機後備磁碟機 通用後備磁碟機

(4GB)(9GB)

(9GB)

(9GB)

(4GB)

(4GB)

(4GB)

邏輯磁碟機 0 邏輯磁碟機 1 邏輯磁碟機 2

(9GB)
(4GB)

(4GB)(4GB)
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附錄 B

監控 JBOD ( 僅適用於 SCSI)

本附錄說明如何僅針對 Sun StorEdge 3310 SCSI Array 監控韌體並將韌體下載到獨立
的 JBOD。請注意，並不是所有的陣列功能都支援 JBOD。本附錄包含下列步驟：

■ 第 211 頁 「啟用 JBOD 支援」
■ 第 213 頁 「檢視元件和警報特性」
■ 第 214 頁 「升級硬碟上的韌體」
■ 第 215 頁 「升級 SAF-TE 裝置的韌體」
■ 第 216 頁 「更換故障的磁碟機」

▼ 啟用 JBOD 支援

若要對 JBOD 的周邊裝置狀況和事件進行監控，必須先啟用 JBOD 支援。 

1. 選擇 View → Agent Options Management。 

顯示 Agent Options Management 視窗。

2. 選取 Enable JBOD Support 核取方塊。

3. 若要立即在主視窗中顯示 JBOD，必須探尋新的庫存。選擇 View → View Server，
然後按一下 Probe。

4. 按一下 OK。 

JBOD 會顯示在主視窗中。

在單匯流排配置中，JBOD 的兩個連接埠都會連接到伺服器上的同一個 HBA，如下列範
例所示。
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在雙匯流排配置中，每個連接埠會連接到自己的 HBA，如下列範例所示。

注意 – 在雙匯流排配置中，如果每個連接埠都連接到不同的伺服器，則程式只可以對連
接到連接埠 B 的伺服器的 JBOD 進行監控。
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▼ 檢視元件和警報特性

View Enclosure 視窗會顯示 JBOD 的元件和警報特性。

1. 選擇 EMU (SCSI) 或 SES ( 光纖通道 ) 圖示 。

2. 選擇 View → View Enclosure。

若要顯示 FRU ID 資訊，按一下 View FRU。
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下載用於裝置的韌體
這個選項讓您可以升級 JBOD 上的硬碟磁碟機和 SAF-TE 裝置上的韌體。

▼ 升級硬碟上的韌體

1. 選擇任一 JBOD 元件。

2. 選擇 Array Administration → Download FW for Devices。

3. 按一下 Download FW for Disks 標籤。

4. 從 Available Disks 選擇要下載新韌體的磁碟機，然後按一下 Add。

如果有要刪除的邏輯磁碟機，從 Selected Disks 選擇磁碟機，然後按一下 Remove。
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5. 按一下 Browse 並找到下載韌體檔案。選擇檔案，按一下 Open，然後按一下 OK。

開始下載韌體。

6. 當進度達到 100% 時，按一下 OK。

7. 若要更新程式，選擇 View → View Server。

8. 按一下 Probe，然後按一下 OK。

9. 若要確認韌體是否已成功下載，選擇 View → View Physical Drive，並確保在 Product
Revision 欄位中的韌體版本已變更。

▼ 升級 SAF-TE 裝置的韌體

1. 選擇任一 JBOD 元件。

2. 選擇 Array Administration → Download FW for Devices。

3. 按一下 Download FW for SAFTE Devices 標籤。

4. 若要新增裝置，從 Available SAF-TE Devices 中選擇裝置，然後按一下 Add。

若要刪除裝置，從 Selected SAF-TE Devices 中選擇裝置，然後按一下 Remove。
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5. 按一下 Browse 並找到下載韌體檔案。選擇檔案，按一下 Open，然後按一下 OK。 

開始下載韌體。

陣列開始發出嗶聲，並在達到大約 70% 時 LED 指示燈開始閃爍。

6. 當進度達到 100% 時，按一下 OK。

7. 若要更新程式，選擇 View → View Server，然後按一下 Probe。

8. 按一下 OK。

9. 若要確認韌體是否已成功下載，選擇 View → View Enclosure，並確保在 Firmware Rev
欄位中的韌體版本已變更。

▼ 更換故障的磁碟機

紅色的裝置狀態符號表示磁碟機故障 。在更換故障的磁碟機後，請執行下列步驟： 

Solaris 作業環境

1. 如果磁碟機自動返回線上狀態 ( 即紅色裝置狀態符號消失 )，則執行指令 

2. 執行指令

3. 如果磁碟機沒有自動返回線上狀態 ( 即紅色裝置狀態符號沒有消失 )，則透過執行下列
指令，進行重新配置重新啟動

# devfsadm

# format

# reboot -- -r
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Windows NT/2000 作業系統

1. 請依照陣列的《Sun StorEdge 3000 Family 安裝、操作和維修手冊》中的指示，安裝新
的磁碟機。

2. 選擇 View → View Server，然後按一下 Rescan。

3. 若要確認程式已識別新的磁碟機，請在主視窗選擇該磁碟機。

4. 選擇 View → View Physical Drive，然後確認資訊。
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附錄 C

使用叢集配置 ( 僅適用於 SCSI)

就 Sun StorEdge 3310 SCSI Array 而言，如果您使用的是 Windows NT，Sun StorEdge
Configuration Service 可以監控共用的 SCSI 儲存裝置。本單元包含以下主題：

■ 第 219 頁 「規劃叢集配置」
■ 第 220 頁 「叢集配置要求」

■ 第 220 頁 「設定叢集配置」
■ 第 220 頁 「設定叢集配置」

首先，叢集配置必須與適當的硬體一起設定，另外，還要有具備 Service Pack 3 或 4 的
Windows NT Server Enterprise Edition 和 Microsoft Cluster Server (MSCS) 軟體。

如果您準備設定叢集配置，請確保已閱讀本章。

規劃叢集配置
在設定叢集配置前，必須決定所需的配置類型，因為會影響儲存裝置的初始設定方式。

有兩種主要叢集配置類型： 

■ 熱備用伺服器叢集，該處的所有 LUN 屬於叢集上兩個伺服器的其中一個。如果伺服
器發生 LUN 故障，則 LUN 會移至第二台伺服器，該伺服器在此之前閒置。該配置
要求 少兩個 LUN。

■ 負載平衡叢集，其中某些 LUN 是在一個伺服器上維護，而某些 LUN 則在另一個伺
服器上維護。兩台伺服器同時處理資料，但是在不同的 LUN 上處理 I/O。 

必須 少定義三個 LUN。這允許建立一個小的 LUN 供仲裁磁碟使用，建立一個大的
LUN 供叢集中的每一台伺服器使用。萬一伺服器發生故障，仲裁磁碟會維護恢復叢集必
須的配置資料。
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叢集配置要求
在安裝 MSCS 軟體時，請識別要做為仲裁磁碟使用的磁碟，用來維護叢集資訊。

在叢集配置中，程式某一時間只能在一台伺服器上運行，即有仲裁磁碟的伺服器。如果
執行 Sun StorEdge Configuration Service 的伺服器故障，Cluster Administrator 會自
動將第一台伺服器的磁碟負載變更到第二台伺服器，並在第二台伺服器上啟動服務。

在兩台伺服器的叢集配置上，叢集本身具有自己的 IP 位址，會在 Managed Server 清單
上成為受管理的伺服器。將叢集新增到 Managed Server 清單，以做為完成叢集設定的

後一步。

▼ 設定叢集配置

以下是如何在具有兩台主機伺服器的叢集配置上設定陣列的步驟概述。

1. 安裝伺服器。

a. 安裝兩台伺服器，每台都具有 PCI 匯流排和啟動磁碟，磁碟不是共用 SCSI 儲存的一
部分。

b. 在每台伺服器上安裝主機介面卡 ( 如 Ultra-Wide、差異主機介面卡 )，並為共用 SCSI
匯流排上的每個主機介面卡設定唯一的 SI ID。

c. 在每台伺服器上安裝兩張網路介面卡。

d. 在每台伺服器的啟動磁碟上安裝 Windows NT Server、Enterprise Edition 軟體和
Windows NT Service Pack 3 ( 含 ) 以後版本。

2. 安裝雙現用儲存子系統，且將其連接到兩張主機介面卡。 

若需安裝步驟的相關資訊，請參閱提供的文件。
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3. 在每台伺服器上安裝代理程式。 

a. 在另一台伺服器上安裝服務之前，先停止在這台伺服器上的服務。 

b. 請確保服務已在伺服器上執行，且該伺服器可以存取對應至指定主控制器之邏輯磁碟
機上的主機 LUN。

c. 如需安裝代理程式的特定步驟，請參閱有關的安裝章節。 

安裝代理程式後，不需要重新啟動電腦。然而，安裝代理程式之後，請務必在其中一
台伺服器上停止服務。

注意 – 以下幾個步驟中，將如範例所示只使用一台伺服器工作。

4. 安裝主控台軟體。

您可以在其中一台伺服器或者伺服器所在網路中的任一電腦上安裝主控台。程式讓您可
以以遠端方式配置和監控陣列。如需詳細的步驟，請參閱適當的安裝章節。

5. 將已啟動服務的伺服器新增到 Managed Servers 清單中 ( 請參閱第 43 頁 「新增伺服
器」 )。 

請務必選擇 Auto Discovery 並新增 ssmon 密碼。

6. 使用主控台軟體來驗證和配置現用伺服器上的儲存裝置，然後重新啟動伺服器。

儲存裝置陣列可能已經在雙現用儲存子系統上預先設定了。您必須查看樹狀檢視圖中的
配置，以確定配置是否存在。

如果儲存未設定或者希望變更配置，則設定一台伺服器上的所有 LUN。然後，在 MSCS
軟體安裝後，可以使用 Cluster Administrator 伺服器之間分配儲存設備。

7. 使用 NT Disk Administrator，在現用伺服器上建立分割區和格式化 LUN。 

a. 如有必要，重新分配磁碟的磁碟機代號。 

請注意，必須以 NTFS 格式化分割區。

Windows NT 將雙現用控制器上的 LUN 視為在叢集中的兩台伺服器上。您可以只在
一台伺服器上建立分割區和邏輯磁碟機。安裝 MSCS 後，就可以使用 Cluster
Administrator 來分配伺服器間的儲存設備。

用於兩個磁碟機的共用 SCSI 儲存設備的磁碟機代號必須相同。如果有其他的光碟機
或外部硬碟在一台伺服器上，可能需要為共用儲存設備重新指定磁碟機代號。完成該
步驟後，檢查其他伺服器上的代號，以確保它們是相同的。

b. 寫下指定給共用儲存設備的磁碟機代號。
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8. 存取第二台伺服器，啟動 Disk Administrator，並確定第二台伺服器與第一台伺服器的
磁碟機代號相同。 

如果不是，重新分配磁碟機代號，使它們在兩台伺服器上一致。

9. 關閉第二台伺服器。

10. 在第一台伺服器上安裝 MSCS 軟體並重新啟動。 

11. 啟動 Cluster Administrator，並確保可以看到叢集。

12. 存取第二台伺服器，透過將其連接到第一台伺服器來安裝 MSCS，然後重新啟動。

13. 重新啟動第二台伺服器，並在 Cluster Administrator 中確認兩台伺服器都包含在叢集
中。

14. 在 Cluster Administrator 中調整磁碟群組。 

請確保仲裁磁碟和其他磁碟，是否全部都在原來設定該儲存設備的第一台伺服器下的一
磁碟群組中。若需執行該步驟的詳細資訊，請參閱 MSCS 文件。

注意 – 只要將兩個 LUN 置於同一個磁碟群組中，將會得到一個可刪除的空磁碟群組。

15. 將服務新增到第一台伺服器上有仲裁磁碟的群組中。

a. 在兩台伺服器上，停止三項服務中的每一項，即 Configuration Service Startup、
Configuration Service Monitor 和 Configuration Service Server，並將它們設定
為手動。

b. 使用 Cluster Administrator 將每個服務作為資源安裝到具有仲裁磁碟的群組中。 

以下面的順序輸入每個服務，並按照指定格式鍵入其名稱 ( 兩個字在一起 )。安裝完
每一項服務後，請將服務恢復連線，以在現用伺服器上啟動服務。

輸入服務，作為一般服務。系統會要求您指出每項資源的相關性。群組中的相關性如
下：

■ 與仲裁磁碟相關的磁碟
■ 其他磁碟 ( 如果要新增至該群組 )
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup 依賴於已在群組中的兩張磁碟。Configuration 
ServiceMonitor 依賴於 Configuration Service Startup，而 Configuration 
ServiceServer 依賴於 Configuration Service Monitor。
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16. 為了使兩個叢集伺服器在叢集 IP 位址下顯示為一個圖示，請編輯 CLUSTER.TXT。

檔案的目錄與主控台檔案相同，位於安裝主控台的電腦系統磁碟機上。如果磁碟機 C 是
系統磁碟機，則路徑為：

C:\Program Files\Sun\sscs

以下文字說明檔案的內容：

17. 編輯檔案的 後一行，插入叢集的 IP 位址，然後插入構成叢集的兩個伺服器的 IP 位址。 

a. 移除數字符號 (#)。

18. 啟動主控台，並將第一台伺服器從 Managed Servers 清單中刪除，然後將叢集作為一
台伺服器新增到清單。

19. 存取 Server List Setup 功能。請參閱第 43 頁 「新增伺服器」。

請務必選擇 Auto Discovery，並新增 ssmon 密碼。如果鍵入叢集名稱，在網路具有
DNS 的情況下，程式會提供 IP 位址。

此時，叢集配置已正確設定為能與程式一起運作。如果執行服務的伺服器發生故障，它
的磁碟群組會轉移至第二台伺服器，而且 Cluster Administrator 會自動啟動第二台伺服
器上的服務。

注意 – 如果一台伺服器發生故障，主控台的叢集圖示只要在 15 分鐘內便會由紫色變為灰
色，且可能在 10 分鐘後再變回紫色。

如果希望某些在其他伺服器上執行的儲存設備具有負載平衡配置，必須使用 Cluster
Administrator 將一個或多個磁碟群組移至其他的伺服器。

#Edit this file to map the NT cluster IP address to several
#servers constituting the cluster.
#The format of the entry is:
#<Cluster IP Address>=<server1 IP Address>:<server2 IP Address>
#The IP address must be in dot form.
#Example:If the cluster IP address is 151.239.130.70 and the
#IP addresses of individual servers are 151.239.130.71 and
#151.239.130.72,the entry would be:
# 151.239.130.70=151.239.130.71:151.239.130.72
#
#IMPORTANT NOTE:
#Use only the Cluster IP address to configure an NT cluster
#server on the Configuration Service console.
#
#151.239.130.70=151.239.130.71:151.239.130.72
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附錄 D

判斷主機世界通用名稱 ( 僅適用光纖通道 )

本附錄說明如何判斷主機的世界通用名稱 (World Wide Name，WWN)、世界通用節點
名稱 (World Wide Node Name，WWNN)，以及陣列的世界通用通訊埠名稱 (World
Wide Port Name，WWPN)。步驟包含：

■ 第 225 頁 「判斷 WWN」
■ 第 227 頁 「判斷 WWNN」
■ 第 228 頁 「判斷 WWPN」

▼ 判斷 WWN
使用 LUN 篩檢程式功能之前， 好能辨別哪個 Sun StorEdge 3510 FC Array 連接到哪
個 HBA 卡，以及指定給每張卡的世界通用名稱。

Solaris 作業環境

1. 如果您的電腦安裝了新的 HBA 裝置，請重新啟動電腦。

2. 鍵入下列指令

# luxadm probe
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3. 向下捲動清單，查看光纖通道裝置及相關的世界通用名稱。

Linux 及 Windows NT/2000 

1. 啟動特定的主機，記下 BIOS 版本和連接到主機的 HBA 卡型號。 

2. 使用適當的指令 ( 通常使用 alt-q 或 control-a) 存取 HBA 卡的 BIOS。 

如果主機有數張 HBA 卡，請選擇連接到儲存裝置的卡。 

3. 掃描這張卡，查看其所連接的裝置 ( 通常使用 Scan Fibre Devices 或 Fibre Disk 公用
程式 )。

節點名稱 ( 或類似的標籤 ) 就是世界通用名稱。

以 Qlogic 卡為例：

ID 供應商  產品 版本 節點名稱 連接埠 ID

0 Qlogic QLA22xx Adapter B 210000E08B02DE2F 0000EF
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▼ 判斷 WWNN
1. 請按兩下 Configuration Service 主視窗中的陣列圖示 ，或選擇它並選擇 

View → View Controller。

節點名稱會顯示在 View Controller Configuration 視窗的 Node name 欄位中。

注意 –WWNN 資訊也包含於控制台產生的 xml 報告中。
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▼ 判斷 WWPN
1. 請按兩下 Configuration Service 主視窗中的陣列圖示 ，或選擇它並選擇 

View → View Controller。

2. 按一下 View Controller Parameters。

顯示 RAID Controller Parameters 視窗。在 Channel 標籤上，向右捲動以顯示 WWPN。

注意 –WWPN 資訊也包含於控制台產生的 xml 報告中。
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附錄 E

電子郵件和 SNMP

Sun StorEdge Configuration Service 具備完整的事件監控和電子郵件通知能力。主控台
可以將 SMTP 電子郵件訊息傳送到指定的電子郵件位址清單。可以對諸如 Microsoft
Exchange 等電子郵件系統進行設定或編寫指令碼，以根據事件的不同呼叫管理人員。某
些呼叫服務還可以將電子郵件訊息傳送到呼叫器。

代理程式會將事件記入作業環境的錯誤日誌。代理程式也會將有關大量儲存事件的
SNMP 陷阱傳送給企業管理主控台，例如，HP OpenView。如需使用 SNMP 之監控軟
體的清單，請到 Sun Management Center，網址是
http://wwws.sun.com/software/solaris/sunmanagementcenter/。

本附錄說明如何設定主控台以傳送電子郵件訊息。也說明如何配置伺服器將陷阱傳送到
SNMP 管理主控台，並且描述了陷阱格式，提供有關 SNMP 的背景資訊。此外，還會
討論在不需要 Sun StorEdge Configuration Service 的情況下傳送 SNMP 陷阱的其他方
法。本章涵蓋下列主題：

■ 第 230 頁 「為每台伺服器傳送電子郵件訊息」
■ 第 230 頁 「為每台伺服器傳送電子郵件訊息」

■ 第 233 頁 「設定伺服器以傳送陷阱」
■ 第 233 頁 「檢查社群字串」
■ 第 235 頁 「指定陷阱接收者」
■ 第 236 頁 「設定 Solaris 作業環境伺服器」
■ 第 236 頁 「設定 Linux 作業環境伺服器」

■ 第 237 頁 「SNMP 的運作方式」
■ 第 241 頁 「不使用 Sun StorEdge Configuration Service 而傳送 SNMP 陷阱」
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為每台伺服器傳送電子郵件訊息
透過 Server List Setup 功能配置主控台，以便為每台管理伺服器傳送電子郵件訊息。

▼ 為每台伺服器傳送電子郵件訊息

1. 選擇 File → Server List Setup。 

顯示 Server Setup 視窗。 

 

2. 按一下 Add。

如果已新增伺服器，則必須將伺服器移動至 Available Servers 清單，然後按一下 Edit。

顯示 Add Server 視窗或 Edit Server 視窗。這兩個視窗有相同的欄位。
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3. 如果尚未新增伺服器，則應在 Properties 標籤中填入資訊。  

如需詳細資訊，請參閱第 44 頁 「加入伺服器：」。

4. 若要使用電子郵件傳送事件訊息，請選擇 Mailing Lists 標籤。 

顯示 Add Server 視窗，其中已選取 Mailing Lists 標籤。
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a. 對於每一個使用者，將電子郵件位址鍵入 Mail Address 欄位中。

b. 在 Severity 清單方塊中，捲動清單並選擇所需的項目。

c. 按一下 Add to List。 

若要從清單中刪除使用者，選擇郵件地址並按一下 Delete from List。

d. 指示郵件伺服器。按一下 Setup Mail Server。 

顯示 Mail Server Setup 視窗。 

 

鍵入簡單郵件傳輸通訊協定 (SMTP) 郵件伺服器的 IP 位址或名稱 ( 該伺服器會將電
子郵件訊息傳送給先前指定的目標位址 )。

e. 如果對 Mail Server 視窗中的資訊感到滿意，則按一下 OK。 

顯示 Add Server 或 Edit Server 視窗。

5. 如果對 Add Server 或 Edit Server 視窗中的資訊感到滿意，則按一下 OK。 

顯示 Server Setup 視窗。

6. 如果要新增其他伺服器，則為每台伺服器重複步驟 2 到 5。

7. 必要時，將一台或多台希望由該主控台控制的伺服器移動至 Managed Servers 清單。 

如果正在編輯伺服器，必須將其移回 Available Servers 清單。

8. 按一下 OK 返回主視窗。
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設定伺服器以傳送陷阱
如果在網路上擁有企業管理主控台 ( 例如 HP OpenView 或 IBM NetView 等 )，則可以
配置伺服器，將有關事件的陷阱傳送到主控台。本節說明了所需的配置步驟。

注意 – 如果您希望將 SNMP 陷阱傳送到其他的企業管理主控台，才需要遵循本節中的指
示。

小心 – 如果 HP OpenView 安裝在設定為傳送陷阱的同一個伺服器上，為避免初始化錯
誤，必須重新配置系統資源。如需更多有關重新配置系統資源的指示，請參閱疑難排解
項目 - 第 248 頁 「徵兆：HP OpenView 無法安裝或陷阱協助程式無法啟動。」。

Windows NT 伺服器

若要將 Windows NT 伺服器配置為將 SNMP 陷阱傳送到一個或多個企業管理主控台，
必須在伺服器上配置每一個 SNMP 服務，以確保：

■ 伺服器列出企業管理主控台的社群字串或者社群名稱。

■ 伺服器列出作為從 Windows NT 代理軟體的陷阱接收器的企業管理主控台。

▼ 檢查社群字串

可以使用預設社群名稱或 public 的社群字串。但是，選擇 public 以外的社群名稱能夠
增加安全性，因為它將通訊限制到具有指定社群字串的電腦。

若要為 Windows NT 4.0 設定社群字串：
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1. 若未選擇該選項，則在 Control Panel 視窗中，按兩下 Network 圖示，然後按一下
Services 標籤 ( 如果尚未選取 )。

在 Network Services 清單，捲動至 SNMP 服務，按一下以選取該項目，然後按一下
Properties。 

顯示 Microsoft SNMP Properties 視窗。

注意 – 如果未安裝 SNMP 服務，透過按一下 Network 視窗中的 Add，可以安裝該服務。
Select Network Service 視窗便會顯示，可以從中選擇 SNMP 服務。您必須插入
Windows NT 4.0 CD，以便讓電腦複製 SNMP 服務需要的檔案。

2. 在 Microsoft SNMP Properties 視窗中按一下 Security 標籤，以顯示 Security 設定。

3. 確保要用於伺服器的社群名稱或者社群字串已在 Accepted Community Names 清單中
指定。

如果名稱尚未在清單中，按一下 Add 以顯示 Service Configuration 視窗。在輸入欄位
中鍵入新名稱並按一下該視窗中的 Add。顯示 Security 標籤，其中新名稱出現在
Accepted Community Names 清單上。

注意 – 社群名稱或社群字串有區分大小寫。

4. (選擇性) 如果需要，將 Accept SNMP Packets from Any Host 的預設設定變更為 Only
Accept SNMP Packets from These Hosts，並新增要接收伺服器上代理程式陷阱的企
業管理電腦網路位址。 

使用該設定可以提供更多的安全性，因為這可以讓您指定 Microsoft Windows NT 代理
程式從中接收資訊的一台或多台電腦。

若要將具有 Sun StorEdge Configuration Service 主控台軟體的電腦的網路位址新增至
下一個清單方塊，按一下 Add 以存取 Security Configuration 視窗。在 Entry 方塊中鍵
入 IP 位址，並按一下該視窗中的 Add。Security 標籤會重新顯示，並具有 Configuration
Service 管理主控台電腦的位址。

5. 按一下 OK。 
234  Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



▼ 指定陷阱接收者

在此程序中，您要列出作為從伺服器接收陷阱的企業管理主控台。

注意 – 對於此程序，需要接收陷阱的企業管理主控台的 IP 位址。程序也需要與前面各節
中指定的社群具有相同的名稱。

指定將企業管理主控台電腦當作代理陷阱接收的步驟如下。

1. 按一下 Microsoft SNMP Properties 視窗中的 Traps 標籤，以顯示陷阱設定。 

2. 確保指定的社群名稱與之前在 Security 標籤中指示的名稱相同。

如果您需要更正社群名稱，請在 Community Name 欄位中鍵入名稱，然後按一下 Add。
如果輸入欄位內已有另一個名稱，在鍵入另一名稱後仍會保留。若要刪除名稱，選擇該
名稱並按一下 Remove。

3. 在 Trap Destinations 清單中新增企業管理主控台的 IP 位址。

a. 按一下 Add。 

顯示 Service Configuration 視窗。 

b. 在 Entry 欄位中鍵入 IP 位址，並按一下 Add。 

顯示 Traps 標籤，其中新的網路位址出現在 Trap Destinations 清單中。

c. 依照下列格式鍵入每個 IP 位址：AAA.BBB.CCC.DDD

您無須鍵入前導零。適當的位址範例：

192.168.100.1

4. 如果希望傳送選擇性的陷阱至另一個企業管理主控台，鍵入該管理工作站的網路位址。

如果擁有多個企業管理主控台，每一個都必須在這裏顯示出其位址。

5. 按一下 OK 確認設定。

6. 按一下 Close，離開 Network 視窗。

7. 結束 Windows NT 並重新啟動伺服器。

如果準備要安裝 Sun StorEdge Configuration Service，安裝軟體後才需要重新啟動。
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▼ 設定 Solaris 作業環境伺服器

對於執行 Solaris 作業環境的系統，您可以透過稱為 sstrapd 的 SNMP 陷阱協助程式
介面來產生 SNMP 版本 1 陷阱。依據預設值，在啟動過程期間，該協助程式不會自動
啟動。下列步驟說明如何啟用陷阱處理。 

1. 使用任何標準文字編輯器建立 /var/opt/SUNWsscs/ssagent/sstrapd.conf 檔案。

這個檔案包含 SNMP 管理主控台的名稱或 IP 位址。如果有多個主控台，請在獨立的行
列出這些位址。

2. 編輯 /etc/init.d/ssagent 檔案，並從與 SNMP 相關的啟動區段移除註釋標記。這
些行是用雙井字符號標示 (##)。

3. 編輯後儲存這些檔案。

sstrapd 協助程式會在下一次開機時啟動，也可以透過執行下列指令立即啟動

這會啟動 sstrapd 協助程式以及其他兩個協助程式 ( 如果這些程式目前不在執行中 )。
每個協助程式同時僅允許執行一個例項，無論有無任何協助程式先前正在執行中。

▼ 設定 Linux 作業環境伺服器

對於執行 Linux 作業環境的系統，您可以透過稱為 sstrapd 的 SNMP 陷阱協助程式介
面來產生 SNMP 版本 1 陷阱。依據預設值，在啟動過程期間，該協助程式不會自動啟
動。下列步驟說明如何啟用陷阱處理。

1. 使用任何標準文字編輯器建立 /var/opt/SUNWsscs/ssagent/sstrapd.conf 檔案。

這個檔案必須以 SNMP 管理主控台的系統名稱或 IP 位址清單 ( 每行一個 ) 建立。檔案
中可以含有空白行和註釋行。

2. 編輯 /etc/init.d/ssagent 檔案並從與 SNMP 相關的啟動區段移除註釋標記。

這些行是用雙井字符號標示 (##)。

/etc/init.d/ssagent uptrap
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3. 編輯後儲存這些檔案。

sstrapd 協助程式會在下一次開機時啟動，也可以透過執行下列指令立即啟動

這會啟動 sstrapd 協助程式以及其他兩個 Configuration Service 協助程式 ( 如果這些
程式目前不在執行中 )。每個協助程式同時僅允許執行一個例項，無論有無任何協助程式
先前正在執行中。

SNMP 的運作方式
簡單網路管理通訊協定 (SNMP) 是網路管理中 廣泛使用的通訊協定之一。正如其名稱
所示，它以一種相當簡單的方式管理網路裝置。SNMP 是一個簡單、無認可、無連接的
通訊協定。

SNMP 原來是開發在網際網路的通訊協定組下工作，主要在 TCP/IP ( 傳輸控制通訊協
定 / 網際網路通訊協定 ) 傳送協定下工作。自此，SNMP 已應用到其他一般傳送通訊協
定下工作，例如 Novell 的 IPX/SPX ( 網際網路資料封包交換 / 順序資料封包交換 )。

/etc/init.d/ssagent uptrap
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SNMP 陷阱訊息

代理程式使用 SNMP 將資訊傳送到企業管理系統。

一旦伺服器配置了傳送陷阱，事件資訊就會流向該系統。

陷阱訊息包含下列資訊：

■ OID ( 物件 ID) 1.3.6.1.4.1.2294.1.2

■ Event Date (MM, DD,YY, 如 01,22,98)

■ Event Time (HH:MM:SS，如 15:07:23)

■ Server Address and Name (IP 位址名稱，如 192.187.249.187 Administration)
■ Card Name

■ Event Severity (Informational, Warning, Critical)

■ 文字訊息

顯示的訊息和其格式取決於您正在使用的 SNMP 管理主控台。

必須將檔案 RST_OID.MIB 載入到企業管理主控台才能接收陷阱。在 Solaris 和 Linux
作業環境中，這個檔案位於 /opt/SUNWsscs/ssagent。在 Microsoft Windows 上，
這個檔案位於 \Program Files\Sun\ssagent。

代理程式和管理員

SNMP 軟體模組由代理程式和管理員組成。代理程式啟用要監控管理裝置中變數的軟
體。代理程式軟體可以嵌入管理裝置中，也可以在裝置所連接的電腦上執行。

管理員或者管理主控台是網路監控軟體，使用 SNMP 將有關變數的請求傳送到代理程
式。因為變數值會變更，管理員會週期性地輪詢代理程式。SNMP 管理員通常會分析從
代理程式接收到的資料，以圖形化的方式顯示給使用者。資料可以儲存在資料庫中，作
為歷史性和趨勢性分析。

除了回應 SNMP 管理員的請求外，代理程式可以傳送被動通知或陷阱到管理站。這與傳
統軟體的中斷信號類似。

管理主控台能採取各種行動對陷阱作出回應。通常，對陷阱進行日誌記錄，相關的資訊
則透過通知配置轉送給感興趣的使用者。陷阱也可能導致 SNMP 管理員啟動進一步的動
作 ( 如查詢代理程式，發出更多請求尋找網路實體的目前狀態，或者啟動應用程式 )。
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管理資訊庫 (MIB)
在網路上，每一個由 SNMP 代理程式使用的裝置具有一個或多個變數或與之相關的物
件。一個典型變數的範例為，一個追蹤裝置名稱的變數。這些變數或物件在一個稱為
Management Information Base (MIB) 的文字檔案中有較詳盡的說明。MIB 是由管
理變數的一個精確的文字定義。定義 MIB 的程序由國際標準化組織 (ISO) 的網際網路工
程小組 (IETF) 所建立。

SNMP 物件

某些用於網路管理的變數通用於所有 LAN 網路裝置。許多變數已標準化，被稱為 MIB-
II 變數和 MIB-II 擴充程式。IETF 還為不屬於標準 MIB-II 類別的 MIB 定義了程序。這
些變數在私人企業 MIB 中列出。

變數列在私人企業 MIB 的項目下。例如，物件 ID 1.3.6.1.4.1.2294.1.2 是指一個變數的
物件 ID ( 或 OID)，用於追蹤一個 Configuration Service 的 MIB 下的代理程式版本。  

圖 E-1 中的圖表顯示如何導出 OID。核取標記指出 OID 中的節點。在 MIB 中，指定變
數或物件的資料位於 OID 下。

Sun 的樹狀節點為 2294。每一家私人企業若想要開發能識別本身裝置的代理程式，可以
向 IETF 申請自己的樹狀節點。

SNMP 請求類型

支援存取 MIB 資料的 SNMP 操作包括 Get、GetNext 和 Set。給定索引值，Get 即從
表格項目欄位值檢索數值類值。GetNext 用於詳細討論表格項目的例項，每個指令傳回
感興趣的欄 ( 或欄位 ) 中的下一個順序值。Set 操作用來建立或變更 MIB 變數值。

SNMP 安全性

設定值增加了安全性問題。SNMP V1 ( 版本 1) 有一套簡單的安全配置。每一個通訊協
定資料單位 (PDU) 都包含一個社群字串，它是使用者名稱和密碼的組合。可以為特定社
群字串配置代理程式。代理程式不回應傳送給它的請求，除非在請求 PDU 中的社群字
串與它自己配置的社群字串相符。
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圖 E-1 MIB 變數的物件 ID
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▼ 不使用 Sun StorEdge Configuration Service 而傳
送 SNMP 陷阱

下列是傳送 SNMP 陷阱的替代方法 ( 不需要 Sun StorEdge Configuration Service 的情
況下 )。

陣列能將有關大量儲存事件的 SNMP 陷阱傳送給企業管理主控台 ( 如 HP OpenView)。
下列配置不需要安裝代理程式，就可以傳送 SNMP 陷阱。

1. 開啟文字編輯器。

2. 鍵入下列資訊，因為當它們套用於網路時會取代這些變數。

[SNMP_TRAP]

ENABLED=1
RECEIVER1=123.123.123.123

[EMAIL]

ENABLED=1
SUBJECT=RAID Event
SENDER_MAIL_BOX=someone@somecompany.com
SMTP_SERVER=123.123.123.123
RECEIVER1=somebody@somecompany.com

3. 使用此名稱儲存檔案 agent.ini。

4. 從您的工作站 FTP 至陣列。

5. 鍵入 root 使用者名稱，按 Return

6. 在提示輸入密碼時，按 Return。

如果先前已為控制器指定密碼，則需要在提示時鍵入密碼。

7. 登入後，請變更至 /cfg 目錄。

8. 將檔案從工作站放入 /cfg 目錄。

9. 結束 FTP 工作階段。

10. 重設您用來管理陣列的任何方法的控制器，例如主控台、Telnet 或終端機工作階段。
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附錄 F

疑難排解

本章對以下徵兆提供疑難排解的建議：

■ 第 244 頁「徵兆：在安裝 Sun StorEdge Configuration Service 時，java -version 傳
回低於 1.2.2 的 Java runtime environment 版本，但是機器已經安裝了 Java runtime
rnvironment 1.2.2、1.3 或 1.4。」

■ 第 244 頁 「徵兆：伺服器無回應，或已關機。」

■ 第 245 頁「徵兆：嘗試從現有邏輯磁碟機新增邏輯磁碟區時，沒有列出任何邏輯磁碟
機。」

■ 第 246 頁 「徵兆：DHCP 環境中某個伺服器的 IP 位址已變更。」

■ 第 247 頁 「徵兆：無法從伺服器接收陷阱。」

■ 第 248 頁 「徵兆：HP OpenView 無法安裝或陷阱協助程式無法啟動。」

■ 第 248 頁 「徵兆：新增或更換硬體時，控制台未顯示變更。」

■ 第 249 頁 「徵兆：執行 Solaris 作業環境的系統上沒有邏輯磁碟機。」

■ 第 249 頁 「徵兆：未報告環境警報。」

■ 第 249 頁 「徵兆：主控台出現執行緩慢的情況。」

■ 第 250 頁 「徵兆：Sun StorEdge Diagnostic Reporter 停止運作。」

■ 第 250 頁 「徵兆：(Solaris 或 Linux) 無法顯示線上說明」
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徵兆：在安裝 Sun StorEdge Configuration Service 時，java -version 傳
回低於 1.2.2 的 Java runtime environment 版本，但是機器已經安裝了 
Java runtime rnvironment 1.2.2、1.3 或 1.4。 
■ 檢查 /usr 目錄以確認從 Java 到 Java 是 新版本的連結而不是 Java 1.1。

若要檢查 Java Java runtime environmen 版本，請鍵入

(Solaris 作業環境 ) 如果連結並非指向所列出的 新版本，則鍵入

其中 xxx 是 新的 Java runtime environment 版本。

徵兆：伺服器無回應，或已關機。

請確保服務正在伺服器上執行。

1. (Solaris 作業環境 ) 請執行以下指令

ssmon 和 ssserver 這兩個名稱都應在輸出中出現。如果未啟動，請繼續步驟 2，如果
已啟動，請繼續步驟 4。

(Windows NT) 到  Settings → Control Panel → Services，驗證 SUNWscsd Monitor、
SUNWscsd Server 和 SUNWscsd Startup 服務已經啟動。如果未啟動，請繼續步驟 2，
如果已啟動，請繼續步驟 4。

(Windows 2000) 到 Start → Administrative Services → Computer Management。按一
下 Services & Applications，驗證 SUNWscsd Monitor、SUNWscsd Server 和
SUNWscsd Startup 服務已經啟動。如果未啟動，請繼續步驟 2，如果已啟動，請繼續
步驟 4。

2. (Solaris 或 Linux 作業環境 ) 如第 13 頁 「啟動或停止代理程式」中所示，停止和啟動
各個協助程式。

(Windows NT/2000) 在要啟動或停止的服務上按一下滑鼠右鍵，將服務停止然後啟動。

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java

# ps -e | grep ss
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3. 如果協助程式或服務沒有正常停止或啟動，則重新配置後進行重新開機。

4. 請確定已載入 TCP/IP 通訊協定軟體，且網路卡和網路連線運作正常。

若要在指令行中測試 TCP/IP 連接，則鍵入

如果沒有得到回應，則 TCP/IP 通訊協定服務有問題。請聯絡 MIS 部門尋求協助。

5. 請確定指定正確的伺服器名稱和密碼。

如果名稱或者密碼不正確，請透過編輯項目進行更正。如果是 Solaris 作業環境，請參閱
第 14 頁「管理 ( 使用者 ) 安全等級和準則」。如果是 Windows NT/2000，請參閱第 23
頁「管理員 ( 使用者 ) 安全等級和準則」。如果是 Linux 作業環境，請參閱第 32 頁「管
理 ( 使用者 ) 安全等級和準則」。

密碼必須為透過設定使用者的程序所建立的密碼。

■ 請確保已正確安裝使用者 (ssmon、ssadmin、ssconfig)。請確保使用者已在 
Windows NT 中設定為擁有許可權 Act as a part of the operating system 和 
Log on as a batch job。

■ 如果正在使用命名服務 (Windows NT 網域，以及 Solaris 作業環境中的 NIS 或 NIS+)，
則確保使用者已被正確新增至命名服務。

■ 如果是在 Windows NT 下的網域中輸入了使用者名稱，則傳送使用者名稱需要一段
時間。

徵兆：嘗試從現有邏輯磁碟機新增邏輯磁碟區時，沒有列出任何邏輯
磁碟機。

如果在 Select a Logical Drive 之下未列出任何邏輯磁碟機，表示這些邏輯磁碟機尚未取
消對應，所以無法選取。您必須先取消對應這些邏輯磁碟機。

# ping {伺服器的 IP 位址或伺服器名稱 }
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徵兆：DHCP 環境中某個伺服器的 IP 位址已變更。

在 DHCP 環境中，如果伺服器離線超過三天，伺服器的 IP 位址有時可能會變更。

如果發生這種情況，必須通知主控台伺服器的新 IP 位址，因為主控台與伺服器是透過
IP 位址通訊的。

要修正這種狀況，必須在主控台軟體的 Edit Server  視窗中輸入新的伺服器 IP 位址。

1. 選擇 File → Server List Setup。

2. 將伺服器名稱從 Managed Servers 清單移至 Available Servers 清單。

顯示 Edit Server 視窗。視窗顯示設定時的伺服器名稱和 IP 位址。

3. 在 Available Servers 清單中選擇伺服器名稱，並按一下 Edit。

顯示 Edit Server 視窗。視窗顯示設定時的伺服器名稱和 IP 位址。

4. 如果網路位址已變更，按一下 Get IP Addr by Name。 

如果您提供了網路使用的服務所記錄的伺服器名稱，程式會搜尋並顯示正確的 IP 位址。
否則，必須手動鍵入 IP 地址。

如果伺服器使用的名稱與伺服器的網路名稱不一致，或者命名服務尚未更新，則必須手
動鍵入 IP 位址。

5. 輸入伺服器 IP 位址後，按一下 OK 以指定變更的位址，然後返回 Server List Setup 視
窗。

6. 將伺服器名稱移回 Managed Servers  清單。

7. 按一下 OK 離開 Server List Setup 視窗。
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徵兆：無法從伺服器接收陷阱。
若要解決在 SNMP 管理工作站 ( 如 HP OpenView) 上沒有從伺服器接收到陷阱的問題，
請使用下列步驟：

1. 確保 SNMP 服務已在伺服器上啟動。

驗證 sstrapd 已透過執行以下指令執行。

輸出會包含名稱 sstrapd；如果沒有，請參閱第 13 頁「啟動或停止代理程式」，以獲
得有關啟動協助程式的說明。

在 Windows NT 下，從 Control Panel → Services，檢查 SNMP 服務是否已列出，並
顯示為已啟動。如果沒有，請安裝該服務，然後啟動服務。如需詳細資訊，請參閱
Windows NT 文件。

2. 檢查伺服器上是否正確設定了企業管理主控台的正確目標位址和社群字串。

第 233 頁「設定伺服器以傳送陷阱」提供了在 Windows NT 伺服器上正確設定將陷阱
傳送到企業管理主控台的具體步驟。

3. 確保 MIB 已在 SNMP 管理主控台下編譯。

在 Solaris 和 Linux 作業環境中，RST_OID.MIB 檔案是位於 /opt/SUNWsscs/ssagent
中。在 Microsoft Windows 上，該檔案位於 \Program Files\Sun\ssagent。如需
如何編譯 MIB 的相關資訊，請參閱 SNMP 管理主控台文件 ( 如 HP OpenView)。

4. 在 Windows NT 環境下，檢查 Sun StorEdge Configuration Service 的 NT 註冊項目。 

如果沒有項目，請在伺服器上重新安裝代理程式。

a. 首先，請確保 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\ 

Parameters\ExtensionAgents 

包含 SSAGENT 所需的項目。

b. 第二，檢查 

HKEY_LOCAL_MACHINE\SOFTWARE\Sun\Sun StorEdge Configuration 

Service Agent\SNMP Extension Agent\Current Version

指向帶有完整路徑名稱的延伸代理程式： 

C:\PROGRA~1\Sun\ssagent\SSAGENT.DLL

C:\PROGRA~1\Sun\ssagent\ 

是預設安裝目錄。 

如果您將程式安裝在其他目錄中，請確保將其指向該目錄。

# ps -e | grep ss
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c. 第三，確定 

SSAGENT.DLL 

是在 C:\PROGRA~1\Sun\ssagent 目錄中。

徵兆：HP OpenView 無法安裝或陷阱協助程式無法啟動。
如果在準備要發送 SNMP 陷阱的同一台伺服器上安裝了 HP OpenView，會導致沒有足
夠的系統資源同時執行陷阱協助程式和 HP OpenView。請依照下列步驟所示對系統資
源進行重新設定。

1. 將下列行新增到 /etc/system 的末端 .

2. 重新啟動伺服器。

徵兆：新增或更換硬體時，控制台未顯示變更。

如果新增裝置或更換故障裝置 ( 例如磁碟機、磁帶機、電源或風扇等 )，主控台不一定會
顯示更新資訊。有時，樹狀圖和其他相關的檢視圖無法反映裝置的實際狀態。

如果在下一個週期性掃描前，希望主控台能夠識別新增的裝置，在 Server View 視窗按
一下 Rescan。伺服器會立刻重新掃描庫存，主控台更新其伺服器庫存，並在樹狀圖中顯
示任何變更結果。若要確保得到及時庫存，可進行手動掃描。

可能必須按 Rescan 多次。當伺服器在重新掃描過程中而主控台發送了庫存請求時，伺
服器只將 近一次更新結果發送到主控台，因為伺服器尚未完成目前掃描。

set shmsys:shminfo_shmmax=x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni-=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semms1=32
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徵兆：執行 Solaris 作業環境的系統上沒有邏輯磁碟機。

如果未顯示邏輯磁碟機，請確保已為邏輯磁碟機加標籤且其未被 Sun StorEdge 
Configuration Service ( 如果已安裝 ) 排除在外。

徵兆：未報告環境警報。

具有基於 SCSI 機箱監控功能的儲存機箱 ( 如 SAF-TE 卡 ) 將環境警報發送到主控台。警
報狀況可能是由磁碟機、風扇、電源或異常溫度故障引起的。

如果環境警報發生，您必須在 View Enclosure 視窗中按一下 Reset 才能消除警報。您必
須要有配置安全權限，才可在軟體中按 Reset 。 

警報產生後，要求用於這些儲存機箱的 SAF-TE 監控規範，直到警報重設後，由此引起
的環境警報才會生成。

重設警報後，環境事件會再次顯示在 Event Log. 中。

徵兆：主控台出現執行緩慢的情況。

執行於 Windows NT 環境下的主控台在主控台工作站上 少要 10 MB 的可用虛擬記憶
體 ( 實體記憶體加分頁檔大小 )。可用實體記憶體越大，主控台程式的回應程度就較高，
可將作業系統的記憶體分頁到從實體記憶體 小化到分頁檔。

當使用的記憶體總量接近可用虛擬記憶體總量 ( 實體記憶體加分頁檔大小 ) 時，超過的
分頁內容有可能引起問題，導致工作站上所有應用程式的效能降低。

增大實體記憶體和分頁檔大小以增大整體虛擬記憶體。若要變更分頁檔大小，選擇
Control Panel → System，然後在出現的 System Properties 視窗選擇 Performance 標
籤。在 Windows NT 環境中，在 Performance 標籤視窗的 Virtual Memory 區段變更
分頁檔大小。 
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徵兆：Sun StorEdge Diagnostic Reporter 停止運作。

如果 Sun StorEdge Diagnostic Reporter 不再將電子郵件訊息傳送給您，表示它可能已
停止運作，您必須先停止 Diagnostic Reporter 再重新啟動。

(Solaris 作業環境 ) Sun StorEdge Diagnostic Reporter 停止運作並且不再報告其狀況的
情況有三種。變通辦法就是將其停止和重新啟動。

■ 如果代理程式發生錯誤或者遭到停止並重新啟動，則 Sun StorEdge Diagnostic 
Reporter 會停止運作。

■ 如果 Config Tool 正在執行，而協助程式停止並重新啟動，則可能會發生 Config Tool
無法繼續與協助程式通訊的情形。

■ 如果代理程式發生錯誤失敗或者遭到停止，而協助程式沒有偵測到這一情況、停止傳
送電子郵件訊息，並繼續透過顯示綠色狀態表示 Sun StorEdge Diagnostic Reporter
仍然保持連線。

停止和重新啟動 Sun StorEdge Diagnostic Reporter，方法是鍵入

徵兆：(Solaris 或 Linux) 無法顯示線上說明

請確定您已經指定了要用來顯示線上說明的 Web 瀏覽器的絕對路徑名稱。

1. 到 /opt/SUNWsscs/sscsconsole 並且鍵入 

2. 輸入 Web 瀏覽器的絕對路徑名稱。

# /etc/init.d/ssdgrptd stop 
# /etc/init.d ssdgrptd start

./config_sscon
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附錄 G

錯誤代碼和訊息

本附錄提供錯誤代碼及錯誤和狀態訊息清單。

錯誤代碼
錯誤代碼是在事件日誌中顯示和說明的八個字元代碼，其中包含四個欄位，即每個欄位
由兩個字元構成。 Some codes might be followed by a dash and another eight-
character code, which is for internal use only.

下列表格說明每個雙字元欄位中所用的錯誤代碼。四個雙字元欄位的格式為：

SSMMmmEE

其中：

SS = Severity ( 嚴重性 ) 欄位

MM = Major 欄位

mm = Minor 欄位

EE = Error 欄位

表 G-1 Severity 欄位

Severity 欄位 說明

01 Critical ( 嚴重 ) 

02 Warning ( 警告 )

03 Informational ( 資訊 )
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表 G-2 Major 欄位

Major 欄位 說明

01 未使用

03 既有

04 RAIDCard Card 訊息

05 JBOD ( 就是一組磁片 ) 訊息

06 SSMon 監控訊息

07 dll/ 共用庫訊息

08 SSserver 訊息

09 HBA ( 主機匯流排轉接器 ) 訊息

0A Server Communications ( 伺服器通訊 ) 訊息

0B 控制器訊息
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下表中定義 Minor 欄位。Error 欄位的定義取決於 Minor 欄位的定義，因此必須參照適
當的表格。

表 G-3 Minor 欄位

Minor 欄位 說明

01 未知

02 請參閱 第 254 頁 「Error 欄位：系統磁碟機狀態」。

03 請參閱 第 254 頁 「Error 欄位：磁片狀態」。

04 請參閱 第 255 頁 「Error 欄位：SAF-TE 狀態」。

05 請參閱 第 255 頁 「Error 欄位：磁帶狀態」。

06 請參閱 第 257 頁 「Error 欄位：冗餘狀態」。

07 請參閱 第 257 頁 「Error 欄位：內部狀態」。

08 請參閱 第 258 頁 「Error 欄位：裝置狀態」。

09 請參閱 第 258 頁 「Error 欄位：初始化狀態」。 

0A 請參閱 第 258 頁 「Error 欄位：使用者端參數無效」。

0B 請參閱 第 259 頁 「Error 欄位：開啟傳輸」。

0C 請參閱 第 259 頁 「Error 欄位：關閉傳輸」。

0D 請參閱 第 259 頁 「Error 欄位：記憶體分配」。

0E 偵測到 RaidCard 故障。

0F 請參閱 第 260 頁 「Error 欄位：傳輸」。

10 請參閱 第 260 頁 「Error 欄位：指令」。

11 請參閱 第 260 頁 「Error 欄位：指令」。

12 請參閱 第 261 頁 「Error 欄位：主要通訊」。

13 請參閱 第 261 頁 「Error 欄位：通訊非同步」。

14 請參閱 第 262 頁 「Error 欄位：通訊安全」。

15 請參閱 第 262 頁 「Error 欄位：逾時」。

16 請參閱 第 262 頁 「Error 欄位：管理」。

17 請參閱 第 263 頁 「Error 欄位：韌體」。

18 請參閱 第 263 頁 「Error 欄位：系統關閉」。

19 偵測到 Dynamic Growth 故障。 

1C 請參閱 第 264 頁 「Error 欄位：設定配置」。

1D 請參閱 第 264 頁 「Error 欄位：控制器事件」。
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Error 欄位：系統磁碟機狀態

Error 欄位：磁片狀態

1E 請參閱 第 265 頁 「Error 欄位：磁碟機端事件」。

1F 請參閱 第 266 頁 「Error 欄位：主機端事件」。

20 請參閱 第 266 頁 「Error 欄位：邏輯磁碟機事件」。

23 請參閱 第 266 頁 「伺服器管理 / 監控事件錯誤」。

表 G-4 系統磁碟機狀態錯誤

Error 欄位

01 離線

02 已降級

03 連線

04 未知

05 同位檢查

06 重建

07 重新配置

08 動態成長

09 不存在

0A 初始化

表 G-5 磁片狀態錯誤 (2 的 1)

Error 欄位 說明

01 離線

02 已降級

03 連線

表 G-3 Minor 欄位 ( 續 )

Minor 欄位 說明
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Error 欄位：SAF-TE 狀態
 

Error 欄位：磁帶狀態

04 未知

05 SMART

06 死亡

表 G-6 SAF-TE 狀態錯誤

Error 欄位 說明

01 電源

02 風扇

03 熱度

04 警報

05 已鎖定

06 插槽

07 未知

08 無法獲得 SAF-TE 資訊

09 電池 

0A 無效插槽數目

0B 無環境資料可提供

表 G-7 磁帶狀態錯誤

Error 欄位 說明

01 讀取

02 寫入

03 Hard Error

04 媒體錯誤

表 G-5 磁片狀態錯誤 (2 的 2)

Error 欄位 說明
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05 讀取失敗

06 寫入失敗

07 媒體壽命

08 不可升級

09 防寫

0A 非移動

0B 清潔媒體

0C 不支援的格式

0D 磁帶已被扯斷

14 立即清潔

15 週期性清潔

16 清潔媒體已過期

1E 硬體 A

1F 硬體 B

20 介面

21 彈出媒體

22 下載失敗

28 載入器硬體 A

29 載入器托盤磁帶

2A 載入器硬體 B

2B 載入器門

C8 查詢日誌失敗

C9 查詢磁帶失敗

表 G-7 磁帶狀態錯誤 ( 續 )

Error 欄位 說明
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Error 欄位：冗餘狀態

Error 欄位：內部狀態
 

表 G-8 冗餘狀態錯誤

Error 欄位 說明

01 模式正常

02 沒有記憶體可用於協商

03 次控制器故障

04 次控制器已被卸下

05 偵測到次控制器卸下

06 偵測到次控制器插入

07 主控制器故障

08 主控制器已被卸下

09 偵測到主控制器卸下

0A 偵測到主控制器插入

0B 未知狀態

0C 協力失敗

0D 協力產品已插入

0E 協力產品已移除

表 G-9 內部狀態錯誤

Error 欄位 說明

01 無記憶體

02 信號

03 執行緒

04 沒有裝置
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Error 欄位：裝置狀態

Error 欄位：初始化狀態

Error 欄位：使用者端參數無效

表 G-10 裝置狀態錯誤

Error 欄位 說明

01 查詢

02 未知

表 G-11 初始化狀態錯誤

Error 欄位 說明

01 dll 初始化

02 dll 初始化失敗

表 G-12 使用者端參數錯誤

Error 欄位 說明

01 設定配置 - 配置失配

02 設定配置 - 配置裝置無效

03 設定配置 - 查詢失配

04 設定配置 - Enquire2 失配

05 應用程式長度不正確

06 不支援的指令

07 指令無效

08 設定配置 - 一般性失配

09 無效長度

0A 卡識別碼無效

0B 無效的卡名

0C 參數無效
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Error 欄位：開啟傳輸

Error 欄位：關閉傳輸

Error 欄位：記憶體分配

0D 卡類型指令無效

0E 設定配置 - 其他參數無效 

0F 設定配置 - 區塊重疊

10 設定配置 - 裝置資訊無效 

表 G-13 開啟傳輸錯誤

Error 欄位 說明

01 開啟傳輸

表 G-14 關閉傳輸錯誤

Error 欄位 說明

01 關閉傳輸

表 G-15 記憶體分配錯誤

Error 欄位 說明

01 記憶體不足

02 記憶體不足，無法進行管理操作

表 G-12 使用者端參數錯誤 ( 續 )

Error 欄位 說明
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Error 欄位：傳輸

Error 欄位：指令

表 G-16 傳輸欄位錯誤

Error 欄位 說明

01 鎖定錯誤

02 記憶體不足

03 獲得鎖定錯誤

04 釋放鎖定錯誤

05 指令無效

06 無效長度

07 無效的卡名

08 卡標識無效

09 沒有找到卡

0A 找不到裝置

0B 開啟錯誤

0C 找不到卡名

表 G-17 指令代碼錯誤

Error 欄位 說明

01 鎖定錯誤
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Error 欄位：主要通訊

Error 欄位通訊連結

Error 欄位：通訊非同步

表 G-18 主要通訊錯誤

Error 欄位 說明

01 套接字錯誤

02 報告錯誤

03 執行緒錯誤

04 鎖定錯誤

05 系統錯誤

表 G-19 通訊連結

Error 欄位 說明

01 套接字錯誤

表 G-20 通訊非同步

Error 欄位 說明

01 套接字錯誤

02 執行緒錯誤

03 冷連結錯誤

04 傳送事件錯誤
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Error 欄位：通訊安全

Error 欄位：逾時

Error 欄位：管理

表 G-21 通訊安全

Error 欄位 說明

01 安全衝突

表 G-22 逾時錯誤

Error 欄位 說明

01 配置更新

02 鎖定逾時

表 G-23 管理錯誤

Error 欄位 說明

01 設定客戶名稱錯誤

02 設定配置已結束

03 初始化

04 初始化已結束

05 重建

06 重建已結束

07 同位檢查

08 同位檢查已結束

09 設定 SAF-TE 插槽狀態

0A 設定 SAF-TE Perform Slot ( 執行插槽 )

0B 設定 SAF-TE Send Global ( 全域傳送 )

0E 排程同位檢查

0F 排程同位檢查已結束
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Error 欄位：韌體

Error 欄位：系統關閉

Error 欄位：RDP 路徑變更

10 設定控制器參數

11 韌體下載

12 一致性檢查或重建已結束

表 G-24 韌體下載錯誤

Error 欄位 說明

01 並非 SAF-TE 裝置

02 數據長度無效

03 下載失敗

04 加總檢查碼失敗

表 G-25 系統關閉錯誤

Error 欄位 說明

01 系統關閉失敗

表 G-26 RDP 路徑變更錯誤

Error 欄位 說明

01 RDP 路徑失敗

02 RDP 路徑已還原

表 G-23 管理錯誤 ( 續 )

Error 欄位 說明
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Error 欄位：設定配置

Error 欄位：控制器事件

表 G-27 設定配置錯誤

Error 欄位 說明

01 設定配置執行緒建立失敗

02 獲取邏輯磁碟機清單指令失敗

03 建立配置指令失敗

04 初始化完成狀態指令失敗

05 Get Configuration ( 獲取配置 ) 指令失敗

06 變更磁碟區配置指令失敗

07 刪除邏輯磁碟機指令失敗

表 G-28 控制器事件錯誤

Error 欄位 說明

01 控制器已重設

02 控制器 DRAM 同位檢查錯誤

03 冗餘控制器故障

04 控制器電源故障

05 控制器風扇故障

06 控制器溫度警示

07 控制器 UPS 交流電源斷電

08 控制器初始化完成

09 控制器電源還原連線

0A 控制器風扇還原連線

0B 控制器溫度正常

0C 控制器 UPS 交流電源重新供電
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Error 欄位：磁碟機端事件

表 G-29 磁碟機端事件錯誤

Error 欄位 說明

01 磁碟機通道選擇逾時

02 磁碟機通道 SCSI 匯流排錯誤

03 磁碟機通道意外切斷

04 磁碟機通道協商錯誤

05 磁碟機通道目標已逾時

06 磁碟機通道同位檢查錯誤

07 磁碟機通道資料不足或超限

08 磁碟機通道未定義錯誤

09 磁碟機通道 SCSI 匯流排重設已發出

0A 磁碟機通道未就緒錯誤

0B 磁碟機通道目標 HW 錯誤

0C 磁碟機通道目標媒體錯誤

0D 磁碟機通道意外單元強調

0E 磁碟機通道意外感應資料

0F 磁碟機通道區塊重新分配失敗

10 磁碟機通道區塊重新分配成功

11 磁碟機通道 SCSI 已中止指令

12 磁碟機通道 SCSI 通道故障

13 磁碟機通道 Smart 故障

14 磁碟機通道掃描 SCSI 磁碟機
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Error 欄位：主機端事件

Error 欄位：邏輯磁碟機事件

伺服器管理 / 監控事件錯誤

表 G-30 主機端事件錯誤

Error 欄位 說明

01 主機通道 SCSI 匯流排重設

02 主機通道 SCSI 匯流排裝置重設

03 主機通道中止標記訊息

04 主機通道同位檢查錯誤

05 主機通道重新選擇逾時

表 G-31 邏輯磁碟機事件錯誤

Error 欄位 說明

01 邏輯磁碟機 SCSI 磁碟機故障

02 邏輯磁碟機初始化失敗

03 邏輯磁碟機重建失敗

04 邏輯磁碟機初始化已開始

05 邏輯磁碟機初始化已完成

06 邏輯磁碟機重建已開始

07 邏輯磁碟機重建已完成

表 G-32 伺服器管理 / 監控事件錯誤 

Error 欄位 說明

01 要管理 / 監控的伺服器發生已變更。
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錯誤和狀態訊息        
大多數的錯誤和狀態訊息很容易理解。表 G-33 對訊息中所用的名詞術語加以澄清。
表 G-34 則列出各個錯誤和狀態訊息。 

表 G-33 替代值

值 說明

通道 卡的通道號碼，表示 SCSI 通道。值 1 表示第一個通道。

風扇 風扇號碼。

機箱 機箱號碼。

LogicalArray 邏輯陣列號碼。

LogicalDrive 邏輯磁碟機號碼。

Lun LUN 號碼。

名稱 文字名稱。

電源 電源號碼。

插槽 插槽號碼。

狀態 以文字表示的邏輯陣列、裝置或機箱的狀態。其值為：Critical、
Online、Offline、Critical Rebuild、Non Existent、Low Battery、
Normal。

目標 SCSI ID 的目標。 

溫度 以攝氏表示的溫度。
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表 G-34  錯誤 / 狀態訊息

錯誤和狀態訊息

SCSI 磁碟機故障 (Ch:%d、Id:%d)。請更換有缺陷的磁碟機。

上一次的硬體故障將磁帶留在自動載入器中。請插入空的媒體盒以清除故障。如果沒有清除故
障，請將自動載入器關閉然後重新開啟。如果問題仍存在，請與磁帶供應商協助專線聯絡。

必須建立一個名為 ssconfig 的使用者才能對 SUNWsscs Diag Reporter 進行配置。

中止複製 SCSI 磁碟機。

中止初始化。

中止同位檢查。

中止重建。

收到 Abort/Clear-Queue/Abort-Tag 訊息 (SCSI 通道 %d、SCSI ID %d、目標 Lun %d)。
I/O 模組、電纜、控制器或 HBA 可能發生了故障。

對一個或多個伺服器的存取遭到拒絕。以 ssconfig 使用者身份登入，然後再次嘗試該操作。

對一個或多個伺服器的存取遭到拒絕。以 ssconfig 使用者身份登入，然後再次嘗試該操作。

現用的陷阱事件是空的。

新增的實體磁碟機 %d:%d 已在邏輯磁碟機 LogicalDrive 上啟動。

新增的實體磁碟機已在邏輯磁碟機 LogicalDrive 上完成。

「將 SCSI 磁碟機新增到邏輯磁碟機」資訊。

代理程式名稱是空的。

從伺服器獲取資料時出錯。

WWN 與此同名的 HBA 卡已存在。

該程式的另一例項已在執行！

正在進行陣列管理

至少需要配置一個電子郵件地址。

本磁碟機不支援嘗試裝入的盒式磁帶類型。已自動將盒式磁帶彈出。嘗試裝入一種不支援的磁
帶格式。

嘗試寫入帶有防寫的盒式磁帶。請去掉防寫或者使用另一盒磁帶。

音頻警報的狀態未知。

已觸發音頻警報。

已關閉音頻警報。

正在進行背景檢查或重建操作。

正在進行背景初始化。
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正在進行背景同位檢查。

正在進行背景重建操作。

遇到損壞區塊 (Ch:%d、Id:%d)。區段編號是 %u。資訊性訊息。

區塊重新分配失敗 (Ch:%d、Id:%d)。磁碟機有缺陷。必須進行更換。

區塊重新分配重成功 (Ch:%d、Id:%d) 資訊性訊息。磁碟機可能會出現故障。

無法接受進來的連線。

無法分配記憶體。

無法結合 TCP 通訊埠與開放的 TCP/IP 通訊。

無法與進來的連線進行連線。

無法為進來的連線建立通訊階段。

無法建立主機 LUN 篩檢程式，尚未選取主機 ID。

無法建立標準主機 LUN 對應，尚未選取主機 ID。

無法找到剛才建立的邏輯磁碟機。可能已被停用。

無法從控制器獲得配置。操作已被取消。

無法從設定配置中獲得配置。

無法接聽開啟的 TCP/IP 通訊。

無法鎖定資源。

無法開啟 TCP/IP 通訊。

無法在 TCP/IP 通訊上執行 IOCTL。

無法查詢連線的進來資料狀態。

無法從連線用戶端接收資料。

無法報告狀態。

無法傳送資料至連線用戶端。

變更邏輯磁碟機失敗。

變更邏輯磁碟區失敗。

變更或設定本機 / 通用待命磁碟機成功。

只有在偵測到所有的邏輯磁碟機並重設控制器後，對 佳化進行的變更才能生效。

按一下 View 以選擇一個檔案。

在設定配置關閉傳輸失敗。

收寄郵件操作被使用者取消。

表 G-34  錯誤 / 狀態訊息 ( 續 )

錯誤和狀態訊息
附錄 G 錯誤代碼和訊息 269



使用控制器重新建立通訊。

配置資訊儲存成功！

連接和登入指令錯誤

聯絡人傳真號碼格式錯誤。

聯絡人姓名是空的。

聯絡人電話號碼格式錯誤。

繼續在邏輯磁碟機 LogicalDrive 上新增磁碟機。

控制器事件，電池 %s %s。資訊性訊息。

控制器事件，電池 %s %s。可能是電池模組錯誤。如果錯誤繼續存在，則請更換缺陷電池模組。

控制器事件，控制器初始化已完成。控制器已被重新啟動。資訊性訊息。

控制器事件，控制器重設。資訊性訊息。

控制器事件，DRAM 同位檢查錯誤。可能是由於控制器錯誤。如果錯誤繼續存在，則請更換
缺陷控制器。

控制器事件，風扇還原連線。資訊性訊息。

控制器事件，偵測到風扇故障。風扇與集電源成在一起。更換電源。檢查 LED 指示燈，看是
否有電。

控制器事件，電源還原連線。資訊性訊息。

控制器事件，偵測到電源故障。更換電源。檢查 LED 指示燈，看是否有電。

控制器事件，偵測到冗餘控制器故障。可能是由於控制器錯誤。如果錯誤繼續存在，則請更換
缺陷控制器。

控制器事件，SDRAM 錯誤。可能是由於控制器錯誤。如果錯誤繼續存在，則請更換缺陷控制器。

控制器事件，溫度警示。檢查室內溫度，看空氣流通是否受到阻擋或限制。進行必要的更正。

控制器事件，溫度還原正常。資訊性訊息。

控制器事件，UPS 交流電源重新供電。資訊性訊息。

控制器事件，偵測到 UPS 交流電源斷電。請與技術支援聯絡。

控制器已被重新設定。

控制器已回到冗餘模式！

控制器已回到冗餘模式！

已在實體磁碟機 %d:%d 上完成複製和取代。

已在實體磁碟機 %d:%d 上開始複製和取代。

已中止實體磁碟機 %d:%d 的複製和取代。

表 G-34  錯誤 / 狀態訊息 ( 續 )

錯誤和狀態訊息
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建立邏輯磁碟機失敗。

建立邏輯磁碟區失敗。

正在建立主機 LUN 篩選程式項目，請稍候 …

正在建立標準主機 LUN 對應，請稍候 …

客戶傳真號碼格式錯誤。

客戶名稱是空的。

客戶電話號碼格式錯誤。

資料有危險。本磁帶的媒體性能嚴重降級。須從該磁帶複製所有需要的資料。不要再使用此磁
帶。請用一盒不同的磁帶重新開始操作。

數據不足 / 超限 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。如果是隨機磁碟機，則有
可能是磁碟機迴圈上有 I/O 模組或電纜故障。

郵件解密操作被使用者取消。

刪除邏輯磁碟機失敗。

刪除邏輯磁碟區失敗。

已成功刪除磁片！

正在刪除磁碟，請稍候 Ö

正在刪除主機 LUN 篩選程式項目，請稍候 …

正在刪除標準主機 LUN 對應，請稍候 …

[Channel:Target] ( 通道：目標 ) 處的裝置自我可靠性測試失敗。

裝置資訊失敗。

成功為磁碟加上標籤。

門鎖處於未知狀態。

門已鎖住。

門已開鎖。

下載帶有啟動記錄的韌體。

正在將韌體下載到裝置

正在將韌體下載到 RAID 控制器。

磁碟機 SCSI Ch:%d、Id:%d 磁碟機可能安裝不當或有缺陷。如果是隨機磁碟機，則可能是 I/O
模組或電纜故障。

電子郵件地址格式錯誤。

機箱 #Enclosure 狀態變更：名稱

表 G-34  錯誤 / 狀態訊息 ( 續 )
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機箱 #Enclosure，溫度臨界值已從 State 狀態變為 State 狀態。

使用韌體；不必進行控制器重設。

寫入檔案時出現錯誤，請稍後再試！

出現錯誤。請重設配置檔。

擴充 LD/LV 資訊。

成功擴充邏輯磁碟區。

已在邏輯磁碟機 LogicalDrive 上完成擴充。

已在邏輯磁碟機 LogicalDrive 上開始擴充。

邏輯磁碟機 LogicalDrive 擴充已中止。

風扇 #Fan 處於未知狀態。

風扇 #Fan 發生故障。

系統中沒有風扇 #Fan 。

風扇 #Fan 操作正常。

檔案 I/O 錯誤。無法儲存配置！

下載韌體到 SAF-TE/SES 裝置 (Ch:%d、Id:%d) 失敗。

下載韌體到 SAF-TE/SES 裝置 (Ch:%d、Id:%d) 成功。

下載韌體到 SCSI 磁碟機 (Ch:%d、Id:%d) 失敗。

下載韌體到 SCSI 磁碟機 (Ch:%d、Id:%d) 成功。

請先選擇一個邏輯磁碟機！

請先選擇一個實體磁碟機。

請先選擇一個 RAID 控制器。

對於 RAID1 邏輯磁碟機，'Add Drive'/'Copy and Replace' 功能已被停用。

郵件轉寄操作被使用者取消。

未釋放一般檔案互斥鎖。

取得邏輯磁碟機清單失敗。

Getting Agent Options ( 獲取代理程式選項 ) 失敗！

Getting Controller Parameters ( 獲取控制器參數 ) 失敗！

Getting Host LUN Assignments ( 獲取主機 LUN 分配 ) 失敗！請重試

獲取配置失敗！

偵測到總體相位 / 信號錯誤 (Ch:%d)。請檢查磁碟機安裝、電纜和 I/O 模組。根據需要進行
更換。複式控制器無法結合。

表 G-34  錯誤 / 狀態訊息 ( 續 )

錯誤和狀態訊息
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群組名稱不能空白。

主機 LUN 篩檢程式項目建立成功！

主機 LUN 篩檢程式項目刪除成功！

修改主機 LUN 成功。

指定給多台主機時沒有協調好檔案存取，則可能會發生資料破壞和存取競爭。

如果 小間隔為 \“0\” 或 \“*\”，則內容必須為 \“Event\”

如果韌體下載進程被中斷，則可能會導致控制器 / 裝置無法使用。

已在邏輯磁碟機 LogicalDrive 上完成初始化。

已在邏輯磁碟機 LogicalDrive 上開始初始化。

邏輯磁碟機 LogicalDrive 初始化已中止。

初始化操作已完成。

正在初始化、重建、擴充或新增 SCSI 磁碟機。請稍後重試。

插入故障的主控制器。

插入故障的次控制器。

接收無效資料。

伺服器 IP 位址無效！

IP 位址格式錯誤 ( 必須為 xxx.xxx.xxx.xxx 和 0 &amp;lt; xxx &amp;lt;255)！

IP 位址已被複製！

IP 位址是空的。

位置是空的。

以 \“ssconfig”\ 使用者身份登入，然後再次嘗試該操作。

邏輯陣列  LogicalArray 已從 state 狀態變為 state 狀態。

邏輯磁碟機 %d，SCSI 磁碟機有故障。請更換有缺陷的磁碟機。

對於順序 佳化 LD，使邏輯磁碟機 ID %d 會超過 2 TB 大小限制。

對於隨機 佳化 LD，邏輯磁碟機 ID %d 會超過 512 GB 大小限制。

邏輯磁碟機 ID %d，重建已中止。資訊性訊息。

邏輯磁碟機 ID %d，重建已完成。資訊性訊息。請用新磁碟機更換有缺陷的磁碟機。

邏輯磁碟機 ID LogicalDrive，重建已中止。

邏輯磁碟機 ID LogicalDrive，重建已完成。

邏輯磁碟機 ID LogicalDrive，重建已開始。

表 G-34  錯誤 / 狀態訊息 ( 續 )
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邏輯磁碟機 ID LogicalDrive，新增磁碟機已暫停。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，新增 SCSI 磁碟機已中止。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，新增 SCSI 磁碟機已完成。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，新增 SCSI 磁碟機失敗。不可還原的錯誤。可能是因為磁碟機故障
或者等量磁碟區上有不可還原的錯誤。請在邏輯磁碟機上執行同位檢查。請與技術支援聯絡。

邏輯磁碟機 ID LogicalDrive，複製已中止。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，複製已完成。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，複製失敗。不可還原的錯誤。可能是因為磁碟機故障或者等量磁
碟區上有不可還原的錯誤。請在邏輯磁碟機上執行同位檢查。請與技術支援聯絡。

邏輯磁碟機 ID LogicalDrive，擴充已中止。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，擴充已完成。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，擴充失敗。不可還原的錯誤。可能是因為磁碟機故障或者等量磁
碟區上有不可還原的錯誤。請在邏輯磁碟機上執行同位檢查。請與技術支援聯絡。

邏輯磁碟機 ID LogicalDrive，初始化已中止。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，初始化已完成。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，初始化失敗。資訊性訊息。磁碟機或插槽可能有缺陷。使用者可
能已中止操作。

邏輯磁碟機 ID LogicalDrive，使用者已中止同位檢查。同位檢查必須執行完成，以確認所指定
邏輯磁碟機的資料完整性。

邏輯磁碟機 ID LogicalDrive，同位檢查已完成。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，重建失敗。資訊性訊息。磁碟機或插槽可能有缺陷。使用者可能
已中止操作。

邏輯磁碟機 ID LogicalDrive，開始新增 SCSI 磁碟機操作。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，開始複製。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，開始擴充。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，開始初始化。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，開始同位檢查。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，開始同位檢查。資訊性訊息。

邏輯磁碟機 ID LogicalDrive，開始重建。資訊性訊息。

邏輯磁碟機 LogicalDrive  已從 State 狀態變為 State 狀態。

邏輯磁碟機 LogicalDrive  已從 State 狀態變為 State 狀態。
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邏輯磁碟機 LogicalDrive，同位檢查失敗。不可還原的錯誤。可能是因為磁碟機故障或者等量
磁碟區上有不可還原的錯誤。請在邏輯磁碟機上執行同位檢查。請與技術支援聯絡。 
注意：如果您是手動中止同位檢查，則沒有發生資料毀損的危險。不必與技術支援聯絡。

邏輯磁碟區組件清單。該邏輯磁碟區中的總磁片數 =

登入成功

登入不成功

登出指令錯誤。

郵件資訊是空的。

記憶體分配出錯。無法載入協助程式。

郵件之間的 小間隔必須是下列格式之一： \“*\” \“0\” 
“\nn\” \“nn:mm\”

小間隔無法滿足內容值。

小間隔格式錯誤。

小間隔格式為 HH[:MM]。

小間隔是空的。

停止監視。

不支持多重 IP 分配機制。請只選擇一種機制。

蜂鳴器靜音。

控制器蜂鳴器靜音故障。

控制器蜂鳴器靜音。

未釋放互斥鎖。

互斥鎖逾期。

無法建立互斥鎖！

變更互斥鎖狀態失敗！

協商錯誤 (Ch:%d、Id:%d)。請檢查磁碟機安裝、電纜和 I/O 模組。根據需要進行更換。

已建立新的同位檢查排程。

不存在任何管理過程。

未找到任何管理過程。應當完成所有的活動！

沒有任何陣列管理活動正在進行！

沒有更多要報告的事件。

未發現新的控制器，不需要將系統重新啟動。
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沒有可重新建立的可用磁碟機。

目標報告尚未準備就緒錯誤 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。磁碟機插槽可
能有缺陷。

僅可以刪除 LD/LV 的 後一個分割區。

在設定配置開啟傳輸失敗。

開啟傳輸，鎖定失敗，原始 Lock Holder 的 IP 位址是 %s。

開啟傳輸，登入失敗。

操作已成功完成。

操作失敗。

操作正在進行中。

在其中一個伺服器上的操作失敗。

在範圍之外！

中止同位檢查。

同位檢查確認。

無法在邏輯磁碟機 LogicalDrive 上開始同位檢查。

已在邏輯磁碟機 LogicalDrive 上完成同位檢查。

已在邏輯磁碟機 LogicalDrive 上開始同位檢查。

已中止邏輯磁碟機 LogicalDrive 的同位檢查。

已刪除同位檢查排程。

已更新同位檢查排程。

同位檢查錯誤 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。如果是隨機磁碟機，則可能
是 I/O 模組或電纜故障。

同位檢查錯誤 (SCSI 通道 %d,、SCSI ID %d、目標 Lun %d)。I/O 模組、電纜、控制器或 HBA
可能發生了故障。

無法刪除分割區 0。

分割區表格已滿。無法新增新的分割區。

密碼錯誤！

密碼是空的。

連接埠無效 ( 連接埠必須介於 0 和 65535 之間 )。

連接埠無效 ( 連接埠必須介於 1270 和 1273 之間 )。

電源 #Power 狀態未知。

表 G-34  錯誤 / 狀態訊息 ( 續 )

錯誤和狀態訊息
276  Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月



電源 #Power 故障，已被關閉。

電源 #Power 故障或已被停用。

系統中不存在電源 #Power。

電源 #Power 操作正常但已被停用。

電源 #Power 操作正常。

系統中存在電源 #Power。

主控制器故障！

Probe Agent ( 探測代理程式 ) 指令錯誤！

進度不可用

RAID 控制器韌體總和檢查失敗 ñ 韌體資料損毀。

RAID 控制器韌體下載失敗。

已更新 RAID 控制器韌體。

RAID 控制器已還原連線。

讀取配置檔時出錯。

在邏輯磁碟機 LogicalDrive 上重建已中止。

重建或檢查操作已完成。

複式陣列狀態變化：控制器失敗。

複式陣列狀態變化：控制器已回到冗餘模式。

已移除故障的主控制器。

已移除故障的次控制器。

重新選擇逾時 (SCSI 通道 %d、SCSI ID %d、目標 Lun %d)。I/O 模組、電纜、控制器或 HBA
可能發生了故障。

還原控制器配置。

在完成更新後重試配置操作。

SAF-TE/SES 卡 Channel:Target 韌體已被更新。

SAF-TE/SES 卡 Channel:Target 全域狀態已被更新。

SAF-TE/SES 卡 Channel:Target 插槽執行狀態已被更新。

SAF-TE/SES 卡 Channel:Target 插槽狀態已被更新。

在伺服器中儲存副本。

正在儲存配置資訊，請稍候 ...

掃描 SCSI 磁碟機 (%d.%d) 成功。
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掃描 SCSI 磁碟機資訊。

掃描 SCSI 磁碟機成功 (Ch:%d、Id:%d)。資訊性訊息。

無法在邏輯磁碟機 LogicalDrive 上開始排程的同位檢查。

已在邏輯磁碟機 LogicalDrive 上完成排程的同位檢查。

已在邏輯磁碟機 LogicalDrive 上開始排程的同位檢查。

由於沒有完成前一次檢查，排程的同位檢查已跳到下一次排程。

SCSI 已中止指令 (Ch:%d、Id:%d)。資訊性訊息。磁碟機可能故障或插槽有缺陷。

SCSI 匯流排裝置重設 (SCSI 通道 %d、SCSI ID %d、目標 Lun %d)。I/O 模組、電纜或 HBA 
可能發生故障。

SCSI 匯流排重設 (SCSI 通道 %d、SCSI ID %d、目標 LUN %d)。I/O 模組、電纜或 HBA 可
能發生故障。

已發出 SCSI 匯流排重設 (Ch:%d、Id:%d)。請檢查磁碟機安裝、電纜和 I/O 模組。根據需要
進行更換。

SCSI 通道故障 - 光纖迴圈連接。檢查磁碟機路徑失敗。可能有電纜或模組故障。

SCSI 通道故障 - 一般。請檢查磁碟機路徑。

SCSI 通道故障 - 複式迴圈 / 路徑故障。請檢查磁碟機路徑。可能有電纜或模組故障。

SCSI 通道失敗 (Ch:%d、Id:%d)。更換缺陷的 I/O 或磁碟機模組。

已還原 SCSI 通道 - 已還原光纖迴圈連接。資訊性訊息。

已還原 SCSI 通道故障 - 已還原備用路徑。資訊性訊息。

次控制器故障！

伺服器錯誤。

由於記憶體不夠，伺服器無法完成操作。

伺服器名稱是空的。

伺服器未受管理！

設定控制器參數成功。

設定或新增配置失敗。

插槽 #Slot 已有一個裝置 Name。

偵測到 SMART 可預測故障 (Ch:%d、Id:%d)。資訊性訊息。磁碟機可能會出現故障。

SMTP From 位址格式錯誤或者是空的。

SMTP From 位址格式錯誤。

SMTP 伺服器位址是空的。
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請指定同位檢查的頻率。

標準配置選項提供一組基本的預設 RAID 集，其中磁碟機大小、數量和分配已經過預先配置。

標準配置將更換現有的配置。

標準主機 LUN 對應建立成功！

標準主機 LUN 對應刪除成功！

在特定配置中，標準對應可用於所有連接的主機。

待命重建操作已完成，但有未知錯誤。

正在進行待命重建操作。

次控制器的啟動狀態。

未釋放狀態變更互斥鎖。

Sun StorEdge Configuration Service 監視協助程式已開啟。

Sun StorEdge Configuration Service 伺服器協助程式已開啟。

Sun StorEdge Configuration Service 啟動完成。

Sun StorEdge Configuration Service 陷阱協助駐程式已開啟。

系統管理員 (ssconfig) 已開始執行無法回復的系統關閉及重新啟動。儲存所有資料並立即登出。

系統 ID 是空的。

磁帶操作已停止，因為在讀取或寫入資料過程中出現了磁碟機無法糾正的錯誤。  

TapeAlert 通知。裝置 [Channel:Target] ( 通道：目標 )。  

報告目標 HW 錯誤 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。磁碟機插槽可能有缺陷。

報告目標媒體錯誤 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。磁碟機插槽可能有缺陷。

目標逾時 (Ch:%d、Id:%d)。請檢查磁碟機安裝、電纜和 I/O 模組。根據需要進行更換。

溫度從 TemperatureC 變為 TemperatureC。

背景指令已結束。

已中止背景指令。

更換器機制與磁帶磁碟機通訊時遇到困難。關閉然後開啟自動載入器，重新開始操作。如果問
題仍存在，請與磁帶供應商協助專線聯絡。

配置已得到更新。

配置更新成功。如果建立了新的 LD/LV，則可能需要重新啟動伺服器。

控制器裝置清單已變更。

控制器參數已經更新。

目前的使用者是 ssconfig，您無法再次登入。
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協助程式沒有回應。

裝置不屬於同一 HBA 卡。操作無法繼續。

無法分配磁碟機號 ( 安裝點 )。

密鑰是空的。

韌體不支援多重 IP 分配機制。

韌體下載失敗，因為您嘗試為該磁帶磁碟機使用不正確的韌體。請取得正確的韌體，然後重試。

主機 LUN 篩檢程式對應 (StorEdge SN#%d LD %d Partition %d WWN:) 已建立。

主機 LUN 篩檢程式對應 (StorEdge SN#%d LD %d Partition %d WWN:) 已建立。

IP 位址不得空白。

後在磁帶磁碟機中使用的清潔磁帶已磨損。丟棄磨損的清潔磁帶，等待目前的操作結束，然
後使用新的清潔磁帶。

刪除邏輯磁碟機後 LD# 上移，所以可能與 RS-232 終端機視窗上所顯示的 LD# 不一致。

密鑰的長度必須大於 8 個字元。

Mail Server ( 郵件伺服器 ) 欄位不能是空的。

媒體的指定壽命已盡。

記憶體分配失敗。

無法將安裝點 ( 磁碟機號 ) 寫入檔 ( 註冊表 )。

建立邏輯磁碟機後不會增加邏輯磁碟機的數目。(before:%d now:%d)。

操作失敗，因為自動載入器門已開啟。清理自動載入器門旁邊的障礙物，彈出媒體盒，然後重
新插入。如果沒有清除故障，請將自動載入器關閉然後重新開啟。

操作失敗，因為磁碟機中的磁帶已被扯斷。丟棄舊的磁帶。請用一盒不同的磁帶重新開始操作。

Selected Device 清單是空的！

伺服器已經存在！

伺服器名稱不可以空白，也不得包含任何多餘空格。

選擇的伺服器可能已經關機。

設定配置失敗，因為有其他衝突作業。

設定配置失敗。

盒帶不是資料級的。您備份到磁帶的所有資料都有危險。磁碟機未能讀取 MRS 帶區。請用一
盒資料級磁帶替換這盒磁帶。

磁帶磁碟機有硬體故障，該故障與讀寫無關。關閉然後開啟磁帶磁碟機，重新開始操作。如果
問題仍存在，請與磁帶供應商協助專線聯絡。
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磁帶磁碟機有硬體故障。彈出磁帶或媒體盒，重設磁碟機 ( 按住卸載按鈕 5 秒鐘 )，然後重新
開始操作。

磁帶磁碟機有 SCSI 介面故障。請檢查電纜和電纜連接，然後重新開始操作。

應對磁帶磁碟機進行例行清潔。等待目前的操作結束，然後使用清潔磁帶。

磁帶磁碟機有讀取資料問題。沒有損失任何資料，但磁帶容量減少。

磁帶磁碟機需要清潔。如果操作已停止，則彈出磁帶並清潔磁碟機。如果操作尚未停止，則等
待操作結束，然後清潔磁碟機。

磁碟機中的磁帶是一盤清潔磁帶。如果想要進行備份或還原，請插入一盤資料級磁帶。

磁帶已損壞，或磁碟機有故障。磁碟機無法繼續從磁帶讀取資料。

請與磁帶供應商協助專線聯絡。  

磁帶有問題，或磁碟機有故障。請使用好磁帶來測試磁碟機。如果問題仍存在，請與磁帶供應
商協助專線聯絡。

磁帶操作失敗。彈出然後重新插入磁帶或媒體盒。

WWN 必須是一個小於 16 個字元的十六進位字串。

沒有可配置的磁片。

沒有可管理的 LD/LV。

沒有足夠的可用磁片，無法新增 LD/LV；或沒有可用的 LD，無法建立 LV。在使用 LV 之前，
必須先取消對應 LD 並刪除分割區。

對應常會對應一個以上的主機，因此，不可取消選擇 \“Map to Multiple Hosts”\ 屬性。變更
此設定之前，請先移除多台主機的對應。

自動載入器機制有問題。載入器機制已偵測到一個硬體故障。

沒有任何備用或替換用磁碟機。無法繼續重建。

可能造成資料損失。

這項操作歷時一分鐘。

這項操作可能需要數秒鐘。請稍候 ...

此操作將新增到現有配置。

此操作將刪除所有現有的配置和資料。

無法為陣列查詢分配記憶體。無法監控該陣列。

無法決定本機主機，正在終止！

因為磁帶磁碟機正在使用中，無法將媒體盒彈出。請等待，直到操作完成，然後再將媒體盒彈出。

無法查詢 RAID 控制器。

無法查詢 SAF-TE 裝置。對該機箱的 SAF-TE 監控已被停用。
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無法查詢磁帶裝置。將會刪除此裝置。

無法對位於 [Channel:Target] 的裝置發出 Self-Reliability Query ( 自我可靠性查詢 )。

無法記錄事件。

無法開啟結合文件 - 或不存在任何結合。請檢查結合檔。

無法開啟 I/O 傳輸層

無法查詢 TapeAlert 記錄資料。對該裝置的 TapeAlert 監控已停用。

無法讀取授權資料。

無法讀取 SMTP 伺服器的回應。

無法傳送電子郵件至 SMTP 伺服器。

無法在 SAF-TE/SES 管理機箱上切換喇叭。

無法在 SMTP 伺服器驗證收件者。

無法寫入授權資料。

未定義錯誤 (Ch:%d、id:%d)。請與技術支援聯絡。

意外中斷 (Ch:%d、Id:%d)。請檢查磁碟機安裝、電纜和 I/O 模組。根據需要進行更換。

從目標接收到意外的感應資料 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。磁碟機插槽
可能有缺陷。

從目標接收到意外單元強調 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。磁碟機插槽可
能有缺陷。

未對應 LUN，對主機不可用

使用者名稱是空的。

等待互斥失敗。

寫入配置檔時出錯。

傳真號碼格式錯誤。

電話號碼格式錯誤。

必須先刪除索引號碼較大的分割區的主機對應，然後才可以變更該分割區。

必須先刪除此 LD/LV 的主機對應，然後才可以將其刪除。

必須先刪除 後一個分割區的主機對應，然後才可以新增新的分割區。

您必須擁有超級使用者 / 系統管理員權限，才能執行此程式。現有的 ...

表 G-34  錯誤 / 狀態訊息 ( 續 )

錯誤和狀態訊息
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安裝及程式提示
表 G-35 包含安裝及程式提示的清單。 

表 G-35 安裝及程式提示

安裝及程式提示

找到了該套裝軟體的一個現有配置。是否要進行還原？

是否確定要繼續？

是否確定要刪除記錄檔？

是否刪除該陷阱？

是否確定要覆寫該檔案？

是否確定要重建磁碟機？

確定要還原原廠預設值嗎？

在開始使用 SUNWsscsConsole 之前，請先執行 
/opt/SUNWsscs/sscsconsole/config_sscon，輸入預設 Web 瀏覽器的路徑名稱，以便
存取 HTML 說明檔。

開始將韌體下載到裝置。是否要繼續？

無法找到 Java 執行時期環境 $JRE_MAJOR.$JRE_MINOR 或更高版本。SUNWsscs Console 
需要 JRE 1.2 ( 含 ) 以後版本才能執行。Console 將嘗試在 /usr/java、/usr/jre、
/usr/local/java 或 /usr/local/jre 中尋找。如果是在上述目錄以外的某個目錄中安裝
了 JRE，則須進行連結。

只有重設控制器後對這一設定進行的變更才能生效。在重設控制器之前，可能無法正常繼續操
作。是否要重設控制器？

按一下 View 以選擇一個檔。

要將韌體下載到控制器嗎？

要將帶有啟動記錄的韌體下載到控制器嗎？

要儲存目前的事件日誌檔嗎？

要設定郵件伺服器嗎？

請輸入一個聯絡人名稱。

請輸入一個客戶名稱。

請輸入一個位置。

請輸入一個電子郵件地址。

請輸入一個系統 ID。
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請輸入一個有效的閘道位址。

請輸入一個有效的 IP 位址。

請輸入一個有效的網路遮罩。

請輸入 SMTP 伺服器資訊。

請輸入 SMTP 伺服器資訊。

請輸入登入密碼。

請輸入 ssconfig 使用者密碼以登入。

在安裝主控台之前，須先安裝 JRE 1.2.2、1.3 或 1.4。

要向控制器發出重設指令嗎？

對應的 LUN 存在！在建立新的 LD/LV 之前，必須先將其刪除。如果您繼續執行，則此操作
會覆寫現有的配置。刪除任何現有的 LD/LV，則會遺失全部資料！如果想要保留現有的配置，
請使用 \“Add LDs/LVs to the Current Configuration\” 選項。是否要繼續？

請選擇 LD/LV！

請選擇 CH/ID。

請選擇要掃描的通道 /ID。

請在指令行或 ssdgrcli.cfg 中指定至少一個 SSCS 代理程式。

刪除套裝軟體 @PKG_NAME@，然後嘗試安裝該套裝軟體。

請選擇 LD/LV！

在下載韌體之前，請選擇產品 ID。

請選擇開機記錄檔案。

選擇配置檔案。

選擇 AM 或 PM。

選擇韌體檔案。

請只選擇一個 LD/LV！

僅可以選擇一行進行編輯。

僅可以選擇一行進行刪除。

選擇管理控制器的伺服器。

按一下 Remove 之前請選擇代理程式。

按一下 Edit 之前請選擇代理程式項目。

請選擇要掃描的磁碟機的通道 /ID

選擇要下載的韌體檔案

表 G-35 安裝及程式提示 ( 續 )

安裝及程式提示
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選擇邏輯磁碟機。

按一下 Edit 之前請選擇伺服器項目。

按一下 Remove 之前請選擇伺服器項目。

選擇起始日期。

選擇逾時 (Ch:%d、Id:%d)。磁碟機可能安裝不當或有缺陷。如果是隨機磁碟機，則可能是 I/O
模組或電纜故障。

指定對應資訊。

SUNWsscsConsole 需要 JRE 1.2.2、1.3 或 1.4 才能執行。Console 將嘗試在 /usr/java、
/usr/jre°B/usr/local/java 或 /usr/local/jre 中尋找。如果是在上述目錄以外的某
個目錄中安裝了 JRE，則須進行連結。

用戶端只會在正在執行時接收事件。確定要結束嗎？

Content of Periodic Trap ( 週期陷阱的內容 ) 不可是 \“Event\”。請另行選擇。

必須重設控制器，以便讓新的韌體生效。是否要重設控制器？

您輸入的密鑰在前面或後面包含多餘的空格，這可能會導致加密錯誤。是否要繼續？

可能造成資料損失。是否確定要移動？

此項操作會覆寫現有的配置。刪除任何現有的 LD/LV，則會遺失全部資料！如果想要保留現
有的配置，請使用 \“Add LDs/LVs to the Current Configuration\” 選項。是否要繼續？

此項操作會覆寫現有的配置。刪除任何現有的 LD/LV，則會遺失全部資料！如果想要保留現
有的配置，請使用 \“Add LDs/LVs to the Current Configuration\” 選項。是否要繼續？

這項操作將導致所有邏輯磁碟機上的現有控制器設定和資料損失。確定要還原原廠預設值嗎？

這項操作將導致所有已修改分割區上的資料損失。是否要繼續？

若要確定目前安裝的 Java 版本，請鍵入 “java-version”

陷阱資訊已被修改。是否儲存變更？

您選擇 Event 作為陷阱類型，因此，您必須選擇至少一個 Active ( 現用 ) 陷阱事件。 

您選擇了 My SMTP server needs authorization ( 我的 SMTP 伺服器需要授權 )，因此必須輸
入一個密碼。

您選擇了 My SMTP server needs authorization ( 我的 SMTP 伺服器需要授權 )，因此必須輸
入一個使用者名稱。

您選擇了 use encrypt ( 使用加密 )，因此必須輸入一個密鑰。

表 G-35 安裝及程式提示 ( 續 )

安裝及程式提示
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辭彙表

本附錄列出文件中出現的縮寫並定義 RAID 名詞術語。其中也包括對磁碟機、邏輯磁碟
機和複式控制器的操作狀況的定義。 

縮寫
ANSI 美國國家標準協會。

CH 通道。

CISPR 國際無線電干擾特別委員會。 

EMU 事件監控裝置。

FC-AL 光纖通道仲裁迴圈。FC-AL 實作為迴圈或光纖。迴圈 多可以包括 126 個節點，
可透過僅一個或兩個伺服器存取。 

FRU 現場更換零件。

GB 十億位元組。1,000,000,000 (10 億 ) 位元組。 

GBIC 十億位元介面轉換器。熱交換式的輸入 / 輸出裝置，能插入十億位元乙太網路連
接埠或光纖通道。

HBA 主機匯流排介面卡。

ID 識別號。

IEC 國際電工技術委員會。

JBOD 一群磁碟機 (Just a Bunch of Disks，具有磁碟機而沒有控制器的陣列裝置 )。

LAN 區域網路。

LD 邏輯磁碟機。

LUN 邏輯裝置號碼。在 SCSI 通道上使用的唯一識別碼，讓主機可以區分不同的裝置。
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LVD 低噪音、低功率、低振幅訊號系統，啟用支援的伺服器和儲存裝置之間的資料通
訊。LVD 訊號技術使用兩根電線在銅線上傳送一個訊號，而電纜長度需在 25 公尺
(82 英尺 ) 之內。 

MB 百萬位元組。1,000,000 位元組或資料字元。 

NVRAM 非易失性隨機存取記憶體。一個配備有電池的儲存裝置；因此即使在主電源切斷
後，資料仍然保持完整無損。

PID 主控制器識別號。

RAID 獨立磁碟複式陣列。一種配置，其中多個磁碟機組合成單個虛擬磁碟機以提高效能
和可靠性。

SAN 儲存區域網路。儲存裝置和伺服器的高速、實行開放標準的可縮放網路，提供對資
料的加速存取。

SCSI 小型電腦系統介面。磁碟和磁帶裝置與工作站連接的工業標準。

SES SCSI 機箱服務驅動程式。與 SCSI Enclosure Services 裝置的介面。這些裝置能偵
測和監控機箱內的實際狀況，並可存取機箱的狀態報告和配置特性 ( 如機箱上的
LED 指示燈 )。

SID 次控制器識別號。

S.M.A.R.T. 自行監控分析和報告技術。這是 IDE/ATA 和 SCSI 兩種硬碟機的行業標準可靠性
預測指示器。使用 SMART 標示的硬碟機能提供某些硬碟故障的提早警告，因此能
保護重要資料。 

SMTP 簡單郵件傳輸通訊協定。在伺服器之間或從郵件使用者端向郵件伺服器發送電子郵
件的通訊協定。然後可以用使用 POP 或 IMAP 的電子郵件使用者端擷取郵件訊
息。 

SNMP 簡單網路管理通訊協定。管理複雜網路的一組通訊協定。SNMP 向網路的不同部
分發送訊息 ( 稱為通訊協定資料裝置，簡稱 PDU)。符合 SNMP 標準的裝置 ( 稱為
代理程式 ) 在管理資訊庫 (MIB) 中儲存與它們自己有關的資料，然後將資料傳回給
SNMP 請求者。 

WWN 世界通用名稱。用以識別陣列系統和使用 Solaris 操作環境的系統中的陣列磁碟區
的號碼。
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名詞術語
LUN 對應 從儲存裝置呈現虛擬 LUN 給伺服器的能力。這樣做的益處包括伺服器從 SAN 啟

動而不需要本機磁碟機。每個伺服器都需要 LUN 0 來啟動。

LUN 遮罩 使管理員能將 HBA 動態地對應到指定 LUN 的特性。這就提供了個別伺服器或多
個伺服器對個別磁碟機或多個磁碟機的存取，並能禁止不想要的伺服器存取同樣的
磁碟機。

N 連接埠 點對點或光纖網路連線中的光纖通道連接埠。

RAID 獨立磁碟複式陣列。一種安排，即將兩個或更多的磁碟機設定為一起運作，以提供
更多的磁碟儲存空間、更好的效能及 / 或資料複式備份。這些特性的各種組合，是
透過經過定義的 RAID 等級加以說明的。如需有關 RAID 等級的詳細說明，請參
閱第 195 頁 「RAID 基本知識」。

分割 在邏輯磁碟機中所有不同的 SCSI 磁碟機上儲存順序進入的資料區塊。例如，在邏
輯磁碟機中有三個 SCSI 磁碟機，資料會按以下方式儲存：

資料區塊 1 在 SCSI 磁碟機 1

資料區塊 2 在 SCSI 磁碟機 2

資料區塊 3 在 SCSI 磁碟機 3

資料區塊 4 在 SCSI 磁碟機 1

資料區塊 5 在 SCSI 磁碟機 2，等等。

因為多個磁碟機同時運作、擷取及儲存，此資料寫入方法可增加磁碟系統的處理能
力。RAID 0、3、5、1+0 全都採用分割。

分割區 磁碟儲存空間的一部分，也稱為系統磁碟機 (System Drive) 或 LUN，在主機操作
環境中顯示為單一實體磁碟機。邏輯磁碟機可以位於一個或多個實體磁碟機上。 

光纖切換裝置 光纖切換裝置的作用就像是路由引擎，會主動將資料傳輸從來源導向目標，並仲裁
每一個連接。當新增更多的節點時，透過光纖切換裝置的每一個節點都會保持固定
的頻寬，而且切換連接埠上的節點會使用高達 100Mbps 的資料路徑來傳送或接收
資料。
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光纖通道 部署在各式硬體上具經濟效益的十億位元通訊連結。

光纖網路 在一個或多個切換裝置上構建的光纖通道網路。 

同位檢查 檢查容錯陣列 (1、3、5 和 6 或 1+0) 上複式數據完整性的過程。邏輯磁碟機上的
同位檢查程序會重新計算每個邏輯磁碟機 RAID 等量集的資料等量磁碟區的同位
檢查，並與儲存的同位檢查做比較。如果發現差異，會報告錯誤，而新的正確同位
檢查會替代儲存的同位檢查。

回寫快取記憶體 這是一個快取記憶體寫入策略，陣列控制器接收將寫入磁碟的資料，將資料儲存在
記憶體緩衝區中，並立即向主機操作環境發送訊號，表示已完成寫入操作，而不必
等待資料實際寫入磁碟機。在很短時間內，當控制器不繁忙時，控制器即將資料寫
入磁碟機。

回寫快取記憶體功能提高了寫入操作的效能和控制器卡的處理能力。然而，由於在
發生電源故障情況下有遺失資料的危險，使用回寫快取記憶體的儲存系統配備有
UPS 或電池後備快取記憶體。UPS 提供足夠時間的電源，可讓快取記憶體中的所
有資料寫入磁碟機。使用電池後備快取記憶體，電池能夠提供電源讓記憶體資料保
留長達 48 小時。

自動重建 在磁碟機故障後自動重建資料並寫入後備磁碟機的過程。手動安裝新的磁碟機以替
代故障磁碟機後，也會進行自動重建。若重建過程因重設而中斷，請使用 Array
Administration → Rebuild 來重新啟動重建過程。

快取記憶體 允許資料儲存在磁碟上預先指定的區域或 RAM ( 隨機存取記憶體 )。快取記憶體
用於加速 RAID 系統、磁碟機、電腦和伺服器或其他週邊裝置的操作。 

協力群組 一對互相連接的控制器裝置。與這對控制器裝置互相連接的延伸裝置也可以是協力
群組的一部分。

狀態 磁碟機、邏輯磁碟機或複式控制器的目前操作狀態。儲存系統在其非易失性記憶體
中儲存磁碟機、邏輯磁碟機和複式控制器的狀態。這項資訊在系統供電中斷時仍保
留。

直寫快取記憶體 一項快取記憶體寫入原則，陣列控制器在向主機操作環境發送訊號表示過程已完成
之前，即將資料寫入磁碟機。直寫快取記憶體的寫入操作和處理能力效能比回寫快
取記憶體低；但是，在發生電源故障情況下損失資料的危險也極小。

故障切換 容錯系統的一種操作模式：一個元件發生故障時，其功能由複式元件承擔執行。 
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背景工作優先權 背景工作優先權是分配給陣列管理活動 ( 如重建故障磁碟機、同位檢查及初始化 )
的可用陣列控制器 CPU 時間的百分比。如果背景工作優先權設定為 100%，陣列
管理活動比其他系統活動具有更高的優先順序。如果為 0%，只有在陣列控制器上
沒有其他活動時才會進行陣列管理活動。

重建 重建磁碟是在磁碟故障以前，先重建磁碟上資料的過程。重建只能在具有資料備份
的陣列中執行。 

如需有關重建的詳細資訊，請參閱第 290 頁 「自動重建」。如需重建率的相關資
訊，請參閱第 291 頁 「背景工作優先權」。 

容錯 處理內部硬體問題而不中斷資料可用性的能力；常用方法是在偵測到故障時使用已
上線的備份系統。許多儲存系統使用 RAID 架構保護單個磁碟機故障時不會遺失
資料來提供容錯。使用 RAID 1 ( 鏡像 )、RAID 3 或 5 ( 帶同位檢查的分割 ) 或
RAID 6 或 1+0 ( 鏡像和分割 ) 技術，陣列控制器可以重建故障磁碟機的資料，並
將它寫入後備或替換用磁碟機。

容錯邏輯磁碟機 在單個磁碟機故障情況下，透過使用 RAID 1、3、5 或 6 ( 也稱為 RAID 1+0) 提
供資料保護的邏輯磁碟機。

終結器 一種用來結束 SCSI 匯流排的零件。終結器可吸收射頻訊號，防止能量反射回電纜
線設備。 

通道 在儲存裝置和儲存控制器或 I/O 介面卡之間用以傳輸資料並控制資訊的任何路
徑。也表示磁碟陣列控制器上的一個 SCSI 匯流排。各個磁碟陣列控制器提供至少
一個通道。 

備用磁碟機 標示為 「後備」的磁碟機，用於在與邏輯磁碟機相關的實體磁碟機發生故障後支
援自動重建資料。如果要讓備用磁碟機取代另一部磁碟機，它的大小至少應該和故
障的磁碟機一樣大。而且，故障的磁碟機本身必須是來自 RAID 1、3、5 或 1+0。

等量磁碟區大小 這是在邏輯磁碟機中每個實體磁碟機上進行分割的資料量 ( 以 KB 計算 )。數值為
8 KB 的增量，範圍從 8 至 64 KB。一般情況下，大型等量磁碟區對於具有基本順
序讀取的系統更有效。

若要變更現有磁碟機上的等量磁碟區大小，您必須備份資料、重新定義等量磁碟區
大小、重新設定記憶體及重新儲存所有的資料。
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群組 群組是新的資料物件，允許在單個類別下包含多個伺服器，與網域的概念相似，允
許使用者在 Configuration Service 內組織伺服器。取代所有被管理伺服器的線性
樹狀結構的是，Configuration Service 操作員可以將伺服器組織成相似的集或群
組。

群組不是必要的。例如，可以設定 Configuration Service 為沒有群組而有十五台
伺服器，或者一個群組下有十台伺服器而 上層另有五台伺服器。Configuration
Service 允許任何組合。

許可的群組數和群組內伺服器的數量僅受到可用系統記憶體的限制。如果伺服器是
群組的成員，而使用者從群組清單方塊中刪除了該群組，Configuration Service 會
將群組內的伺服器重新分配給無群組類別。Configuration Service 會自動重新對
應主視窗的樹狀結構。

跨越 磁碟跨越利用韌體的分割功能，在兩個其他的獨立 RAID 邏輯磁碟機上進行資料
分割。這兩個跨越的邏輯磁碟機，以一個邏輯磁碟機呈現給操作環境。這樣做的優
點在於：

支援組合容錯邏輯磁碟機中兩個磁碟機同時故障 (前提為各個邏輯磁碟機中的一個
磁碟機故障 )。

因為主軸數量增加，所以提高了效能。

其缺點在於：由於各個邏輯磁碟機分別處理容錯而增加了複式 RAID 等級的 RAID
經常性使用。

實體陣列 實體陣列是 Configuration Service 中參與一個或多個邏輯磁碟機的一組實體磁碟
機。如果一組實體磁碟機設定為不使用實體磁碟機總容量的邏輯磁碟機，
Configuration Service 會要求同樣的磁碟機實體陣列在任何使用剩餘容量建立的
其餘邏輯磁碟機中一起使用。

當剩餘的磁碟機容量是在已經用於建立邏輯磁碟機的多個實體磁碟機上時，New
Configuration 視窗中的 Add Disk 按鈕會變更為 Add Array。因為實體磁碟機已
被分割，必須選擇它們作為一個陣列。無法分別進行選擇。

磁碟區 也稱為邏輯單元數目或 LUN。磁碟區是一個磁碟機或多個可組合成一個資料儲存
裝置的磁碟機。
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寫入原則 用以控制系統寫操作的快取記憶體寫入原則。寫入原則選項包括 write-back 和
write-through 快取記憶體。

熱交換式 當系統保持通電並可操作時，移除並替換現場更換零件 (FRU) 的能力。

熱後備磁碟機 RAID 1 或 RAID 5 配置中的磁碟機不包含任何資料，在另一個磁碟機故障時作為
後備。 

頻外 指不在資料路徑中的連線和裝置。 

雙現用控制器 一對元件，例如在兩者正常工作時共用一項或一組任務的容錯儲存系統中的儲存控
制器。當其中一個元件發生故障時，另一個元件需承擔整個負載。雙現用控制器連
接同一組裝置，提供的 I/O 效能和容錯組合能力比單控制器高。 

鏡像 (RAID 1) 寫入一個磁碟機的資料同時寫入另一個磁碟機。如果一張磁碟故障，可使用另一張
磁碟操作系統並重建故障磁碟。磁碟鏡像的主要優點在於 100% 資料備份。鏡像磁
碟後，一張磁碟故障並不會產生影響。兩張磁碟會一直包含相同的資料，任一張都
可以作為操作磁碟。

磁碟鏡像提供 100% 資料備份，但由於需要複製系統中的每個磁碟機，因此所費不
貲。

讀取原則 讀取原則說明如下：

當您指定 No Cache 讀取原則時，控制器不會在讀取快取記憶體中儲存資料。

Normal 會指定目前控制器不對目前磁碟機使用預先讀取快取記憶體。

將讀取原則設定為 Read Ahead，控制器將自動讀取多個相鄰的資料區塊。對於順
序讀取的應用程式而言，這是 有效的方式。

邏輯磁碟機 一個獨立實體磁碟機陣列，主機視其為大型磁碟機。
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邏輯磁碟機

儲存 , 59
驗證 , 57

陣列管理控制器分配 , 50
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參數

控制器 , 175
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Linux 作業環境

建立 , 34
Solaris 作業環境

建立 , 15
Windows

建立 , 23
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事件錯誤 , 264
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參數
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靜音 , 146
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控制器分配指令 , 50

控制器參數
儲存變更 , 176

探測 , 109

掃描
磁碟機 , 168

排程
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啟用動態 IP 分配 , 188

啟動
Sun StorEdge Configuration Service, 38

通用後備磁碟機
定義 , 196
與本機後備磁碟機比較 , 208

透過網路管理儲存設備 , 132
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Event Severity, 238
Event Time, 238
IP 位址格式 , 235
Microsoft SNMP 內容視窗 , 235
OID ( 物件 ID), 238
Server Address 和 Name, 238
Service Configuration 視窗 , 235
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在 Linux 上 , 236
在 Solaris 上 , 236
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疑難排解 , 248
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陷阱設定 , 233
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執行 / 變更 , 190
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大小上限 , 180
Sequential I/O

大小上限 , 180

登入 , 49

登出 , 49

硬碟
在主視窗中顯示 , 42

等量磁碟區大小
定義 , 291

紫色裝置狀態圖示
裝置狀態狀況 , 101

開始安裝 Sun StorEdge Configuration Service 之前

步驟 , 3

韌體
升級

SAF-TE 裝置 , 174
SES 裝置 , 174
控制器 , 169
硬碟 , 173

黃色裝置狀態項目 , 101

十三畫
新增

SCSI 磁碟機到邏輯磁碟機 , 165
主機 LUN, 83
伺服器 , 43
新裝置

探測 , 109
邏輯磁碟機 , 152

群組
View Group 指令 , 107
View Group 視窗 , 107
定義 , 292
狀態 , 102
符號顏色 , 102
群組名稱 , 44
顏色 , 103

蜂鳴器
靜音 , 146, 189

裝置
未在主控台顯示 , 248
狀態 , 101
重建 , 140
詳細檢視資訊 , 106

解除安裝
Sun StorEdge Configuration Service, 16, 35

Linux 作業環境 , 35
Solaris 作業環境 , 16
Windows, 25

跨越 , 292

載入配置，請參閱恢復邏輯磁碟機配置

電子郵件
Add Server, 232
Mail Address 項目方塊 , 232
Mail Server Setup 視窗 , 232
Mailing Lists 反白顯示 , 231
Mailing Lists 標籤 , 45
SMTP 電子郵件訊息 , 229
訊息 , 230
郵件清單 , 231
嚴重性項目對話方塊 , 232

電池
狀態 , 110
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十四畫
圖示

工具列
Custom Configuration, 41
Save Event Log, 41
Server List Setup, 41
事件日誌 , 41
標準配置 , 41
儲存報告 , 41

狀態 , 101
帶有碟形衛星天線的伺服器 , 57

實體陣列 , 292

實體裝置
Physical Drives 標籤 , 111
View Physical Device 視窗 , 116
檢視實體磁碟機 , 116

實體磁碟機
在主視窗中顯示 , 42

疑難排解 , 243
Java 版本 , 244
另請參閱錯誤代碼
另請參閱錯誤訊息

監視過程 , 104

磁碟空間
Sun StorEdge Configuration Service Agent, 6, 28
要求

Sun StorEdge Configuration Service 
Console, 6, 28

磁碟機
Physical Drive Standby State 視窗 , 190
重建 , 141
掃描新的 , 168
複製並替換 , 166
變更備用 , 190

磁碟機重建 , 139, 140

管理工具群組 , 62

網路
DHCP, 188
RAAP, 188
靜態 IP, 188

十五畫
寫入原則

定義 , 293

標準配置 , 66

標籤
自動寫入 , 79
說明的 , 42

編輯
可用伺服器 , 191

線上說明 , 101
為 Linux 指定瀏覽器 , 30
為 Solaris 指定瀏覽器 , 12

複製
成員磁碟機 , 166

輪詢
裝置的狀態更改 , 54

十六畫
樹狀檢視圖 , 101

選擇 Configuration File 視窗 , 59, 86

錯誤代碼 , 251
RDP 路徑變更錯誤 , 263
SAF-TE 狀態錯誤 , 255
內部狀態錯誤 , 257
冗餘狀態錯誤 , 257
主要通訊錯誤 , 261
主機端事件錯誤 , 266
伺服器管理 / 監控事件錯誤 , 266
系統磁碟機狀態 , 254
系統關閉錯誤 , 263
使用者端參數錯誤 , 258
初始化狀態錯誤 , 258
指令代碼錯誤 , 260
記憶體分配錯誤 , 259
控制器事件錯誤 , 264
通訊安全錯誤 , 262
通訊非同步錯誤 , 261
通訊連結錯誤 , 261
開啟傳輸錯誤 , 259
韌體下載錯誤 , 263
傳輸欄位錯誤 , 260
裝置狀態錯誤 , 258
逾時錯誤 , 262
磁片狀態錯誤 , 254
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磁帶狀態錯誤 , 255
磁碟機端事件錯誤 , 265
管理錯誤 , 262
關閉傳輸錯誤 , 259
邏輯磁碟機事件錯誤 , 266

錯誤訊息 , 267

頻外
儲存管理 , 127

十七畫
儲存

透過網路進行管理 , 132
瀏覽器需求 , 132

儲存控制器參數變更 , 176

儲存邏輯磁碟機配置 , 59, 85

環境
未報告警報 , 249
狀態 , 117

十八畫
叢集配置

CLUSTER.TXT, 223
IP 位址 , 223
Microsoft Cluster Server 軟體 , 220
要求 , 220
啟動 Sun StorEdge Configuration Service, 220, 

222
規劃 , 219
設定 , 220

擴充
分割區 , 163
邏輯磁碟機的容量 , 163

瀏覽 , 42

瀏覽器需求
透過網路管理儲存設備 , 132

簡單郵件傳輸通訊協定 (SMTP), 232

十九畫
辭彙表 , 287

鏡像 (RAID 1), 293

二十畫
嚴重等級 ( 事件 ), 123

警告
New Configuration, 74
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讀取原則類型 , 293
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變更主機 LUN 分配 , 83

邏輯磁碟區
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定義 , 196
建立 , 80, 154

邏輯磁碟機
Partitions 方塊 , 84
RAID 等級的 大磁碟機數目 , 76
View Logical Drive 指令 , 115
View Logical Drive 視窗 , 117
大於 253 GB, 73
刪除 , 156
刪除分割區 , 161
每個邏輯磁碟機的 大未用容量 , 181
每個邏輯磁碟機的 大磁碟數目 , 181
定義 , 196, 293
建立分割區 , 159
恢復配置 , 143
大數目 , 66

新增 , 152
新增 SCSI 磁碟機 , 165
磁碟機分配 , 198
儲存配置 , 59
擴充容量 , 163

邏輯磁碟機號碼 , 158

驗證配置 , 57
索引   305



306  Sun StorEdge 3000 Family Configuration Service 1.3 使用者指南 • 2003 年 6 月


	目錄
	圖
	表
	前言
	本書的組織結構
	使用 UNIX 指令
	排版慣例
	Shell 提示字元
	相關文件
	請與 Sun 技術支援聯絡
	存取 Sun 文件
	508 號傷殘資源存取特性
	Sun 歡迎您的批評指教

	介紹
	開始之前
	範例畫面
	Solaris 作業環境
	Windows NT/2000 作業系統
	超級使用者 / 管理員權限

	將 Sun StorEdge Configuration Service 安裝在執行 Solari
	系統需求
	表 3‑1 主控台系統需求
	表 3‑2 代理程式系統需求

	安裝 Sun StorEdge Configuration Service 之前
	安裝軟體
	安裝套裝軟體
	表 3‑3 Solaris 作業環境所需的 Sun StorEdge Configuration 

	安裝代理程式和主控台
	啟動或停止代理程式

	使用者和密碼
	管理 (使用者) 安全等級和準則
	建立密碼和許可權

	解除安裝 Sun StorEdge Configuration Service
	解除安裝 Sun StorEdge Configuration Service

	恢復配置

	將 Sun StorEdg eConfiguration Service 安裝在 Microsof
	系統需求
	表 4‑1 主控台系統需求
	表 4‑2 代理程式系統需求

	安裝 Sun StorEdge Configuration Service 之前
	安裝軟體
	安裝套裝軟體
	安裝代理程式和主控台
	在 Windows NT Server 啟動或停止代理程式
	在 Windows 2000 Server 啟動和停止代理程式

	使用者和密碼
	管理員 (使用者) 安全等級和準則
	多台伺服器上的全域密碼
	建立 Windows NT 使用者
	建立 Windows 2000 使用者

	解除安裝 Sun StorEdge Configuration Service
	解除安裝 Sun StorEdge Configuration Service


	將 Sun StorEdge Configuration Service 安裝在執行 Linux 
	系統需求
	表 5‑1 主控台系統需求
	表 5‑2 代理程式系統需求

	安裝 Sun StorEdge Configuration Service 之前
	安裝軟體
	安裝套裝軟體
	安裝代理程式和主控台
	啟動或停止代理程式

	使用者和密碼
	管理 (使用者) 安全等級和準則
	建立密碼和許可權

	解除安裝 Sun StorEdge Configuration Service
	解除安裝 Sun StorEdge Configuration Service


	設定 Sun StorEdge Configuration Service
	啟動 Sun StorEdge Configuration Service
	將 Sun StorEdge Configuration Service 安裝在 Solaris/
	在 Microsoft Windows NT/2000 作業系統上啟動 Sun StorEdge 

	初次使用前後的主視窗
	如果主控台在使用中鎖住
	停止 Sun StorEdge Configuration Service

	功能表、工具列和標籤
	功能表列
	工具列
	標籤
	實體磁碟機 (硬碟)
	瀏覽
	新增伺服器
	登入和登出
	選擇管理控制器的伺服器
	透過主控台分配控制器

	變更伺服器分配
	取消分配管理伺服器
	使用終端機視窗以手動方式刪除伺服器

	配置代理程式參數 (選擇性項目)
	啟用 JBOD 支援 (僅適用於 SCSI)

	驗證儲存配置
	儲存邏輯磁碟機配置
	在執行 Solaris 作業環境系統上的伺服器上 建立分割
	在 Windows NT 作業系統的伺服器上建立分割
	在 Windows 2000 作業系統上的伺服器上 建立分割
	下一個步驟


	完全配置
	配置邏輯磁碟機和邏輯磁碟區
	使用Standard Configuration 來對邏輯磁碟機 進行配置
	使用 Custom Configuration 配置邏輯磁碟機和 邏輯磁碟區
	New Configuration 選項
	使用 New Configuration 之前
	準備大於 253 GB 的邏輯磁碟機
	使用 New Configuration 建立和分割邏輯磁碟機

	建立和分割邏輯磁碟區
	清除配置
	登出配置等級

	主機 LUN 分配
	新增 (對應) 主機 LUN
	刪除 (取消對應) 主機 LUN

	配置檔案
	將配置儲存到備份檔案
	載入配置


	LUN 篩檢 (僅適用光纖通道)
	概述
	分配 LUN 篩檢程式
	存取 LUN Filter View
	以手動方式新增 HBA 裝置
	移除標準主機對應
	將邏輯磁碟機對應到主機
	刪除 LUN 篩檢程式


	監視陣列
	主視窗
	表 9‑1 裝置狀態狀況
	線上說明
	產品配置的樹狀檢視圖
	群組
	表 9‑2 雙伺服器群組顏色


	監視過程
	Auto Discovery 選項

	檢視詳細裝置資訊
	View Group
	View Server
	View Controller Configuration
	Controllers 標籤
	Physical Drives 標籤
	Enclosure Info 標籤
	View FRU
	View Controller 參數
	View Primary/Secondary Controller Configuration
	Logical Drives 標籤

	檢視 邏輯 磁碟機
	檢視實體磁碟機
	View Enclosure
	View FRU
	Array Administration Progress
	Agent Options Management

	事件日誌
	事件日誌檔
	Event Log 視窗
	表 9‑3 事件記錄欄位

	嚴重等級

	Save Report
	View Report
	頻外儲存管理
	使用頻外管理
	從頻外管理移除陣列

	透過網路管理儲存設備
	網路瀏覽器需求
	Solaris/Linux 作業環境
	Windows NT/2000 作業系統

	設定陣列
	從網路瀏覽器存取主控台


	維護陣列
	陣列管理活動
	進行同位檢查
	排程同位檢查

	磁碟機故障
	使用備用磁碟機自動重建磁碟機
	不使用備用磁碟機重建裝置
	檢查重建過程的進度
	手動重建故障磁碟機
	恢復邏輯磁碟機配置
	重新設定控制器
	將控制器蜂鳴器設定為靜音
	恢復故障控制器的連線
	將雙控制器陣列轉換為單控制器陣列
	顯示效能統計資料


	更新配置
	新增邏輯磁碟機或從新的邏輯磁碟機新增邏輯 磁碟區
	新增邏輯磁碟機到邏輯磁碟區

	從現有邏輯磁碟機新增邏輯磁碟區
	刪除邏輯磁碟機或邏輯磁碟區
	邏輯磁碟機/邏輯磁碟區號碼

	建立分割區
	邏輯磁碟機/邏輯磁碟區號碼

	刪除分割區
	擴充邏輯磁碟機或邏輯磁碟區的容量
	邏輯磁碟機/邏輯磁碟區號碼

	將 SCSI 磁碟機新增到現有邏輯磁碟機
	邏輯磁碟機/邏輯磁碟區號碼

	複製並替換成員磁碟機
	邏輯磁碟機/邏輯磁碟區號碼

	掃描新的硬碟
	下載 RAID 控制器韌體
	升級韌體和開機記錄
	下載用於裝置的韌體
	升級硬碟上的韌體
	升級 SAF-TE/SES 裝置的韌體
	變更控制器參數
	儲存已變更值
	Channel 標籤
	RS 232 標籤
	Cache 標籤
	表 11‑1 每個 2U 陣列的邏輯磁碟機之最大磁碟數目
	表 11‑2 每個 2U 陣列的邏輯磁碟機之最大未用容量 (GB)

	Disk Array 標籤
	Drive I/F 標籤
	Host I/F 標籤
	Redundancy 標籤
	Network 標籤

	將控制器蜂鳴器設為靜音
	指定或變更備用磁碟機

	可用伺服器
	編輯伺服器項目


	RAID 基本知識
	RAID 名詞術語概述
	邏輯磁碟機
	圖 A‑1 包含多部實體磁碟機的邏輯磁碟機

	邏輯磁碟區
	本機後備磁碟機
	通用後備磁碟機
	SCSI 通道
	圖 A‑2 SCSI ID/LUN
	圖 A‑3 邏輯磁碟機配置中的磁碟機分配
	您可以將邏輯磁碟機或者邏輯磁碟區分為幾個分割區，或者將整個邏輯磁碟機當作單一 的分割區來使用。
	圖 A‑4 邏輯磁碟機配置中的分割區
	圖 A‑5 將分割區對應至主機 ID/LUN
	圖 A‑6 將分割區對應至 ID 下的 LUN


	RAID 等級
	表 A‑1 RAID 等級概述  
	RAID 0
	圖 A‑7 RAID 0 配置

	RAID 1
	圖 A‑8 RAID 1 配置
	RAID 1+0
	圖 A‑9 RAID 1+0 配置


	RAID 3
	圖 A‑10 RAID 3 配置

	RAID 5
	圖 A‑11 RAID 5 配置

	進階的 RAID 等級
	表 A‑2 進階的 RAID 等級


	本機和通用後備磁碟機
	圖 A‑12 本機 (專用) 後備磁碟機
	圖 A‑13 通用後備磁碟機
	同時擁有本機和通用後備磁碟機
	圖 A‑14 本機和通用後備磁碟機混合



	監控 JBOD (僅適用於 SCSI)
	啟用 JBOD 支援
	檢視元件和警報特性
	下載用於裝置的韌體
	升級硬碟上的韌體
	升級 SAF-TE 裝置的韌體
	更換故障的磁碟機
	Solaris 作業環境
	Windows NT/2000 作業系統



	使用叢集配置 (僅適用於 SCSI)
	規劃叢集配置
	叢集配置要求
	設定叢集配置


	判斷主機世界通用名稱 (僅適用光纖通道)
	判斷 WWN
	Solaris 作業環境
	Linux 及 Windows NT/2000

	判斷 WWNN
	判斷 WWPN

	電子郵件和 SNMP
	為每台伺服器傳送電子郵件訊息
	為每台伺服器傳送電子郵件訊息

	設定伺服器以傳送陷阱
	Windows NT 伺服器
	檢查社群字串
	指定陷阱接收者
	設定 Solaris 作業環境伺服器
	設定 Linux 作業環境伺服器

	SNMP 的運作方式
	SNMP 陷阱訊息
	代理程式和管理員
	管理資訊庫 (MIB)
	SNMP 物件
	SNMP 請求類型
	SNMP 安全性
	圖 E‑1 MIB 變數的物件 ID

	不使用 Sun StorEdge Configuration Service 而傳 送 SNMP 


	疑難排解
	錯誤代碼和訊息
	錯誤代碼
	表 G‑1 Severity 欄位 
	表 G‑2 Major 欄位 
	表 G‑3 Minor 欄位 
	表 G‑4 系統磁碟機狀態錯誤 
	表 G‑5 磁片狀態錯誤 (2 的 1)
	表 G‑6 SAF-TE 狀態錯誤 
	表 G‑7 磁帶狀態錯誤 
	表 G‑8 冗餘狀態錯誤 
	表 G‑9 內部狀態錯誤 
	表 G‑10 裝置狀態錯誤 
	表 G‑11 初始化狀態錯誤 
	表 G‑12 使用者端參數錯誤 
	表 G‑13 開啟傳輸錯誤 
	表 G‑14 關閉傳輸錯誤 
	表 G‑15 記憶體分配錯誤 
	表 G‑16 傳輸欄位錯誤 
	表 G‑17 指令代碼錯誤
	表 G‑18 主要通訊錯誤 
	表 G‑19 通訊連結 
	表 G‑20 通訊非同步 
	表 G‑21 通訊安全 
	表 G‑22 逾時錯誤 
	表 G‑23 管理錯誤 
	表 G‑24 韌體下載錯誤 
	表 G‑25 系統關閉錯誤 
	表 G‑26 RDP 路徑變更錯誤 
	表 G‑27 設定配置錯誤 
	表 G‑28 控制器事件錯誤 
	表 G‑29 磁碟機端事件錯誤 
	表 G‑30 主機端事件錯誤 
	表 G‑31 邏輯磁碟機事件錯誤 
	表 G‑32 伺服器管理/監控事件錯誤  

	錯誤和狀態訊息
	表 G‑33 替代值 
	表 G‑34 錯誤/狀態訊息 

	安裝及程式提示
	表 G‑35 安裝及程式提示 


	辭彙表
	縮寫
	名詞術語

	索引

